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1 Introduction

Thank you for choosing NETAVIS Observer 4.4 as the management software for your video
monitoring system. As you use it, you will find that Observer not only enables you to view live images
and record them, but also provides a full-scale platform for the intelligent utilization of your video data.

This User Manual guides you through the functionality of NETAVIS Observer 4.4.

If you have questions that are not answered in the Observer documentation set, please contact your
NETAVIS distribution partner, or our product management team directly by e-mail or telephone +43
(1) 503 1722.

We wish you an interesting and productive experience with NETAVIS Observer 4.4.

Your NETAVIS Team.

1.1 The Observer documentation set
These documents are available:

e NETAVIS Observer User Manual

e NETAVIS Observer Supported Video Sources

e NETAVIS Observer Server Installation and Administration
e NETAVIS Observer Server and Client Compatibility

e NETAVIS Observer Server Customizing

e NETAVIS Observer Distributed AS Administration

e NETAVIS Observer SNAP XML Interface

These documents are available online as PDFs directly on each Observer server via the standard web
interface and also from each client via the Info menu at the lower right corner.

1.2 What is new with this release

The changes of a release are documented in the Release Notes, which you can find on the standard
web interface of each Observer server and also under the following direct link:

http://<your-server>/relnotes
or on the public demo server

showroom.netavis.net/relnotes

There you also find the release information of previous releases.

Additionally, the new features of releases are also documented on www.netavis.net.

1.3 Observer data security

Observer has been designed to provide the highest level of robustness and data security. The
following aspects of the Observer system document that:

e All video and configuration data on an Observer server are stored in separate file system
partitions, protected by multiple levels of security.

e Optionally the video data can be stored using 128 bit AES encryption (new since release 4.0)
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e Optionally HTTPS can be used for streaming video data between cameras and servers (new
since release 4.0).

e Optionally HTTPS can be used for streaming video data between server and clients (new since
release 4.2).

e In any case, the authentication data (user names and passwords) transferred between clients
and servers are encrypted by MD5 strong encryption.

Please note: Encryption and decryption can mean higher CPU overhead at the server and/or the
client. Also doing something with the contents of an encrypted stream means decryption and therefore
higher CPU overhead. For example, doing video analytics with an encrypted video stream means that
is has to be decrypted at the server before processing. Likewise, storing an unencrypted stream in an
encrypted video database means that it has to be encrypted at the server before storing . Likewise,
displaying an encrypted video stream at the client means more CPU overhead at the client because it
has to be decrypted.

On the other hand, simply storing an already encrypted video stream coming from the camera does
not need more CPU at the server than storing an unencrypted video stream.

1.4 Video streaming methods and compression

Observer supports video streaming in several standards:

e Motion JPEG (often also referred to as MJPEG)
e MPEG-4 streaming
e H.264 streaming (also known as MPEG-4/AVC)

e MXPEG streaming (this is a streaming standard specially developed by www.mobotix.com for
their IP cameras)

The big difference between the various streaming methods is the way how the image data are
compressed and transferred. The selected streaming method has great influence on:

e the bandwidth needed for transmission between cameras and server but also between servers
and clients,

e the CPU load at the server and the client induced by compression and decompression, and
e the storage requirements for recording

For low-bandwidth client-server connections Observer offers the unique Transcoding™ feature (see
2.6 Observer Transcoding™ for low-bandwidth client-server connections (ABS) on page 21).

1.4.1 Multi streaming (multiple parallel video streams from the camera)

Some cameras are capable of providing multiple parallel video streams to Observer. This can be
helpful, for example, when online viewing and recording is to be done in different formats (e.qg. different
sizes and frame rates) or for optimizing iCAT video analytics performance (see 14.2.1 Considerations
for setting up a system with iCAT on page 106).

Usually MJPEG cameras can deliver several MJPEG streams while MPEG cameras (MPEG-4, H.264,
and MxPEG) usually can deliver only 1 or 2 MPEG streams and some camera types can deliver
several MJPEG streams in addition to the MPEG stream(s).

However there are a few important restrictions with multi streaming:

e Some cameras have performance limitations in providing multiple streams depending on the
streaming format, resolution, and frame rate. We found out that some cameras just stop
streaming when the streaming processors of the camera get overloaded by certain resolution
and frame rates settings. Please refer to the camera data sheet and documentation.

¢ In the current version Observer supports 1 format setting for MPEG streams (MPEG-4, H.264,
and MxPEG) and multiple format settings for MJPEG streams.
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Please note: Please refer to camera data sheet and documentation for camera limitations. Also the
document NETAVIS Observer Supported Video Sources may provide further details on camera
restrictions.

1.4.2 Motion JPEG

A network camera captures individual images and compresses them into a JPEG format. The network
camera can capture and compress, for example, 30 such individual images per second (30 fps), and
then make them available as a continuous flow of images over a network to an Observer server which
then distributes it to Observer clients and / or stores it in the camera archive. At a frame rate of about
16 fps and above, the viewer will perceive full motion video.

As each individual image is a complete JPEG compressed image, they will all have the same
guaranteed quality, determined by the compression level as defined for the network camera or
network video server.

Example of a sequence of three complete JPEG images:

2 fla

1.4.3 MPEG (MPEG-4, H.264, and MxPEG)

Some of the best-known audio and video streaming techniques are defined by the so called MPEG
consortium (Moving Pictures Expert Group). Under the MPEG umbrella several streaming methods
are available like MPEG-4, H.264, and MXPEG (strictly taken, MXPEG is not part of the standards
defined by the MPEG group but is a proprietary standard by the company Mobotix. However, because
of reasons of simplicity we refer to MXPEG also as an MPEG format). MPEG-4 and H.264 are well
known and widely supported MPEG streaming standards.

Simply described, MPEG'’s basic principle is to compare two compressed images to be transmitted
over the network, and using the first compressed image as a reference image (called an I-frame), only
sending the parts of following images (B- and P-frames) that differ from the reference image. A
viewing client will then reconstruct all images based on the reference image and the “difference data”.

At the cost of higher complexity, the result of applying MPEG video compression is that the amount of
data transmitted across the network is less than that of Motion JPEG. This is illustrated below where
only information about the differences in the second and third frames is transmitted

£ {

H.264 and MxPEG all work very similar to MPEG-4 whereby H.264, for example, needs only about
60% of the bandwidth of MPEG-4 for roughly the same video quality. However, this efficiency does not
come for free. Encoding and decoding H.264 needs more CPU power than MPEG-4. A general rule is
that the higher the compression factor the heavier the CPU burden (in the server and in the clients).
Therefore there is always a tradeoff between bandwidth utilization and CPU power needed.

1.4.4 Advantages and disadvantages of Motion JPEG and MPEG (MPEG-4, H.264, and
MXPEG)

Due to its simplicity, Motion JPEG (MJPEG) is a good choice for use in many applications. JPEG is a
widely available standard in many systems often by default. It's a simple compression/decompression
technique, which means the cost, in both system time and money, for encoding and decoding is kept
low. The time aspect means that there is limited delay between image capturing in a camera,
encoding, transfer over the network, decoding, and finally display at the viewing station. In other
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words, MIJPEG provides low latency due to its simplicity (image compression and complete individual
images), and for this reason it's also well suited for when image processing is to be performed, for
example video motion detection or object tracking.

MJPEG gives a guaranteed image quality regardless of movement or complexity of the image scenes.
It still offers the flexibility to select either high image quality (low compression) or lower image quality
(high compression) with the benefit of lower image file sizes, thus lower bit-rate and bandwidth usage.
At the same time the frame rate can be easily controlled, providing a means to limit bandwidth usage
by reducing the frame rate, but still with a guaranteed image quality.

Since MJPEG does not make use of a video compression technique, it generates a relatively large
amount of image data that is sent across the network. For this reason, at a given image compression
level (defining the image quality of the I-frame and JPEG image respectively), the network bandwidth
is less for MPEG compared to MJPEG, except at very low frame rates.

Another difference is that most MJPEG IP cameras can produce multiple simultaneous streams and in
different qualities (image sizes and compression quality) while most MPEG cameras can produce only
one stream in one quality. Therefore the same stream will be used in live viewing and recording.

This summarizes the benefit of MPEG: the ability to give a relatively high image quality at a lower bit-
rate (bandwidth usage). This can be especially important if the available network bandwidth is limited,
or if video is to be stored (recorded) at a high frame rate and there are storage space restraints. The
lower bandwidth demands come at the cost of higher complexity in encoding and decoding, which in
turn contributes to a higher latency when compared to MJPEG.

The graph below shows in principle how bandwidth use between MJPEG and MPEG compares at a
given image scene with motion. As can be seen, at very low frame rates, where MPEG compression
cannot make use of similarities between neighboring frames to a high degree, and due to the
overhead generated by the MPEG streaming format, the bandwidth consumption is actually higher
than MJPEG.

1 M-JPEG

MPEG-4

Bandwidth

Frame rate

1.4.5 JPEG image sizes and storage requirements

The image (recording) quality and image size affects the required storage per image (frame). Likewise
does the frame rate impact the recording storage and also the network bandwidth.

Observer supports all image sizes that a camera offers. The following are some values for typical
JPEG images:

JPEG Image size Image quality Storage per image
approximately

Small Low 3 KB
176x144 QCIF PAL

176x120 QCIF NTSC _

160x120 QQVGA Medium 5 KB

High 8 KB
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JPEG Image size Image quality Storage per image
approximately

Medium Low 8 KB
352x288 CIF PAL
352x240 CIF NTSC

320x240 QVGA Medium 13 KB
High 20 KB
Large* Low 20 KB

704x576 4CIF PAL
704x480 ACIF NTSC _
640x480 VGA Medium 34 KB

High 52 KB

* For mega-pixel cameras the image size will be much bigger than shown in the table.

10
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2 Observer clients on multiple platforms

2.1 Introduction to Observer clients

Once you have successfully installed Observer on your server, authorized users can access the server
via an Observer client.

Normally the Observer client runs on a PC separate from the server, however in a client-on-server
installation the client runs directly on the server (see the document NETAVIS Observer Server
Installation and Administration for further information on how to create and run a client-on-server
installation).

Clients for various platforms

You can choose among these Observer clients, operating systems and platforms:

Observer client OS and platform Supported functionality
Locally installed desktop client MS Windows 7, XP, Vista, etc. All

) ] ) No audio, layout navigation, and
Linux, Unix (also client on server PTZ-Joysticks; Mac OS-X:

Cos) additionally no MPEG streaming
(MPEG-4, H.264, and MxPEG)
Desktop web browser MS Windows 7, XP, Vista, etc. No layout navigation and
Joysticks for PTZ control
Linux, Unix No audio, layout navigation, and
PTZ-Joysticks; Mac OS-X:
additionally no MPEG streaming
(MPEG-4, H.264, and MxPEG)
Apple iPad client iOS 4.x and newer Live viewing and archive access.
Other functions are not
supported yet.
Smartphone browser client many smartphone platforms and | Live viewing only
OSes

Please be aware that some functions like Layout Navigation and running SAFE export files may only
be available on the MS Windows platform.

This chapter describes how to start the Observer client on a desktop PC. If you want to run Observer
on a mobile device please refer to 2.5 Mobile Observer clients on page 20.

The minimum screen resolution for running the Observer client is 1024x768 pixels.
Licensing issues

The available functionality of your Observer installation is defined by the license string. The document
NETAVIS Observer Server Installation and Administration describes how licensing works and how to
obtain a license string. If you have a temporary demo license, a License dialog appears at every login

11
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indicating that there is no permanent license. At this dialog just push the Continue button to operate
Observer in the demo mode.

See 11.1 Server system information and restarting on page 82 for how to display the current license of
your server.

2.1.1 Advanced client technology
The Observer uses advanced technologies to ease the operation of clients on MS Windows platforms:

e Lazy-loading client technology: Observer clients (both browser-based and locally installed)
only load the needed application components from the server on demand, when they are
needed. This saves time at startup and also bandwidth. It also eases the management and
upgrading of clients. Libraries for one version are downloaded only once and are now stored
locally on the client machine. The path is <user’s home directory>\netavisLibs\<version> (e.qg.
D:\Documents and Settings\user\netavisLibs\1.9.0.110.200).

e Automatic client upgrading: Whenever the Observer server is upgraded to a new version, the
clients are automatically upgraded too. This is happening transparently to the user. The same
client will still be able to work with older server versions (see next point). Starting with release
1.9 the client application has to be installed only once and every further Observer version will
be seamlessly accessible, without having to manually upgrade the client.

o Different versions between servers and clients: Starting with release 1.9 Observer clients
can connect to servers running different versions (release 1.9 or newer) without the need to
install clients matching the servers’ versions.

As a summary, Observer clients...

e ...download libraries (for one version) only once

o ...share the same libraries for both browser-based (applet) and installed client application
e ...can connect to servers having different versions

e ...automatically upgrade themselves when the server has a new version

2.2 Starting the Observer client from a desktop web browser

This section describes how to start the client in a standard web browser. If you want to install the client
on your machine and run it independently of a web browser, please refer to 2.3 Working with the
installed Observer client on page 15.

Generally you can start the client with an unencrypted HTTP connection or with an encrypted HTTPS
connection.

1. To access the client via an unencrypted HTTP connection start a web browser and enter the
address of your Observer server: http://1P-address-of-your-server

To access the client via an encrypted HTTPS connection start a web browser and enter the
address of your Observer server: https://1P-address-of-your-server

12
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‘2 about:blank - Microsoft Internat Explorer,

>
Datei  Bearbeiten  Ansicht  Favoriten  Extras

adresse | hitp:f80.81.128.30 |, j
Lot

-

Now a page that checks the availability of the Java on your computer appears. This page should
disappear in a few seconds.

If this page stays, it means that you do not have the Java plug-in installed on your browser. You
have to first install Java by visiting www.java.com/download to install the latest Java 2 package
and then start the browser anew. Now the screen should disappear and you can continue as
shown below.

Next a startup screen is displayed that lets you choose the language that you want to use. Click
on your language of choice and push Start. This takes you to the start page of Observer:

Click on Start Observer client (from the browser using Web Start). Depending on the browser
you are using you might be asked whether you want to execute the Java JNLP link. Click on OK
(to tell the browser to automatically start see 2.2.1 Optimizing the Web Start behavior of your
browser on page 14). Now you will be advised that the program is being loaded. How long
loading takes depends on your network.

On completion of loading, you will be notified that Observer is initializing. Then user data is
loaded.

Note: By clicking on Install the Observer client on your PC you can also install the Observer
client on your machine locally (see 2.3 Working with the installed Observer client on page 15).

Before starting the Observer client you will be asked if you allow to execute the downloaded
trusted applet:

Sicherheitswarnung &|

Installieren und Ausflhren von “"NetAVIS Observer 11",
signiert zu einem unbekannten Datum,/Uhrzeit und
herausgegeben von:

KXperts Software Lid.

Authentizitat des Herausaebers bestatiat durch VeriSign
(Class 3 Code Signing 2001 CA

Hinweis: Xperts Software Ltd. versichert, dass dieser Inhalt
sicher ist. Die Installation bzw. das Anzeigen des Inhalts
sollte nur erfolgen, wenn Sie Xperts Software Ltd.
vertrauen.

Zugelassens Signatur
Volle Fugriffsrechte

(1 Inhalt von Xperts Software Ltd. immer vertrauen

[ Ja ] I Nein ] [Wei‘tere Irformationen

13


http://www.java.com/download

NETAVIS Observer 4.4 User Manual

Select the checkbox ...always trust... and click on Yes to allow the download of the trusted
applet.

When you start the client the first time after a new installation some additional client application
components need to be installed (this is needed only once per client). You will be asked:

[iformation X ]

.@ Your client needs further program components.
Install program components from...

| Local media | | Server over nelwork ‘ | Cancel

Normally you want choose to install the program components from Server over network.
However, if you have a very slow network connection between the client and the server you
might want to choose installation from Local media. When you choose this option you will be
asked to locate the directory ClientInstaller of the Observer installation CD. Once you choose
the correct location and push OK, the components will be installed.

5. Next you either come to the login panel or to the license dialog.
If the license dialog appears you yet have to obtain a license for using Observer. Please consult
the manual NETAVIS Observer Server Installation and Administration for information on how to
do that.
At the login panel enter your Login name and Password and click OK.

Pazsward:

Login name:

| Forgot my password

Ok | Cancel | Guest login |

If you do not yet have a permanent license string for Observer, a License dialog appears. To
continue without a permanent license just push Continue. In this case the full functionality may
not be available. See also 2.1 Introduction to Observer clients on page 11 for further details
about licensing.

Please note: The authentication data transferred between client and server are encrypted with MD5
strong encryption.

The administration user admin has the default password admin. For security reasons you should
change this password (please see 5 Managing users on page 34).

A guest login is possible only if the guest has been defined on your server (which is the factory
setting). For further details contact your Observer administrator.

If you have forgotten your password, you can mark the Forgot my password checkbox, answer the
asked question, and click OK. For more information, ask your Observer administrator.

2.2.1 Optimizing the Web Start behavior of your browser

When you click on a Java Web Start link (JNLP) like the Start Observer client (from the browser
using Web Start), some browsers ask whether you want to download and save the file Web Start
JNLP file instead of executing it. This can be annoying because you have to first save the file and then
execute it manually. Here is how you can automate that for various web browsers.
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Optimizing Web Start for Google Chrome

1. Click on the link that you are trying to launch, and Chrome will download it, as before.

2. By default Chrome will list the download on the bottom of the page. To the right of the filename is
a small drop down arrow, click it.

3. From the menu that pops up select Always open files of this type. Now, when you click on the
Web Start link the next time, the application will start automatically.

2.2.2 What is next

If your Observer server already has cameras configured, then you can go to chapter 6 Using the
Online monitor on page 39. If you have to setup cameras first, then continue with chapter 4 Setting up
cameras on page 25.

Furthermore, because Observer behaves in a context-sensitive way, you will find that certain menu
items are also disabled at certain times. Thus, for example, you cannot remove a camera if there is no
camera to remove. Thus in different contexts the same menu might look quite different at different
times (menu entries and buttons in grey are disabled and in black are enabled).

2.3 Working with the installed Observer client

Alternatively to starting the Observer client from a web browser you can also install the Java client
application locally on your machine. Some functions are only available in the installed client (see 2.1
Introduction to Observer clients on page 11 for details).

2.3.1 Installing the Observer client
To install the client locally on your PC, please follow these steps:

1. Atthe Observer Start page click on the link Install the Observer client on your PC (using
Web Start).
2. Save and run the Web Start installer.

3. Follow the steps of the setup program.
Alternatively you can also download and run the client installer executable on Windows platforms:

1. Atthe Observer Start page click on the link Alternative installation: Download Observer
client installer executable (Windows only).

2. Save the client installer executable at an arbitrary location.

3. Execute the just downloaded client installer (Observer_setup.exe).

4. Follow the steps of the setup program (standard Windows installation).

2.3.2 Starting the installed Observer client

Once the setup finished you can start the client locally from your Windows Start menu (or also from a
desktop icon if you selected so at installation). The Starter window appears:
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‘| Starter V2,61

Saved Sessions

4.0 HU admin
admin@nct.xperts.hu
4.0 HU ckl

ckl@nct. xperts.hu
4.0 HU ckl fast # Modify
ckl@&4.21.30.209:8380
default

= Add new

4 Delete

admin@showroom. netavis.net
ind31.selfip.biz
netavis@ind31.zelfip.biz

ind31.selfip.biz admin
admin@ind31.selfip.biz

licensing admin

admin@licensing.netavis.net

Working with sessions

The Starter allows you to manage sessions. In a session you can define the server address, which
Observer application to start and the user/password details. Thus you can store and run different
sessions easily.

The Session editor is opened when you push Add new or Modify and allows you can define the
session details:

Element Meaning
Session name Name under which the session is stored.
Application You can either choose Observer Client or Layout Navigation

Tool (for further details on the Layout Navigation Tool please refer
to 13 Working with Layout Navigation on page 93). The selected
application will start when you press OK.

Previous Sessions Offers you the list of previously active sessions.
Hostname or IP Address | Enter the name or IP address of the server you want to connect to.
Use secure connection Select this checkbox if you want to use an encrypted connection

between the client and the server (SSL HTTPS).

Please be aware that an encrypted connection needs more CPU
resources on the server and on the client. See also 1.3 Observer
data security on page 6.

Username Enter the login name of the user.
Password Enter the password for the user.
Remember password Select the checkbox if you want the password to be remembered

for the next start of the application.

Alternative Session Here you can select another session out of the already defined
session that should be started automatically when the server of this
session is not accessible.

Show message if Select this checkbox if a message should be shown when the
alternative session started | alternative session is started.
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Starting the Observer client

Pushing Start in the Starter will open the client window and connect you to the Observer server.
When the client is started, the Starter window will be hidden and in the task bar you will see it's icon.
You can access the Starter by clicking its icon. There you can open the Starter dialog again and also
force an exit of the client application.

Active sessions 4
Quick Connect to 4

Open Starter dialog
& -

When you start the client the first time after a new installation some additional client application
components need to be installed (this is needed only once per client). You will be asked:

Tnformation ||

.@ Your client needs further program components.
Install program components from...

| Local media | | Server over nelwork ‘ | Cancel

Normally you want choose to install the program components from Server over network. However, if
you have a very slow network connection between the client and the server you might want to choose
installation from Local media. When you choose this option you will be asked to locate the directory
ClientInstaller of the Observer installation CD. Once you choose the correct location and push OK,
the components will be installed.

If you do not yet have a permanent license string for Observer, a License dialog appears. To continue
without a permanent license just push Continue. In this case the full functionality may not be
available. See also 2.1 Introduction to Observer clients on page 11 for further details about licensing.

Using a different directory for the installed client application components

Per default, the downloaded client application components will be installed in the directory
%USERPROFILE%\netavisLibs (e.g. C:\Documents and Settings\user\netavisLibs).
You can redefine this directory by setting the environment variable NETAVIS_DIRECTORY. The
directory must exists prior to starting the Observer client. If the variable does not exist, the client
components will be installed in the standard directory.

Here is how you can set an environment variable in Windows 7:

1. Right click on the Computer icon in your Explorer or on your Desktop and choose Properties.
2. Inthe System window click on Advanced system settings in the left pane.

3. Inthe System Properties window select Advanced tab and click on the button Environment
Variables at the bottom of the dialog.

4. Inthe Environment Variables window you will notice two tables User variables for the current
user and System variables for all users.

5. To add a new User variable click on New... button. In the New User Variable dialog box enter
the variable name NETAVIS_DIRECTORY and the location of the directory and then click OK. The
default location would be %YUSERPROFILE%\netavisLibs.

6. Click OK in the Environment Variables dialog window and close the other dialogs as well.
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Working with sessions of pre-4.0 servers

The Starter also allows you to also manage sessions with Observer servers running releases older

than 4.0. Just select the checkbox Show settings for pre-4.0 releases to show the additional

settings.

Description of elements:

Element

Window width, height

Upper left corner X, Y

Initial monitor view name

Window decoration visible

Tool control bar visible

Event bar visible

Online monitor control bar

visible

Overlay painting enabled

Meaning

Define the size of the client window in pixels.

Define the location of the upper left corner of the client window in
pixels. This setting can be changed, e.g., for multi-screen setups.

Is optional and defines the initial Online monitor view.
Defines whether the windows decoration border is visible.

Defines whether the tool control bar at the right side of the window
is visible. This bar allows switching between Online Monitor,
Archive Player, Event Management and Administration.

Defines whether the event bar at the bottom of the window is
visible.

Defines whether the @/ menu and the history buttons for Online
monitor control are visible.

When this is selected and the hardware supports it the Online
monitor uses the hardware overlay technique for displaying flicker-
free MPEG streams. This can also boost the client performance and
relieve the main CPU.

In multi-screen operation, overlay painting of MPEG video streams
may result in pink colored view ports if the client is not running on
the primary screen of Windows. Then you should turn off this
feature.

2.4 Client multi-window and multi-screen operation

Observer supports multi-window and multi-screen operation. With clients that have multiple screens

connected you can position windows at different screens.

Here is an example of a client setup with 3 screens:
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Monitor 1 Monitor 2 Monitor 3
Live overview Live alarm view Recordingarchive

incl. event list and incl. prioritized event list and incl.eventmarkers
ICAT friggers iCAT statistics diagram

The window contents and positions are automatically stored per user and between sessions. This

means when a user has multiple windows positioned on 3 screens and he exits and then logs in again,

all the windows on the 3 screens will automatically be restored.

Please note: There can only be one Archive player and this is located in the main window.

2.4.1 Creating a new window

In the main application window select New window from the Windows menu.

The window title and the contents of the window can be adapted by choosing Client preferences... i

the Observer menu (see below).

2.4.2 Defining what components to display in a window
For each window you can define which of these components should be displayed in the window:

Online Monitor

Archive player
Event list

e Cameratree

You can define any combination of components and you can also define that a window should contain

only one component.

Note: Depending on the authorization that your Observer administrator has assigned to you, some of
the client components could be disabled (menu shown in grey color). If you need more authorization,

please contact your local Observer administrator.

Here is how you can define what components are to be shown in a window:

1. Inthe Observer menu choose Client preferences... which will open the dialog.

2. For each window you can define what should be displayed. For example, select the Online
monitor node and turn on (select) the Display Online monitor check box. For each window

individually you can turn on or off the Event list, Camera tree, and Archive player (only for the

main window).

Please note: Normally it does not make sense to always show the camera tree since it will be
opened when needed on demand.
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2.4.3 Modifying window layouts

You can also modify the layout of a window by rearranging its components. Once you have defined in
the Client preferences dialog what components are to be shown in a window you can customize the

layout. Select the menu Windows->Enable layout customization. For the Event list and the Camera
tree you can now define:

o Where they are located inside the window: Just click on the title bar of the Event list or the
Camera tree and drag it to a different location. For example, when the Online monitor and the
Event list are enabled, then you can drag the Event list from the default position at the right
border of the window to the bottom of the window.

Events O — s+ m
ID Time == e |l T
383871 (302011 15:00:44 | =
904 3100372011 15:10:12

o Whether they are floating (open when needed or there are new entries and collapsed or hidden
otherwise) or pinned (always shown): You can change the state of the Event list or the Camera
tree by pinning * or unpinning # it in the title bar.

Whether the Event list or the Camera tree should fill the whole window: You can maximize the
component by pushing the maximize button B. When a component is maximized, it will occupy
the whole space of the window and will automatically resize when you resize the window. Thus
you can create a window that contains only an Event list.

After you are done with the modifications deselect Windows->Enable layout customization.

The default location for the Event list is the right window border and for the Camera tree (that usually
only pops up when needed) it is the left window border.

Please note that only the Event list and the Camera tree can be dragged. The other components in the
window will then change their size accordingly.

2.4.4 Deleting a window

In the main application window select Delete window... from the Windows menu. A Delete window
dialog will open, offering you the list of available windows for deletion.

2.4.5 Positioning a window on a certain screen

Positioning a window on a certain screen is very easy: With the mouse just drag the window to the
screen and drop it there. You can also maximize the window on the screen. All the window states will
be remembered between sessions. This happens on a per-user basis, which means when the user is
logging in on a different client workstation he will have the same window setup as on the first client
workstation.

2.5 Mobile Observer clients

You can access an Observer server also from mobile devices like tablets and smartphones.
Mobile clients do not support the full functionality of desktop clients. the live viewing of video streams
from an Observer server.

This chapter describes how you can install and run Observer on such mobile devices.
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2.5.1 Supported devices
Currently Observer allows you to install the mobile client on these systems:

e Apple iPad client with iOS 3.0 or newer

e Smartphone browser client for most smartphone platforms (including Android, iOS, Blackberry,
Windows mobile). Please refer to the document NETAVIS Observer Server and Client
Compatibility for further details on compatibility.

2.5.2 Installing the Observer client on a mobile device

The Smartphone browser client can be run directly in a smartphone web browser and does not need
any installation.

For the Apple iPad client follow these steps:

1. Goto the iTunes Store and search for "NETAVIS".
2. Install the Observer application on your iPad.

2.5.3 Running the Observer client on a mobile device

Apple iPad

1. Start the Observer iPad client.

2. Connect to an Observer server and login.

3. When you get the camera tree tap on a camera to show the live stream.

4. To zoom a camera view in and out in pinch your fingers together or apart. You can also double-tap

(tap twice quickly) to zoom in, then double-tap again to zoom out.

Smartphone browser client

1. Start a web browser on your smartphone.
2. Enter the address of your Observer server and login.

Please note: On a mobile device the Smartphone client should be activated automatically. When
that is not the case, you can access the Smartphone client at <my-server>/browserclient.

3. When you get the camera tree tap/click on a camera to show the live stream.

2.6 Observer Transcoding™ for low-bandwidth client-server connections (ABS)

The unique Observer Transcoding™ technology (also called ABS for adaptive balanced streaming)
reduces the necessary bandwidth for video streams to a fraction of the usual values. Especially high-
resolution cameras can thus be streamed from server to clients over low-bandwidth wide areas
network (WAN) connections without loss of quality. Therefore even megapixel cameras can be
operated over very low bandwidth connections that would normally prevent their operation. The
technology works for all cameras, streaming resolutions, and formats (including MPEG-4, H.264, and
MxPEG).

Additional CPU resources are needed at the server and at the client for transcoding streams.

Transcoding™ can be set up in the server level by limiting bandwidth for live video and recording
playback streams as well as for recording exports (defined in 11.2 Setting Observer server parameters
on page 84).
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Important: Although transcoding works with all streaming formats, the best results and least CPU
overhead are possible with MJPEG streaming. Also the transcoding bandwidth limit must be chosen
carefully.

Therefore we suggest:

* MJPEG streaming format.

 Limit the transcoding bandwidth to app. 70% of the available server-client connection
bandwidth.

For connections, like Internet connections, with heavily varying bandwidth it is much better to use a
lower limit than a higher limit. With low limits of 256 kbit/s or 128 kbit/s very good results are possible.
Some customers have even used 56 kbit/s or 30 kbit/s with transcoding.

As indicated above the limits are defined in 11.2 Setting Observer server parameters on page 84.

2.7 Exiting the client

The Observer client can be exited by choosing Exit from the Observer menu at the main application
window. You will be asked whether you really want to exit.

If the menu bar is hidden, you can exit the client via the right mouse button menu.
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3 Guidelines for setting up a new system with Observer

This section guides you how to best set up a new system with Observer. Is shows which steps are
needed in which order and gives you some hints on how to configure cameras and users.

For a simple system with 1 server take these steps:

1. Setting up cameras
2. Setting up users
3. Setting up views

For a bigger system with connected servers take these steps

1. Setting up servers
2. Setting up cameras
3. Setting up users

4. Setting up views

Please note: All of these steps should be taken by the administrator user (usually login admin).

Here we describe the steps for one server (for the setup of connected servers please see 12 Working
with interconnected Observer servers on page 88):

3.1 Guidelines for setting up cameras

Usually a system consists of several cameras of the same type with similar settings. Bigger systems
may have many cameras of the same type and several different types. Therefore Observer offers you
the possibility to duplicate cameras in order to facilitate the setup.

Take these steps for setting up cameras:

1. Define camera groups. We found that a good grouping criteria is location of the camera. Another
grouping criteria could be access rights for various users groups. See 4.6 Working with camera
groups on page 32 for details.

2. For each of the cameras that are of the same type and have a similar setting for recording and
possibly motion detection create a camera that serves as a blueprint for other cameras and can be
duplicated later.

Define also the recording settings for this camera. For motion detection (MD) take useful default
values that can be tuned later on (please note that first you have to create the MD definition and
then you set up the scheduling/recording for the MD setting).

Since most video analytics settings are different between cameras, it does not make a lot of sense
to create default values for video analytics at this point in time. One exception could be that you
may want to set up the same object tracking regions for several cameras.

For further details please refer to 4.2 Adding a new camera and setting basic properties on page
25 and 8 Working with simple motion detection on page 64.

3. Now duplicate (clone) the cameras and, if necessary, move them to different camera groups.

After that you can fine tune the camera setup and define special settings like video analytics for
various purposes (see 14 Video analytics with iCAT on page 105).

3.2 Guidelines for setting up users
Usually a bigger system will allows several users to login with different privileges and rights. Therefore

it can be useful to group several users with similar tasks and rights in so called user groups in
Observer.
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Take these steps for setting up users and groups:

1. Create user groups for the various roles and privileges (examples are: security personell, view
only users, administrators). For each users group define the system wide privileges. See 5
Managing users on page 34.

2. Inthe users groups create the users you need. Please note that by default the users will inherit the
privileges from the group they belong to.

3. Set the camera access rights per user.

3.3 Guidelines for setting up views

Observer allows you create several views for showing cameras in various configurations and sizes.
Therefore it makes sense to create various views for different surveillance purposes. Since the views
are defined by user, we suggest that the administrator creates the standard set of views and then
copies the views to the various users.

Take these steps for setting up views:

1. Create the various views needed by most users. See 6.1 Creating a new view on page 39.
2. Copy the views to the various users. See 6.8 Copying views between users on page 46.

Later on you can create further views and copy them again.
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4 Setting up cameras

Observer allows any authorized user to set up cameras in the system. Ask your Observer system
administrator whether you have such authorization.

4.1 Preparations

Before you begin to set up a new camera in Observer, be sure to have the following information
available:
e Your camera type.

e |s your camera type supported by Observer?
Please consult the document NETAVIS Observer Supported Video Sources.

e Are there available licenses for setting up additional cameras?
e |P addresses of cameras (or camera servers).

Please note: Here we describe how to setup a camera in Observer. If you setup an IP camera, then
the camera itself also can be configured. This is normally done via a web-based interface of the
camera. Please consult the manual of your IP camera for further details.

4.2 Adding a new camera and setting basic properties
Start the Observer client application (see 2 Observer clients on multiple platforms on page 11).
You can either

e add a new camera from scratch, or

e duplicate an existing camera and just modify some parameters (see 4.2.2 Duplicating an
existing camera on page 31). Duplicating an existing camera creates an exact duplicate with all
settings copied. This is useful when you have more than one camera of the same type or with
equal/similar settings (like recording or video analytics settings).

4.2.1 Adding a camera from scratch

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

2. With a mouse click, select the camera group to which you want to add the new camera (later on
you can move the camera in the camera tree to a different group).

3. Choose Add new camera from the menu.

The Properties dialog opens in which you can configure the camera.
Enter your camera data in the corresponding fields. Use the following table as a guide. Fields
labeled in bold are mandatory while all others are optional:

Field label Your input

Camera name Enter the name that you want to give your camera. This is the name
by which you will select or display this camera (e.g., camera 2).

Comment Here you can add text that describes your camera.
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Field label

Time zone

Camera type

Name of camera admin

Pwd of camera admin

Camera IP address

Camera server port

Aspect ratio

Streaming mode
(Mobotix only)

Use HTTPS encryption

Non-interlaced mode

Your input

Select the time zone of your camera'’s location (e.g., CET for a
camera installed in Vienna).

Specify the type of camera by selecting it from the camera pop-up
menu.

Important: If you want to connect an analog camera via a video
server then select the type of the video server from the menu. If you
connect an analog camera to a video capture card directly in the
Observer server, then select NDS (Observer Digitizer Server) as
your camera type.

If the camera needs authentication for administrating, then enter the
user name of the camera administrator here.

Enter the password of the administrator account of the camera (only
if used).

Specify the IP address or network name of your camera or video
server. If you supply a network name, you must have access to a
domain name server (DNS) that resolves the name to an IP
address. Even dynamic DNS names (like dyndns) can be used.
This field is not needed for analog cameras connected directly via a
video capture card (NDS).

If you are adding an analog camera via a video capture card (NDS)
or via a video server, specify the port of the capture card or video
server to which the camera is connected.

This setting is only enabled for certain IP cameras that are shipped
with different aspect ratios (like PAL or NTSC). For cameras that
are delivered in one standard only, the correct value is set
automatically and cannot be changed. Please select the correct
value for your camera. If you select a value that does not fit your
camera, then the image might be distorted. Please refer also to
1.4.5 JPEG image sizes and storage requirements on page 9.

This option is only relevant if you use a Mobotix camera. Set it
when you would like to operate the camera in streaming mode. If
this option is not activated, the camera operates in single picture
mode. In streaming mode (MJPEG format) the camera delivers
higher frame rates than in single picture mode. If you activate the
streaming mode you also must set the according option in the
camera with the Admin tools of the camera.

If the camera supports encrypted streaming using HTTPS this
setting will be enabled. It defines whether streaming from the
camera is encrypted using HTTPS. Please note that encryption
needs significantly more CPU resources on the server than
unencrypted communication (see also 1.3 Observer data security
on page 6).

This option is only relevant for digital cameras or video servers that
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Your input

support 2CIF resolution to reduce the interlace effect. Please refer
to the camera's documentation.

Push Save to create the new camera.

Select the newly created camera again in the camera tree and then push the Next button at the
bottom. This invokes the Default settings dialog that lets you define the default image and audio
settings for your camera. To modify values choose Modify selected camera or group menu.

Fields for Basic video and audio settings:

Field label

Multi stream allowed

Allow JPEG streaming

Allow MPEG-4 streaming

Your input

Some cameras are capable of providing multiple video streams in
parallel. This can be helpful for example, when online viewing and
recording is to be done in different formats or for optimizing iCAT
video analytics performance (see 1.4 Video streaming methods and
compression on page 7 for a general discussion about multi
streaming).

Usually MJPEG cameras can deliver several MJPEG streams while
MPEG (MPEG-4, H.264, and MXxPEG) cameras deliver only 1
MPEG stream (some camera types can deliver several MJPEG
streams in addition to the MPEG stream).

If this option is not selected, then only 1 video stream will be pulled
from the camera regardless of how many different formats would be
needed.

If it is selected then multiple streams will be pulled.

Also consider the following checkboxes that define, which formats
can be pulled from the camera.

Please note: Multi-streaming has some important restrictions that
depend heavily on the camera type. Please refer to the document
NETAVIS Observer Supported Video Sources for details on
restrictions.

If your camera supports MJPEG video streaming, you can allow
using this mode by selecting this checkbox.

In one special case, Observer will try to pull an MJPEG stream
even if this checkbox is deselected. This is the case when iCAT
video analytics is working on MPEG streams (e.g. for motion
detection) and Multi stream allowed is selected. This special
additional MJPEG stream in QVGA is used only for iCAT and helps
to minimize server CPU load for iCAT processing (please refer also
to 14.2.1 Considerations for setting up a system with iCAT on page
106).

If your camera supports MPEG-4 video streaming, you can allow

using this mode in the Online Monitor and the archive by marking

this checkbox.

Please note that platform restrictions may apply for this streaming
mode (please refer to 2.1 Introduction to Observer clients on page
11).
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Field label

Allow H.264 streaming

Allow MXPEG streaming

Stream MPEG-4 via
Multicast

Allow Audio to camera

Allow Audio from camera

Audio from and to share
single button

Anonymize (distort) audio

Your input

If your camera supports H.264 video streaming, you can allow using
this mode in the Online Monitor and the archive by marking this
checkbox.

Please note that platform restrictions may apply for this streaming
mode (please refer to 2.1 Introduction to Observer clients on page
11).

If your camera supports MXPEG video streaming, you can allow
using this mode in the Online Monitor and the archive by marking
this checkbox.

Please not that platform restrictions may apply for this streaming
mode (please refer to 2.1 Introduction to Observer clients on page
11).

This option should only be switched on in very special situations.
When marked then the MPEG-4 stream from the camera is
received via "multicast", when disabled via "RTSP over HTTP".
Multicast is a one-to-many, while RTSP is one-to-one type
connection.

Mark this checkbox only if you want to have multicast MPEG-4
streaming of the camera. In most cases you want to leave this
checkbox not marked, which means that the MPEG-4 stream is
transmitted via RTSP over HTTP.

When marked, Observer will allow Audio to the camera and will
offer a button for that in the Online Monitor. Of course this feature
only works if you have a working microphone connected to the PC
where you run your client on and your camera has a loudspeaker
function.

When marked, Observer will allow Audio from the camera to your
client (in the Online Monitor and for recordings). Of course this
feature only works if you have a working loudspeaker connected to
the PC where you run your client on. Please note that platform
restrictions may apply for this streaming mode (please refer to 2.1
Introduction to Observer clients on page 11).

If this checkbox is marked, then there is only one button in the
Online Monitor that switches MPEG and Audio on and off. If this
checkbox is not marked, then you will find 3 buttons for the three
functions. See also 6.9 Working with MPEG cameras and audio ()
on page 46.

In some cases Laws do not allow the transmission or recording of
people's voices. The criterion often is whether one can recognize a
person by listening to its voice. Therefore Observer allows
anonymizing the audio stream by distorting it. If this checkbox is
marked then the live and recorded audio will be anonymized
(distorted).

The Default settings for MPEG-4, H.264, MXPEG and Default settings for single-stream
JPEG cameras define the streaming format for the various streaming types. These settings will
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be used in the Online Monitor and also for recordings. For multi-stream JPEG cameras, the
Default settings for single-stream JPEG cameras are of no importance (because for each
view port in the Online Monitor and also for recording separate formats can be specified).

Please note: In the current version, Observer only supports 1 streaming format for MPEG
cameras for live viewing and recording.

Field label

Use these settings

Image quality

Image size

Frame rate

GOP size

Your input

Usually this checkbox must be set. It defines whether the default
camera settings are set via Observer or in the camera directly (via
its own setting utilities). When it is switched on, the settings in the
camera are overwritten by the values of this dialog. When it is
switched off, the values from the camera are taken and the settings
in Observer are ignored.

In very special situations only, e.g. when setting the values by
Observer causes some unwanted side effects in the camera, you
may want to set the values in the camera directly and switch off this
check box.

Defines the image quality of the stream. The possible values are
High, Medium, and Low quality. The higher the quality, the more
bandwidth will be used for transmission and the bigger the space
requirements for recording will be (see also 1.4 Video streaming
methods and compression on page 7).

For multi-stream JPEG cameras, this value cannot be set here,
since separate image qualities can be set for recording and in each
view port in the Online Monitor.

Defines the image size of the stream. Possible values depend on
the camera model. The bigger the image size, the more bandwidth
will be used for transmission and the more space for recording will
be needed.

For multi-stream JPEG cameras, this value is of no importance,
since separate image sizes can be set for recording and in each
view port in the Online Monitor.

Defines the frame rate of the stream. Possible values depend on
the camera model. The bigger the frame rate, the more bandwidth
will be used for transmission and the more space for recording will
be needed.

For single-stream JPEG cameras, this value defines the maximum
possible frame rate. In the Online monitor and for recording lower
frame rates can be selected.

For MPEG streams defines the how many frames are sent and
stored in a GOP (group of pictures). One GOP is an integral data
packet that is transmitted and recorded. Our default value is 10,
which means that there is 1 reference frame (I frame) and 9
difference frames (P frames). A bigger GOP size means a higher
compression rate but also a somewhat lower quality and a bigger
delay between a real scene and its viewed images (which is
relevant, e.g. for live viewing in the Online Monitor). We think that a
GOP size of 10 is optimal for most case, which, dependent on
camera model, covers a time between 0.5 ~ 1 sec.
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Field label Your input

Bandwidth limit (Kbps) This setting limits the maximum bandwidth in kilobits per second for
the transmission of MPEG streams between the camera and the
server. As a consequence, also the bandwidth between the server
and the clients is thus limited and also the required storage in the
archive is influenced (limited). If this value is zero, then the
bandwidth is not limited.

This actually is a setting in the camera. The camera always
optimizes for the desired image quality and will sacrifice frame rate
in favor of quality in the case, the bandwidth would exceed the
supplied limit.

Fields for In-camera motion detection (please refer to 8.3 In-camera maotion detection on page
67 for further details):

Field label Your input

Receive event images via | If this checkbox is marked, you enable the In-camera motion

FTP detection and tell Observer to receive event images via FTP.
Please be aware that if you select this checkbox, the server-based
motion detection must be disabled.

Receive event images via | The same as above, just that the images are received via HTTP
HTTP protocol (some cameras support only HTTP).

Post recording length (sec) | When Observer receives an in-camera event, then it can start a
parallel server-side recording in addition to the event images it
receives from the camera. The event images received from the
camera via FTP/HTTP are merged with this server-side recording.
This field defines how long this parallel post-event recording is.

If it set to O, then Observer does not start its own server-side
recording of images and just stores the event images it receives
from the camera via FTP/HTTP.

Recording frequency This field defines the recording frequency of the above mentioned
parallel server-side post-event recording.

5. Push the Next button at the bottom of the dialog. This invokes the Scheduling dialog. Please
refer to 7.1 Programming archive recordings on page 49 on how to set up the camera archive
and scheduling.

6. Optional: Push the Next button again at the bottom of the dialog. This invokes the 1/0 Control
dialog that lets you define the handling of optional I/O contacts of your camera. If you do not
want to use I/O contacts you can just jump to the next step.

Set your values:

Field label Your input

Input handling enabled Select this check box if you want to process the state of the digital
input-contact port of the camera.
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Field label Your input

Input poll interval (msec) | The poll interval defines how often the state of the input port is
checked. Minimum time is 500 milliseconds.

Output handling enabled | Select this check box if you want to enable switching the digital
output port of the camera from within view port menu.

7. Push the Save button at the bottom of the dialog.

4.2.2 Duplicating an existing camera

Duplicating an existing camera creates an exact duplicate of the camera with all settings copied. This
is useful when you have more than one camera of the same type or with equal/similar settings (like
recording or video analytics settings).

With duplicating camera you can dramatically reduce the set up time for systems with many cameras
with similar settings.

Here is how you can do that:
1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.
2. Inthe camera tree select the camera you would like to duplicate/clone.
3. Choose Duplicate camera from the menu.

Now a new camera nhamed as the existing camera with "(copy)" appended has been created.

4. Set the basic properties like name and IP address.

5. Optionally modify other parameters as needed (see 4.2.1 Adding a camera from scratch on page
25 for details).

6. Push the Save button at the bottom of the dialog.

4.3 Setting up the camera recording archive

The configuration of camera recordings is covered in section 7.1 Programming archive recordings on
page 49.

4.4 Optional: Configuring video analytics (iICAT)

The configuration of video analytics with iCAT is covered in chapter 14 Video analytics with iCAT on
page 105.

4.5 Defining brightness, contrast, and saturation

If you are not satisfied with the brightness, contrast or saturation of camera video images then you can
modify them. For IP cameras and analog cameras there are two different ways of modifying those
video parameters:

e |P cameras: Each IP camera has its own setup interface (usually available via web browser) to
define / modify the video parameters. Please consult the admin / setup manual of the IP
camera.

e Analog cameras: Observer allows you to define video parameters via the System Admin
menu. Please see below for details.
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4.5.1 Defining video parameters for analog cameras

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

2. Select the camera in the camera tree for which you want to set the image values.

3. Press the Next button 4 times (starting from basic properties to scheduling to 1/0 control to
Image settings. Now you should see the Video parameters dialog:

. Analog1 {2) Video parameters
e TR !

| | | | | | | | |
Brightness; ' 50 !
1 1 1 1 1 1 1 1 1 1 ]
Contrast; ' 50 I
e
Saturation: 50

Original values

4. Inthe menu select Modify selected camera or group and then modify the brightness, Contrast
and Saturation values according to your needs. Please be aware that light conditions may
change during the day.

5. To store the settings press Save.

4.6 Working with camera groups

Camera groups are a powerful means for managing and organizing cameras.

4.6.1 Creating a new camera group

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.
2. Inthe camera tree select the group in which you want to create the new camera group.

3. Inthe menu select Add new camera group which will open new dialog that allows you to enter
the name and description for the new camera group.
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4. Optionally select the Use group name as camera name qualifier checkbox. If this checkbox is
selected then the name of the camera group is displayed as prefix to the camera name, e.g.
“group-name:camera-name”.

5. Press Save to create the new camera group.

4.6.2 Moving a camera or camera group in the camera tree

A camera or a group of cameras in the camera tree can be moved to another location by following
these steps:

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.
2. With a mouse click choose the camera or group you want to move.

3. Inthe menu select Move camera or group.
A new dialog appears that requires you to enter the password.

4. Enter the password.
After you enter the correct password a camera group dialog is opened showing the camera
groups.

5. Inthe newly opened camera groups dialog select the group where you want to move the camera
or group to and press Select.
Now the camera or group is moved to the new location and the camera tree is updated.

4.7 Changing the port mapping of analog cameras

This section is only valid for analog cameras. For analog cameras a port must be defined where the
camera is connected to at the video capture card or the video server.

Sometimes the port mapping of analog cameras needs to be changed but it is difficult to do that
physically by changing the cabling. To help the situation, Observer can change the port mapping in the
software.

There are two ways for doing that:

e Either go to the Camera Administration and manually switch the port there. For this however
you need to know exactly which camera is connected to which port.

e You can also swap the ports in the Online Monitor. This has the advantage that you see the
video pictures and therefore you can identify the correct ports visually.

In order to swap the ports of two analog cameras visually please follow these steps:

1. Inthe Online Monitor go to the view that shows the first analog camera in a view port.
2. CTRL-click into the view port that shows the first analog camera.

3. Now go to the view that shows the camera that you would like to swap with and CTRL-click in the
view port.

Now the ports of the two cameras have been swapped.
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5 Managing users

Observer requires users to login in order to work with the system. This chapter describes how to
create and manage users in Observer.

Generally, you can either

use Observer to administer users (see 5.1 Creating a new user account on page 34), or

utilize Active directory or LDAP to manage users (see 5.8 Working with users from Active
Directory or LDAP on page 37).

5.1 Creating a new user account

An Observer administrator can create user accounts in the system.

Please note: At initial product installation of a set of predefined users accounts and groups are
created. These users and groups model typical permissions of users in various roles. Instead of
creating a new user account you can take one of these predefined users and modify the settings
accordingly.

Here are the steps for creating a new user account:

1.

34

Choose User admin from the System administration menu. This opens the User admin
dialog.

Select a user group to which you want to add the user. Please refer to 5.4 Working with user
groups on page 36 if you want to create a new user group first.

In the menu select Add new user. The Properties dialog opens to allow you to enter user data.

Enter your user data in the corresponding fields of the dialog. Use the following table as a guide.
Fields labeled in bold (both in the dialog and in the table) are mandatory; all others are optional:

Field label Your input
Login name This is a short name that the user will use to log in.
Full user name This is the complete name of the user.
Password Enter a password for the user. The user can change this later on

(see 5.7 Changing the password on page 37).

Re-enter password Enter the password again for verification.

Secondary password Enable the checkbox and enter a secondary password if a
secondary password is needed for logging in the user. This is
important for enforcing the four-eyes principle for certain video
operations.

Re-enter sec. password . o
Enter the secondary password again for verification.

Forgot question Formulate a question that (only) the user can answer if he has
forgotten his password.
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Field label Your input
Forgot answer Provide the answer to the above password question.
SMS number If the user is to receive an SMS in the event of an alarm or failure,

provide his cell phone number. Please insert a full international
number starting with a ‘+'. Example: +43 123 456 7890.

Please note that an SMS sending device has to be connected to the
Observer server for this feature to work. Refer to the manual
NETAVIS Observer Server Installation and Administration for
information about supported devices and how to connect and setup
them.

E-mail address If the user is to receive an e-mail in the event of an alarm or failure,
provide his e-mail address.

Language Specify the preferred language for this user.

Auto login after 1 min _ _ . .
timeout Defines whether this user should be logged in automatically when

nobody else logs at the login panel in for 1 minute. This option can
be enabled for only one user at a time.

PTZ priority (1=lowest, Defines the relative PTZ priority between users. A user with higher

10=highest) priority can take away PTZ control from a user with lower priority.
Please note: The automated PTZ actions started by the event
manager and scheduled routes have priority 4. Therefore users with
priority 1 to 3 will be overridden by automatic PTZ actions, whereby
users with priority 5 to 10 can override automatic PTZ actions but
will not be interrupted by them.

Max. PTZ use time (sec) | Maximum allocation time, after which a PTZ camera is
automatically released. Zero means no limit.

PTZ inactivity timeout (sec)| When a user has taken PTZ control and is inactive for a certain
amount of time, the PTZ camera is freed automatically after this
timeout. Zero means no timeout.

Push Next to go the Privileges dialog. Here set the privileges for the new user (see 5.2 Setting
general user privileges on page 35 for details).

Push Next to go the Camera Access Rights dialog. Here set the camera access rights for the
new user (see 5.3 Setting camera access rights on page 36 for details).

Push Save to create the new user account with the settings you entered.

5.2 Setting general user privileges

For each user and group certain privileges can be defined. These privileges define to which tools and
data a user has access and what he can do.

1.

Choose User admin from the System administration menu. This opens the User admin
dialog.
Select the user or group you want to modify.

Click on the Next button to move to the Privileges dialog. Here you can edit privileges for the
user or group. In their initial state, all privileges in this dialog are inherited from the upper group
level. Inherited privileges from the group level to which the user or group belongs are displayed
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with normal font, while values that you define at the current user or group level are displayed in
bold.

Use the scroll bar to access the lower part of the list.

4. Choose Modify selected user or group from the menu.

5. Set the privileges according to your needs. To change a privilege click on its button and select
the status from the pop-up menu (either Inherited, Enabled, or Disabled).
To set privileges for all users in the system you can select and modify the root group (but please
be aware that at each group or user level privileges can be overridden).

6. Push Save to save your changes.

5.3 Setting camera access rights
1. Choose User admin from the System administration menu. This opens the User admin
dialog.
2. Select the user or group you want to modify.
3. Click the Next button twice to get to the Camera Access Rights dialog.

Analog to the user privileges the camera access rights are inherited from the upper group level.
Inherited access rights from the group to which the camera or camera group belongs are
displayed with normal font, while values that are defined at the current level are displayed in
bold.

4. Select the camera or camera group you want to look at or modify.
Choose Modify selected user or group from the menu.

6. Set the rights according to your needs.
To set access rights for the selected user or group for all cameras in the system you can select
and modify the root camera group.

7. Push Save to save your changes.

o

5.4 Working with user groups

User groups are a powerful means to manage and organize users. For instance, you can set privileges
for groups that are then inherited by the users belonging to this group.

5.4.1 Creating a user group

1. Choose User admin from the System administration menu. This opens the User admin
dialog.
2. Inthe list of users and groups, select a user group to which you want to add a new group.

3. Inthe menu select Add new group which will open the new group dialog that allows you to
define a Group name.

4. Press Next to edit the group Privileges. The privileges are the same as for a user. Inherited
privileges are displayed in normal font while privileges defined at this group (level) are displayed
in bold font.

5. Press Save to create the new group.

5.5 Defining Online Monitor views for a new user

If a new user needs to work in the Online Monitor then camera views need to be defined. Generally,
there are 2 ways for doing that:

e Login as the new user and manually create new views as described under 6.1 Creating a new
view on page 39, or
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e copy existing views from another administration user as described under 6.8 Copying views
between users on page 46.

5.6 Information about logged-in users
Observer allows you to get information about logged-in users:

1. Choose Users... from the System administration menu. Now you see the list of logged-in users
with information about the host from which the user logged in, login time, total bytes transmitted
since login, and bandwidth.

5.7 Changing the password

This section describes how to change passwords for users defined in Observer. For users defined in
Active Directory/LDAP, the passwords need to be changed there.

Each Observer administrator with the appropriate privileges can change the passwords of other users
(see also 5.1 Creating a new user account on page 34).
Additionally, each user can change his own password by following these steps:

1. Inthe Observer menu choose Change password....
2. Inthe newly opened dialog enter the old (current) password and the new password twice.

3. Push OK to change the password. When you login the next time, you will have to enter the new
password.

Please note: The optional secondary password can only be changed by an Observer administrator
with the appropriate privileges.

5.8 Working with users from Active Directory or LDAP

You can configure your Observer server to import users from an Active Directory (AD)/LDAP server. In
this case the users (user names and passwords) are maintained in AD/LDAP and users are imported
(mapped) to a user group in Observer. The privileges of these users (what they are allowed to do in
Observer) are defined at the Observer user group where they belong to.

5.8.1 How Observer and Active Directory/LDAP work together

When an connection to an Active Directory/LDAP server is set up correctly, Observer imports users of
a matched group in Active Directory/LDAP. These users are imported to a certain user group in
Observer. The privileges and camera access rights of the users imported from Active can be defined
at the user group in Observer.

When the Observer server connects the Active Directory/LDAP server the first time, it loads all
matched users into the user group in Observer. These users are then cached in Observer (no user
passwords are stored in Observer). Each 2 minutes the list of users is reloaded from the Active
Directory/LDAP server.

Each time when a user that is defined in Active Directory/LDAP logs in to Observer the password is
checked (authenticated) with the Active Directory/LDAP server. This means that at login time an active
connection to the Active Directory/LDAP server must be present.

Also note that no Observer-specific information is stored in Active Directory/LDAP.

5.8.2 Setting up an Active Directory/LDAP connection

First you need to define a user group to which you want to import the AD/LDAP users:
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1. Choose User admin from the System administration menu. This opens the User admin dialog.

2. Inthe user tree select a group that should serve as the container for the users imported from
AD/LDAP. The group must be empty, it must not contain any local users.

If you do not have an appropriate group, you can create a new user group by selecting the parent
group under which you want to create the new user group. Then choose Add new group from the
menu, supply a name, and push Save.

3. Choose Modify selected user or group from the menu.

4. Select the check box Users of this group are imported from Active Directory.

5. Now you can define the privileges and camera access rights of the imported users by going to the
Privileges dialog and the Camera access rights dialog (push the Next button to move to these
dialogs).

6. Push Save.

Once you have enabled a group for AD/LDAP import you must setup the connection to an AD/LDAP

server:

1. Choose Active directory configuration from the menu. This opens the Active directory

5.

configuration dialog (this dialog actually is part of the Host admin dialog). In this dialog you can
¢ define the connection to an AD/LDAP server

o define an AD/LDAP filter to match a certain AD group (set of users) for importing to
Observer

o define the Tag mapping between AD/LDAP and Observer
Choose Modify host from the menu.

Under Connection parameters define the filters for matching a certain AD group (set of users) for
importing to Observer.

Under Observer group name you must enter the name of a user group in Observer for which you
enabled the Users of this group are imported from Active Directory. Please note that AD
servers usually can be accessed at Port 389.

With Test connection you can check whether the server can be accessed with these values.

Under Directory parameters define the AD/LDAP filters to match a certain AD group (set of
users) for importing to Observer. The filter fields Search base, AD group name, Directory
address are available for further constraining the matched user group in AD and need to contain
the fully qualified strings in AD (e.g. OU=Video-users, DC=netavis, DC=net).

In Observer group name please add the name of the Observer group where the users are to be
imported.

Select or create the appropriate Attribute mapping schema. The attribute mapping defines what
AD attributes are mapped to which Observer attributes. Usually these are the mappings:

For Active Directory:

Attribute Value

Login name tag cn

Name tag displayName
SMS number tag telephoneNumber
Email tag mail

The Tag mapping defines further attribute mappings. For Active directory the AD group
identifier tag must be set to memberOf and Login name tag must be set to cn.

Push Save.

Now the users from AD/LDAP should be imported to the specified user group in Observer.
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6 Using the Online monitor

In the Online monitor you can view live streams from cameras that are set up at the Observer server.
The prerequisite is that you must have authorization to access the Online Monitor (see 5.2 Setting
general user privileges on page 35). Furthermore, you can access only those cameras for which you
have access rights (see 5.3 Setting camera access rights on page 36).

When a new user logs in the first time he will encounter an empty Online monitor waiting for new
camera views to be defined. Once you have defined your views they will reappear next time you log in.

You can also have several Online monitors in multiple windows (see 2.4 Client multi-window and multi-
screen operation on page 18).

Important: If you are using a low-bandwidth connection between client and server (e.g. via wide area
networks) it can happen easily that the video streams cannot pass through the connection fast
enough, which results in bad frame rates and slow responsiveness of the client. In such a case you
should use the Transcoding™ feature of Observer. See 2.6 Observer Transcoding™ for low-
bandwidth client-server connections (ABS) on page 21 for further details.

6.1 Creating a new view

Observer lets you create an unlimited number of named views. Each of these views can contain up to
100 camera view ports.

1. Choose Create new view (either from the empty Online monitor or from the Control menu) to
open the Create new view dialog.

2. You can now choose the layout for your view from predefined templates and you also can define
an arbitrary matrix of up to 10 x 10 views. A new dialog is opened asking for the name of the
view and the aspect ratio for the view ports.

The Name of view is shown in the view selector at the top of the screen. Please note that you
can also create a view hierarchy by using a colon between the names. In the example below we
created a view in the group called “First floor” with a name “Entrance hall”. There might also be a
view called “Office 1" or “Kitchen”.

The Aspect ratio pop-up defines the aspect ratio of the view ports in the view:

o Fixed aspect ratios: PAL, NTSC, VGA, double VGA, or HDTV 16:9.

o Fill available space: This is the default setting and will adapt the view port size (and
hence the aspect ratio) to fill the available space.

o Custom aspect ratio: here you can freely define an N:M aspect ratio.
The setting Stretch image to fit into view port (selected by default) defines whether a camera

image can be stretched to fit into the view port. This may cause distorted images for aspect
ratios that do not fit the current view port aspect ratios.

The setting Crop image to fit into view port defines whether a camera image can be cropped
to fit into the view port. This may cause that some parts of the image are not visible in the view
port. In the section 6.4 Modifying view port settings on page 42 you can define what part of the
cropped camera image is to be shown in the view port.

Please select an aspect ratio that fits most of your cameras you plan to show in the view.
Selecting an improper aspect ratio can lead to unused space on the screen.

Press OK to acknowledge your input.

3. Inaccordance with the selection above, Observer creates a new view that might look as follows
(your view may have a different number of view ports depending on what you selected):
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Event list

View port

The view ports fill the central part of the window, and each view port has its own view port
controls.

At the right side of the window is the Event list, which is explained in 9 Handling events on page
69.

4. Choose Save all view settings from the menu in order to save all settings for your current user.
The next time you log on to Observer, all views will then be available again.If you neglect to
save, all changes are lost when you exit the application.

Please note: All view settings will be stored, also quality and fps settings of view ports. New views will
be stored automatically without the need to save manually.

6.2 Selecting cameras

1. Inthe view port push the Add camera button. Please note that you first have to set up a camera
before you can select it in one of the view ports (see 4 Setting up cameras on page 25). This
opens the camera tree.

2. Select a camera from the newly opened camera tree.

o] |

E:l netavis Cameras
-

we Axis 211A
e Sony CS50
Soogw’ Sony RZ25

Carneras

-

You can either:
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0 select a camera and push the Select button, or
o double click on a camera to add it to the view port where you pushed Add camera, or
o drag and drop a camera to the view port of your choice

Proceed in the same way with additional view ports in your view.

You can assign multiple cameras to each view port. However, since you can only view one
camera image in each view port, Observer lets you manually switch between cameras by clicking
on the camera selection menu at the upper left corner of the view port.

Panazonic NP472 analog

AXIS 2130

AXIS 2100

Panasonic NP472 analog !
Shuffle :

In the camera selection menu of a view port you can also select the option Shuffle. Then
Observer cyclically switches through all the cameras assigned to the view port.

Please select Save all view settings from the view Control menu in order to save all settings.
The next time you log in to Observer, all views and view ports will be available again.

6.3 Navigating in the Online monitor

You have several options for navigating in the Online monitor:

Select a view from the View selector pop-up.
Select a Round tour from the Round tour selector pop-up.
Use the next/previous view buttons to navigate to the previously displayed views.

Double click in a view port to get a big view of the actually displayed camera in the view port. If
there is a view defined containing a big view port with the camera, then this view will be
exposed. Otherwise a new temporary view with the camera will be created. You can then go
back to the previous view by pushing previous view button. Please see also below for a few
hints on how to manage big views of cameras.

Use the quick Camera finder: You can just start typing at your keyboard. A little Camera finder
pop-up will show at the lower right corner of the client window and will show a list of cameras
with matching names and ids:

Camera Finder
-- Press ESC to exit

You can double click a camera or select it with the keyboard and press ENTER, which will
expose a big view of the camera (which is the same action as a double click in the view port).
The behavior of the action can be customized (see document NETAVIS Observer Server
Customizing).
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6.3.1 Optimizing big views of cameras (views opened after a double click)
When you double click on a camera then the Observer does the following:

1. Observer tries to open up an already existing big view that contains the camera, or

2. in case this view is not present, create a hew view with these defaults: MJPEG streaming, VGA or
PAL resolution and aspect ratio, medium quality, 10fps.

So if you want to adapt the appearance of big camera views, create a view with this camera and adapt
the settings. The a double click will open this view.

You can group those big camera views into view groups by supplying view group names lake
"Big:cam1", "Big:cam2" and so on.

6.4 Modifying view port settings

Observer allows you to set various options including video quality of either single view ports or all view
ports in the current view at once.

The settings of a single view port can be modified via the view port's control menu - that appears
in the upper right corner of a view port when you move the mouse pointer over the view port.

The view port control menu offers the following options:

6.4.1 Adding and removing cameras

Cameras can be added and removed with the Add camera and Remove camera menu entries.
Please refer to section 6.2 Selecting cameras on page 40 for more details.

6.4.2 Controlling PTZ cameras

The PTZ menu allows PTZ control and is enabled for PTZ cameras (see 10.4.1 Controlling PTZ
cameras in the Online monitor on page 77).

6.4.3 Setting video parameters

The Video parameters menu offers the following options:

Set streaming | defines how the camera images should be streamed. The available options depend

format on your camera and your setup of the cameras inside Observer (see 4.2 Adding a
new camera and setting basic properties on page 25). Please refer also to 1.4 Video
streaming methods and compression on page 7 for further details on streaming

formats.
Set image sets the quality of the streamed images by modifying the compression rate. The
quality options are High, Medium and Low. Refer to 1.4.5 JPEG image sizes and storage

requirements on page 9 for details on these values.

Set image size |sets the image size of the streamed images. The available size options are camera-
specific. Please refer to your camera's manual.
Please note that for MPEG cameras you cannot change the size of streamed
images. The sizes of streamed MPEG

Set frame rate | sets the frame rate of the video stream. The options are Max fps, various fps and
fpm values and Stop.

Set camera ) - o ) )
name defines the position where the camera name is displayed in the view port.

appearance
Rendering defines which scaling algorithm will be used when images need to be scaled to fit
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preference the available view port space. In the Optimized for speed means that the scaling is
done with a faster algorithm that may cause lines to be not so smooth.
Optimized for quality means that the scaling is done with a more CPU-intensive
anti-aliasing which causes straight lines to be smoother.

These settings can be modified all at once for all view ports in the current view via the Set parameters
of all view ports from the view Control menu. Holding down the CTRL key while selecting any of the
Set parameters of all view ports commands will modify all view ports of all views (not just the current
view).

6.4.4 Controlling video analysis (iCAT) display

The iCAT menu offers various options for displaying ICAT-related video analysis information. Please
refer to 14.4 Working with iCAT on page 122 for further information.

6.4.5 Defining a crop area

For views where you have the Crop image to fit view port setting selected, you can define what part
of the cropped camera image you want to see by choosing Define crop area... from the menu.

6.5 Zooming in a view port and in archive recordings
Observer allows you to zoom view ports in the Online monitor and in the Archive player.

Basically, you have two ways to zoom a view port or a recording in the Archive player:

6.5.1 Zooming with the mouse wheel

1. Just move the mouse pointer over a view port and turn the mouse wheel. The view port will zoom
accordingly.

2. You can move the zoomed area in a view port by dragging it with the mouse.
3. Use the mouse wheel again to zoom out.

6.5.2 Zooming by drawing a zoom rectangle
1. With the mouse draw a rectangle in a view port.
2. Click in this rectangle, which will cause the view port to zoom accordingly.

3. You can position the zoom by dragging the rectangle. You can also modify its size by turning the
mouse wheel.

4. Click outside the rectangle to return to normal (not zoomed) view.

5. You can remove the zoom rectangle by clicking into it with the mouse and pressing the Delete or
Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it.

You can also have multiple zooming rectangles per view port.
Showing a zoomed view in another view port (Online monitor only)

Draw a zoom rectangle with the mouse.
Click into another view port. Now the zoomed area is shown in the other view port.
You can position the zoom by dragging the rectangle.

You can remove the zoom by clicking the rectangle with the mouse and pressing the Delete or
Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it.
Removing a rectangle will also remove the zoomed view from the other view port.

A wnN e
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Please note: When PTZ control is enabled, any mouse actions are taken for PTZ control. In order to
control the view port zooming, hold down the CTRL key while using the mouse.

6.6 Manual recording control in the Online Monitor

In addition to programmed recordings, you can also manually start and stop continuous recordings
directly in the Online monitor. When manual recording control is set up, a recording button is shown in
camera view ports in the Online monitor.

6.6.1 Setting up manual recording control
To enable recording control, you must do 2 things:

e Enable the manual recording camera access right for the user

e Set up a continuous recording schedule for the camera. The continuous recording schedule that
is active at the time when the user pushes the manual recording button defines the format of
the recording. Therefore you can also have different manual recording formats for different
times in the day or week.

Enable the manual recording camera access right

Here is how to set the camera access right for manual recording (see 5.3 Setting camera access rights
on page 36 for a general description on how to set camera access rights):

1. Login as administrator user (or another user with the right to modify user data).

2. Choose User admin from the System administration menu. This opens the User admin
dialog.

Select the user or group for which you want to enable manual recording control.

Click the Next button twice to get to the Camera Access Rights dialog.

Select the camera or camera group for which you want to enable manual recording control.
Choose Modify selected user or group from the menu.

Enable the right Manual recording control from Online monitor by choosing Enabled from the
pop-up menu.
8. Push Save to save your changes.

No g

Set up a continuous recording schedule

In order to use manual recording control for a camera you have to define a continuous recording
schedule (please refer to 7.1.1 Programming continuous timed recordings on page 49 for a general
description of setting up schedules for continuous recordings):

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.
2. Inthe camera tree select the camera for which you want to set up the recording schedule.

3. Atthe bottom of the screen, click on the Next button twice. This takes you to the Scheduling
dialog. If you are setting up a new camera, this dialog will be quite empty.

4. Inthe menu select Modify selected camera or group.
5. Click the Add button to add a schedule slot to the Time Intervals list.

6. Click the Change button and choose Continuous recording.
Now the Scheduling dialog shows the settings for configuring continuous recording.

7. Now you can define the days and times for the recordings. You can activate individual days or,
with the All button, the whole week at once. Select hours and minutes from the popup matrix.
If you want that recording can only be started manually then make sure that the Enable interval
checkbox is disabled.
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Note: When a user pushes the manual recording button in the Online monitor actually the
Enable interval checkbox is toggled. This causes the recording to either start ort stop.

8. Set all the recording options as described in 7.1.1 Programming continuous timed recordings on
page 49.

9. Click on Save to save your settings.

6.6.2 Manually controlling recordings in the Online monitor

When everything is set up as described above then for the enabled user and camera a manual
recording button is shown in any view port displaying the camera.

Boesl ABS 5fpz 00 hbps]

You can switch recording on and off by pushing the manual recording button. The recording state is
shown by the color (a strong red dot means recording is on, otherwise recording is off).

Please note: For times not covered by a continuous recording schedule no manual recording button is
shown.

6.7 Working with round tours (the Smart guard™ function)

Observer allows you to make virtual round tours of views. You can define round tours that contain
certain views. When a tour is started, Observer walks you through all the views by automatically
showing up the views in the Online monitor. This is like a virtual patrol of a security guard (Smart
guard™ function).

6.7.1 Defining a round tour

Steps to add a new round tour:
1. Inthe Online monitor choose Round tours... from the view Control menu. Now the Round
tours dialog opens.
2. Inthe Round tours dialog push the button Add new round tour.
In the Tour name field enter the name of the round tour.

Now you can select a view from the Views list and push the B¥ button to include it in the tour. By

pushing the m button you can remove a view from the tour. You reorder views in the tour by
pushing the Up 2|and Down ¥ buttons.

Please note: You can have the same view several times at different locations in a round tour.
You can select multiple views in the Views list at once by holding the CTRL key while selecting
the views.

5. For each view you can set a Shuffle duration that determines, how long (in seconds) this view
is shown before Observer automatically changes to the next view in the tour. By pushing Set for
all you can set the same duration for all view in the round tour.

6. Push Save to save your changes and OK to leave the dialog.
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Later on you can modify an existing round tour by opening the Round tours dialog and then choose
an existing round tour from the Round tours list and push Modify round tour.

A tour can be deleted by opening the Round tours dialog and then choose an existing round tour from
the Round tours list and push Delete round tour. Then you have to enter your password to confirm
the delete.

6.7.2 Activating round tours

After you have defined a round tour, a new Round tour selector appears in the Online monitor. To
activate the round tour, just choose its name from the Round tour selector. This activates the
automatic walkthrough all of the views in the round tour (Smart Guard™ function). The name of the
round tour now appears in green to show that it is active. You can stop the tour by choosing a view
from the View selector (the Round tour selector will change its color to normal to show that no tour
currently is active).

6.8 Copying views between users

If there are several users in a system it can be a lot of work to create views for each user individually.
In order to help, Observer offers the possibility to copy complete views (including all view settings) or
even all views of an administrator user to another user. Important is that the user who copies the views
to other users must have user administration rights (,User admin: Access to User administration“ and
,2Uuser admin: Manipulate user data").

Here is how you can do that:

1. Login as the user from whom you want to copy the view(s) and go to the Online monitor.
2. Create/define the view(s) you want to copy. Please note that only saved settings are copied.

3. Select the view you want to copy and then choose Copy current view to other users... from
the view Control menu. Now a user selection dialog opens.

4. Select the users to whom you want to copy the current view. Multiple users can be selected by
holding down CTRL while clicking on user names. After you have finished selecting the users,
press the Select button. Now the selected users receive a copy of the current view.

You can also copy all views of the current user by choosing Copy all views to other users...
If the users already have views with the same name as the copied views, then the existing views will
be overwritten by the copied ones!

Please note: The user, who was copied to has to login again in order to see the newly copied views.

6.9 Working with MPEG cameras and audio (MPEG-4, H.264, and MXPEG)

Note: In the current version of Observer, MPEG and bidirectional audio is only supported by clients
running on MS Windows. For further details please refer to 2.1 Introduction to Observer clients on
page 11.

Observer also supports MPEG cameras (MPEG-4, H.264, and MxPEG) with audio streaming (see
also 4.2 Adding a new camera and setting basic properties on page 25).

If the camera allows MPEG streaming, you can select the MPEG streaming format from view port
control menu. Once the MPEG streaming is activated, additional MPEG controls appear on the view

port(s):
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These controls allow you to see and modify Audio aspects:

Audio from the camera: @lindicates that audio from the camera is on. ® indicates that audio from
the camera is off. A click on the icon turns it on or off.

Audio to the camera: & indicates that audio from your microphone to the camera is on. & indicates
that audio from your microphone to the camera is off. A click on the icon turns it on or off.

If you have the Default settings in the Camera Admin set to Audio from and to share single
button then you will see only one control icon: Bidirectional Audio: @ indicates audio in both

directions is on (loudspeaker and microphone is on). % indicated that audio in both directions is off
(loudspeaker and microphone is off).

6.10 Dynamic Online monitor view control

Observer allows you to dynamically control which cameras to display in the Online monitor by several
powerful means:

e control views by iCAT events (motion detection, object triggers, sabotage detection, etc.)

e control views based on special logic (like the Matrix view function, see 16.4 Matrix view function
of the Online monitor (VIP control) on page 133).

The next sections describe how you can define these control mechanisms.

6.10.1 Controlling Online monitor views by iCAT events (motion detection, object
triggers, etc.)

You can add special view control commands to any of the iCAT triggers like motion detection (MD),
object triggers, sabotage detection, etc. Once the iCAT trigger is activated, the associated control
commands are executed.

Here is how you can do that, assuming that you already have valid iCAT definitions:

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

2. Select a camera and for the camera select an iCAT trigger definition (simple motion detection,
event trigger, sabotage detection, lighting change detection, removed/abandoned object).

3. Choose Modify selected definition from the menu.
4. Inthe Comment field add the following text:

pop: <mode>,<view-name>; <additional-camera-IDs>; <user-names>; <IP-addresses>
where:
<mode> is one of:

e 1: shows the camera in a large view.
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2: shows the camera and optional <additional-camera-IDs> in the view named <view-
name> (must be supplied). The cameras are placed in the "oldest" view ports (view ports
that stood there the longest without a camera change). Thus you can create a view where
always cameras with the newest events are displayed.

o 3: shows the camera and optional <additional-camera-IDs> in the view named <view-
name> (must be supplied). The cameras are placed row-wise starting at the top left view
port. The cameras that were in these view port before are shifted to the right. Cameras at
the lower right corner of the view therefore are removed from the view. Thus you can
create a view where cameras with the most recent events are always displayed at the top
left position.

e 4:shows the camera and optional <additional-camera-IDs> in the view named <view-
name> (must be supplied). The cameras are placed in empty view ports. They have a
close button associated with them. When the user clicks the close button, the cameras are
removed from the view, freeing the view port for another camera to be shown.

Thus you can create a view where cameras with the most recent events are always
displayed and stay there until they are removed by the user. Please note: When all view
ports of the view are filled, no new cameras will be shown until a view port is freed.

e b5: similar to mode 1 it shows the camera in a large view. The optional <additional-
camera-IDs> are paired one-by-one with the <user-names>. This causes that these
additional cameras are shown in large view at the clients where the supplied users are
logged in.

e 6: similar to mode 1 it shows the camera in a large view. The optional <additional-
camera-IDs> are paired one-by-one with the in the <IP-addresses>. This causes that
these additional cameras are shown in large view at the supplied clients workstations.

<additional-camera-IDs> is an optional comma-separated list of camera IDs which should be
shown in addition to the camera that triggered the event.

<user-names> is an optional comma-separated list of user names to notify. If not defined, then
all users are going to be notified.

<IP-addresses> is an optional comma-separated list of client workstation IP addresses to which
the notification is sent. If not defined then all connected workstations are going to be notified.

Examples of directives to be used in any iCAT comment field

pop:1;;;
shows a live view of the camera which triggered the event in all connected client sessions.
pop:2,my-view;3,4;;

shows live view of camera which triggered the event and the cameras with IDs 3 and 4 in the
view named "my-view" in all connected client sessions.

pop:3,my_fifo;3,4;mike;192.168.7.12

shows a live view of camera which triggered the event and the cameras with IDs 3 and 4 in the
view named "my_fifo" where the IP address of the client workstation is 192.168.7.12 and user
'mike' is logged in.

pop:4,my_dynamic;3,4;;

shows live view of camera which triggered the event and the cameras with IDs 3 and 4 in the
view named "my_dynamic" in all connected client sessions.

Push the Save button.
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7 Working with archive recordings

This section shows you how to work with the Observer recording archive, particularly in the following
areas:

e Programming archive recordings (timed or triggered by iCAT (video analytics) events)

e Selection and playback of archive recordings

Please note: In order to work with archive recordings you need to have the appropriate user privileges
and camera access rights (for further details see 5.2 Setting general user privileges on page 35 and
5.3 Setting camera access rights on page 36).

7.1 Programming archive recordings
Two types of programming are available in Observer:

e timed recording
e recording on iICAT (video analysis) events like motion detection or people counting

To be able to program recordings, you need corresponding authorization.

7.1.1 Programming continuous timed recordings

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

2. Inthe camera tree select the camera for which you want to program archive recording. When
you select the camera (highlighted in light blue), its data are displayed in the Properties dialog at
the right side of the screen.

3. Inthe menu select Modify selected camera or group.

4. At the bottom of the screen, click on the Next button twice. This takes you to the Scheduling
dialog. If you are setting up a new camera, this dialog will be quite empty.

Note: some fields and buttons are deactivated. Only when you select Modify selected camera
or group in the menu they become editable.

Also, the Time Intervals field is still empty when you begin. Later it will contain one or more
program slots for the selected camera.

5. Click the Add button to add a programming slot to the Time Intervals list.

- AXIS 2130 (14)
Time intervals
00:00 - 24:00 E Change i‘

i —t

Change

The new entry will be selected.
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6. Click the Change button (now enabled) and choose Continuous recording.
Now the Scheduling dialog shows the settings for configuring continuous recording:

. 207mw-4.9 (12) Scheduling

Recording format: JPEG =tream

MTWTFSS 00:00 - 24:00 E Continuous recording [] save audio

Image quality: Medium
Frame rate: 5 picisec

Image size: 320240 (QVGA)

[af |

1 Il | I»]

Continuous recording

Enabie interval Requested recording pericd (days/hours): |10 ! E
. - . |:| Priority over other cameras (if storage space is short)

Monday Friday | Recording period is measured form now |
v'| Tuesd v | Saturd
LEEREL H s | Reduced frame rate settings (JPEG only} |
Wednesday Sunday
V| Thursd
LA Actual recording peried (days/hours): oo
o Storage used by this camera (MB): 1]
Total storage space (MB): 213051
Free storage space (MB): 2180561

Previous Cancel Save

7. Now you can define the days and times for archive recordings. You can activate individual days
or, with the All button, the whole week at once. Select hours and minutes from the popup matrix.
Please make sure that the Enable interval checkbox is marked, because only then are the
settings enabled and recording is started.

Note: If you want to record at different times on different days, you can create multiple recording
intervals. For each recording interval proceed as described here.

8. In addition to defining the weekdays and times, you need to specify the Recording format. If
your camera also supports multiple formats you have several choices (for details on streaming
formats please refer to 1.4 Video streaming methods and compression on page 7):

e JPEG stream is also known as MJPEG, where the server stores sequences of JPEG
images.

¢ MPEG-4 video for MPEG-4 video streams.
e H.264 video for H.264 video streams.
e MXxPEG video for MXPEG video streams.

For the MPEG video formats you can additionally select Save audio.

When you choose any of the MPEG video formats then the video settings that are defined in the
camera’s Default settings will be taken for recording (4.2 Adding a new camera and setting basic
properties on page 25).
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If you choose JPEG stream you can additionally set the Image quality, the Frame rate and the
Image size for the archive recording:

Set the values according to your needs. See 1.4.5 JPEG image sizes and storage requirements
on page 9 for details on images sizes, quality, and storage requirements.

Note: Some cameras are only capable of a single picture stream which will constrain the
possibility of recording in multiple formats and having different video stream settings in the
Online Monitor and the recording. Please refer to the document NETAVIS Observer Supported
Video Sources for information about supported cameras and their streaming capabilities.

9. Fillin the Requested recording period for this camera. This value defines how long Observer
will keep recordings. Recordings that are older than Requested recording period the will be
automatically deleted by Observer (see also 7.1.3 Operation of the Observer dynamic storage
management on page 51).

You can also select Priority over other cameras (if storage space is short) to give this
camera priority over other cameras if the available storage space is too short for all requested
recordings of all cameras (for further details see 7.1.3 Operation of the Observer dynamic
storage management on page 51).

You can also define what the requested recording period refers to: either Recording period is
measured from now or Recording period is measured from youngest recording. There can
be quite a difference between these two choices for the following case: Assume a motion
detection-based recording that only triggers recording once every few weeks.

Optionally, in order to save disk space, you can lower the frame rate of older parts of the archive.
To do that click on Reduced frame rate settings (JPEG only)... to open a small dialog that
allows you to enter a reduction period and a reduced frame rate.

For example, setting 30 days of Requested recording period with 25 fps and 20 days for
reduced archive with 3 fps will maintain an archive containing recent 10 days with 25 fps and the
remaining 20 days will be automatically reduced to 3 fps.

Please note that this works for JPEG streams only and does not affect any MPEG recordings.

Additionally, you can see the Actual recording period (days/hours), the Storage used by this
camera (MB), the Total storage space (MB) which shows the overall storage space of the
server, and the Free storage space (MB) which is the available space for new recordings on
this server.

10. Click on Save to save your settings. As soon as the scheduled time is reached recording is
started with these settings.

7.1.2 Scheduling video analysis (iICAT) operation and recording

For information on how to schedule video analysis (iCAT) operation and recording please refer to
section 14.3.9 Scheduling iCAT operation and recording on page 120.

7.1.3 Operation of the Observer dynamic storage management

In the Scheduling dialog you can specify the Requested recording period property that defines how
long recordings are to be kept by Observer. Any recordings that are older than the requested
recording period are automatically deleted as long as you do not manually protect them from deletion
(see 7.2.8 Protection of recordings against automatic deletion on page 57).

For cases like motion detection-based recording it can be very difficult if not impossible to estimate the
required storage space and therefore space for all requested recordings could be too short. To help
with this hopefully rare case, Observer uses an intelligent storage management process. This process
always tries to store all requested periods for all recorded cameras.

However, if there is not enough space available, the allocation process is doing two things:

e |t generates a system event once a day and sends an email / SMS to the Observer
administrator telling him that there is not enough space for all recordings.
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e |t automatically truncates the recordings of cameras to allow a proportionally even distribution of
the available space among all cameras.

For some special cameras that have to record the requested storage period in any circumstances,
Observer offers the Priority over other cameras (if storage space is short) flag. If this flag is set for
a camera, Observer always tries to store the requested period for this camera and truncates other
cameras that do not have this flag set a little more. If there is more than 1 camera that has the flag set,
the storage management process tries to store all of those cameras.

Algorithm of the dynamic storage management process:
Fill-time-percentage (FTP) = 100 * Actual-recording-time / Requested-recording-time.

Observer tries to keep the FTP of all cameras of each of the two priority classes the same (high-
priority cameras and lower-priority cameras). First the algorithm tries to fully record the high-priority
cameras and then use what is left for the lower-priority ones, whereby all of those will reach the same
FTP. However, the low priority cameras can never go below an FTP of 10%. If the low priority cameras
reach a level of 10%, then the storage management process starts truncating the archives of the high
priority cameras as well. Anyway, this should never happen in a normal case and is only possible if the
storage space is totally insufficient for holding the programmed recordings.

Since the storage management process considers recording time and not recording space for
distributing the available space, it happens that the relatively small recording space of a camera with a
low recording frame rate is truncated in the same proportion like the relatively big recording space of a
camera with a high recording frame rate.

Caution: Please be careful when you set the Priority over other cameras flag since, if storage space
is short, Observer truncates the archives of all other cameras in favor of this camera. If available
storage space is much too short relative to the requested storage periods of all cameras, this can lead
to strongly truncated archives.

7.2 Playback of archive recordings

Observer features a multitude of powerful functions for working with archives.

7.2.1 Selecting the camera and the playback period

1. Go to the main window and choose the Archive player (if the Archive player is not available,
then perhaps it is disabled in the client preferences; see 2.4 Client multi-window and multi-screen
operation on page 18).

Either the Camera tree appears immediately or you have to push the Select camera button E:

2. Select the camera from the camera tree and push Select (you can also double click a camera or
drag it to the calendar view). An overview for the selected camera on the current day is
displayed:
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This one-day overview shows green blocks indicating minutes for which recordings have been
archived. A red corner in a block indicates that an event was triggered and an event recording
was started in that minute.

When you move the mouse pointer over a green block, then the first recorded frame of this
minute is displayed in the lower right corner of the window.

You can also switch to a monthly or an annual overview via the View button and its popup menu.

Here is an example of a month view for the camera:
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With the mouse select the time span of the archive that you want to play back. To do this press
the left mouse button at the start of the time range, then move the mouse pointer to the end of
the time range and then release the mouse button. The color of the selected time range changes
to dark green.

FEEEEEEEEEEEEEEEEEEEEEL,

Also select the playback acceleration by moving the Playback acceleration slider (default value
is 1). At the slider you can see in parentheses how long the selected time will need for playback
at the selected playback acceleration.

Now click the Playback button 2| This brings you to the Player view and the images for the
selected time span are loaded from the server and then will be replayed with the specified
acceleration (you can cancel the loading process by pushing the Cancel button).
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In the Playback view you have several possibilities:

e Automatic or manual fast forward and rewind of recordings

e Selection and playback of a time frame (time zooming)

e Synchronous playback of recordings of up to 4 cameras

e Export of individual images as well as the selected video sequence

7.2.2 Moving forward and back in the recording

Automatic playback: By clicking the Playback buttons |4 or ﬂyou can let the recording
automatically play forward or back. With the Playback Speed slider at the left of the window you can

vary the playback speed. Press the Stop button {0 end playback.

Manual playback: By clicking and moving the green Playback marker ¥, you can control the
playback of images manually.

You can select the size of the playback by clicking the Original size button at the lower left of the
Player dialog. Here you have the possibility to choose from various sizes.

7.2.3 Zooming in a view port and in archive recordings
Observer allows you to zoom view ports in the Online monitor and in the Archive player.

Basically, you have two ways to zoom a view port or a recording in the Archive player:
Zooming with the mouse wheel

1. Just move the mouse pointer over a view port and turn the mouse wheel. The view port will zoom
accordingly.
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2. You can move the zoomed area in a view port by dragging it with the mouse.
3. Use the mouse wheel again to zoom out.

Zooming by drawing a zoom rectangle

1. With the mouse draw a rectangle in a view port.
2. Click in this rectangle, which will cause the view port to zoom accordingly.

3. You can position the zoom by dragging the rectangle. You can also modify its size by turning the
mouse wheel.

4. Click outside the rectangle to return to normal (not zoomed) view.

5. You can remove the zoom rectangle by clicking into it with the mouse and pressing the Delete or
Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it.

You can also have multiple zooming rectangles per view port.
Showing a zoomed view in another view port (Online monitor only)

Draw a zoom rectangle with the mouse.
Click into another view port. Now the zoomed area is shown in the other view port.
You can position the zoom by dragging the rectangle.

You can remove the zoom by clicking the rectangle with the mouse and pressing the Delete or
Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it.
Removing a rectangle will also remove the zoomed view from the other view port.

A wbh e

Please note: When PTZ control is enabled, any mouse actions are taken for PTZ control. In order to
control the view port zooming, hold down the CTRL key while using the mouse.

7.2.4 Playback of a time frame (time zooming)

150 images loaded (every 45 4. of the total 6772 in archive, 2.21%)
Time intervall between frames: 09.72s

200412709 16:21:00 E| 4| ¥ | E| 2004127109 16:44:59
200427109 16:21:00 44 bb| A | »| 200427/00 15:44:58

1« > 2 0l

1. The red and blue markers &4 let you select a smaller time interval for detailed playback.

Alternatively, you can click the Set Blue Marker button E| or Set Red Marker button E|to set
the respective marker at the current position of the green Playback marker.

2. Click the Zoom in button ﬂto load and replay the time interval between the blue and red
markers.

7.2.5 Playback with audio

If the recording also includes audio (i.e. the recording has been done with MPEG-4 or H.264 and with
Audio recording enabled), then you can decide whether you also want to replay audio. By default

Audio is switched on, when you replay. To toggle audio on or off, push the @ button in the Playback
view.

7.2.6 Synchronous playback of up to four recordings

1. Select the playback time frame for the first camera as described above. Then change to the
Player view.
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2. Click the Synchronous Playback button W which opens the Camera tree, where you can
select the second camera for synchronous playback.

3. Repeat camera selection until you have up to 4 cameras for synchronous playback.

The following illustration shows synchronous playback of two cameras:

Calendar I Player |
T

Playback acceleration

Analog 1 Digital 2

5003 (00 :oo:o?)A

Previous timeline selections

16/02/2007 09:26:00 - 10:32:59 =

A10ceET O

[«] [

] i | 1»]

5 [comm

16022007 10:27:00 ) M v . o) & 16022007 11:32:58
1ginzrzonr 102700 ) N A A MM 5022007 113258

1 oo m([b] Bl =

7.2.7 Displaying video analysis (ICAT) information for recordings

The iCAT submenu in the Control menu offers various options for displaying iCAT-related video
analysis information also for recordings. Please refer to 14.4 Working with iCAT on page 122 for
further information.

7.2.8 Protection of recordings against automatic deletion

Normally Observer automatically deletes recordings that are older than the Requested recording
period in order to free space for new recordings. For cases where you want to keep certain scenes
longer than the requested recording period you can protect arbitrary periods against automatic
deletion. Here is how you can do that:

1. Inthe Archive go to the Calendar view and select a camera.

2. Inthe calendar select the period you want to protect against automatic deletion.

3. Press Protect selected images against deletion.
Now the color of the selected period in calendar turns to a different color which shows that the
images are protected.

To unprotect a protected period you must select this period in the Calendar view and Press
Unprotect selected images.
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Caution: Please be careful when using this feature since the protected recording periods will never be
deleted automatically by Observer. This means that the space will be locked as long as you keep them
protected.

7.3 Exporting recordings (images and video sequences)

Observer allows you to export individual images and video sequences in various formats:

JPEG: for single images
AVI DivX: for video sequences

SAFE: This is a proprietary format that stores the video together with the player in an
executable format (.exe) that can be run on MS Windows platforms. The file can be password
protected and you can export synchronous video sequences of up to 16 cameras
simultaneously.

The following sections describe how you can export from the recording archive. In 9.2.2 Exporting
event-related recordings on page 72 you learn how to export recorded video sequences based on
events.

7.3.1 Exporting a single JPEG image (the current frame)

1.

w N

N o g s

In the Archive, select a camera for the export.

In the Calendar select the time for exporting the image.

In the Player move to the picture you want to export and click the Export button o open the
Export dialog.

Choose Current image (JPEG) from Export format.

Enter a file name for the image to be saved.

Mark the first checkbox if you want to overwrite a file of the same name that might exist.

When you click OK a file dialog will be opened asking where on your client computer you to want
to save the file. Select the location and confirm.

Now you can use the exported file.

7.3.2 Exporting a recording in AVI DivX format

A wDNE

o

In the Archive player, select a camera for the export.

In the Calendar select the time period for exporting .

In the Player view or in the Calendar view click the Export button = to open the Export dialog.
You have two AVI options for Export format:

e AVI (all images): This exports a video sequence with all the frames of the currently
selected time frame (regardless of the Playback acceleration setting).

e AVI(Subsampled movie): This exports the time-lapse playback with the settings of
the Playback acceleration slider. E.g. if you have selected a Playback acceleration
of 3, your exported file will be roughly a third of the size of an AVI (all images) export.
See also 7.2.1 Selecting the camera and the playback period on page 52.

Enter the file name of video to be exported.
Mark the first checkbox if you want to overwrite a file of the same name that might exist.

When you click OK, a file dialog will be opened asking where on your client computer you to
want to save the file. Once you select the location and confirm, a File download progress
dialog will show the state of the export. You can cancel the export anytime by pushing Cancel.

Note: To play back exported video sequences with Microsoft Media Player, you need the DivX codec.
You can download this for free from www.divx.com/divx.
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7.3.3 Exporting a recording in SAFE format

a s w DN E

10.

In the Archive, select a camera for the export.

In the Calendar select the time period for exporting .

In the Player view or in the Calendar view click the Export button = 1o open the Export dialog.
Choose SAFE (All images) from Export format.

Enter the file for the video sequence to be exported.
Mark the first checkbox if you want to overwrite a file of the same name that might exist.

Optionally you can create a Multi-camera export (synchronous video sequences) by clicking on

the Select camera button ﬂ This opens the camera tree in which you can select multiple
cameras by holding the CTRL key while clicking on the cameras.

Enter an Export file label which should describe the exported scenes.

Optionally you may enter an Export file password. This password is asked when the export file
is executed (played).

Caution: Do not forget this password because otherwise you cannot replay this exported file.

When you click OK, a file dialog will be opened asking where on your client computer you to
want to save the file. Once you select the location and confirm, a File download progress
dialog will show the state of the export. You can cancel the export anytime by pushing Cancel.

The exported file is an executable for MS Windows 7/Vista/XP.
Here is a screen dump of a running SAFE file:

File View Help
Axis207mw[zoom:37%]

2008-07-29 09:33:00 CET 2008-07-29 09:33:16 CET 2008-07-29 09:36:59 CET

—0

Zooming in exported SAFE video sequences

You can zoom into parts of the camera view by drawing a rectangle and then clicking in the rectangle.
You can drag a zoomed view with the mouse. Alternatively you can show the zoomed view in a
separate window by selecting View > Separate zoom window. You can also use the mouse wheel to
zoom in and out. See also 7.2.3 Zooming in a view port and in archive recordings on page 55.
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7.4 Motion detection in archive recordings

Observer supports server-based motion detection not only for live camera streams but also in the
archived recordings. Here you find information about how to execute motion detection on recordings.

Please note: In this version, Observer supports archive motion detection only for MJPEG recordings
and not for recordings of other streaming formats (like MPEG-4 or H.264).

1. Go to the main window and choose the Archive player (if the Archive player is not available,
then perhaps it is disabled in the client preferences; see 2.4 Client multi-window and multi-screen
operation on page 18).

In the Calendar view of the Player select the camera and the timeframe for the motion detection.

3. Push on the Playback button ‘®.. This will load the images of the timeframe and replay the
recorded images.

4. Inthe Upper left corner of the Player view select Archive motion detection from the Control
menu:

[ catendar | Prayer |
el = 0L

‘ Archive playback ‘

Archive playback
R rchive motion detection

2\ 100 (~00:00:02)

Now the motion detection pane is opened on the left side in the Player view:

e = [l

| Archive motion detection |

Detection fields
‘ Marage detections fields |
PrefPost alarm (sec): D ! Ia

[y

Le] |

1

Il | ]

|
2H 2l 3
o
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5. From the Detection field pop-up menu choose the motion detection field definition you want to
use for this motion detection. If you do not yet have a detection field defined or want to change
an existing definition, then you can push the Manage detection fields button to jump to the
Detection fields view in Administration. Please refer to 8.1.2 Basic configuration of server-based
motion detection on page 64 for details on how to setup detection fields.

Continuing here, we assume you have a correctly set up detection field definition.

6. To start the server-based motion detection Push the Start button .
You can see the progress of the motion detection at the progress bar. You can always stop a
running motion detection by pushing the Stop button =l

Caution: Since the motion detection actually runs on the Observer server and can potentially
use up a lot of CPU resources, please be careful selecting the detection fields and also the time
period. Especially if you have selected a long time period in the Calendar the motion detection
can take a lot of time. As mentioned above, you can always stop a running archive motion
detection.

7. While the motion detection is running, the detected motions are displayed in the hit list sorted by
the time in which the motion occurred. In our example, we have 2 hits:

PreiPost alarm (=ec): D i) Ia

37 % - 27202007 15:25:24

[»

62 % - 270202007 15:26:25

Lef |

Il | ]

I
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8. You can replay the events by just selecting the event with the mouse. The playback time before
and after the event can be defined by the Pre/Post event (sec) fields. You can change the
values according to your needs. Please note that there must be archived pre- and post-event
recordings available in order to be replayed.

1

9. You can step through the events by pushing the Previous 2land Next ¥!buttons.

7.5 External archive management (NEA)

7.5.1 Introduction to external archives (NEA)

Starting with release 4.4 Observer offers external archives (NEA) for portable archive recordings.
Simply connect an external storage device via eSATA to the server, then Observer can save video
streams on the external storage in addition to the main archive storage. Thus it executes a second
(mirrored or double) recording: recording on the external NEA device in addition to standard recording.
The external archive can then be carried and connected to another Observer server for replay and
analysis.

NEA also offers a swap function that allows the easy exchange of external storage devices during
active recording without additional user interaction; therefore no particular operator expertise is
needed for the exchange.
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This chapter describes how you can manage removable storage devices (NEA devices) for external
video recording.

Please note: The NEA recording on the external device is exactly the same as the standard
recording on the main storage (at least as long as there is enough space on the device). The same
recording algorithm is used for NEA as the main storage. This means when the NEA device is running
out of space the oldest recordings will be overwritten . For a detailed description of how Observer
manages recordings please refer to 7.1.3 Operation of the Observer dynamic storage management on
page 51

Apart from the NEA management functions in the client, NEA storage devices can also be configured
and managed via the admin command line interface of Observer (see NETAVIS Observer Server
Installation and Administration). Some more advanced functions like the setup of swap management
for storage devices are accessible only in this interface.

7.5.2 Managing and accessing NEA storages
A user with the appropriate privileges can do the following with external NEA archives:

¢ Initializing of storage devices and starting of NEA recordings as well as stopping of NEA
recordings and ejecting devices.
All of these functions are available in the NEA storage management dialog is accessible via
the System administration menu of the main window.
The user privilege "Recordings: Manage external archive devices (NEA)" is needed for
accessing the dialog. See 5.2 Setting general user privileges on page 35 on how to modify user
privileges.

¢ Replay NEA external archives in the Archive player.
The user privilege "Recordings: View external archive recordings (NEA)" is needed.

For an explanation and setup of automatic swap management of NEA device please refer to the
document NETAVIS Observer Server Installation and Administration.

Displaying the status of NEA storage devices

When a NEA storage device connected to the server you can view its status in the NEA storage
management dialog accessible from the System administration menu of the main window. The
dialog shows all connected NEA storage devices, their sizes and their Status:

e Recording: recording is currently running on the device

e Archive: afinished archive of the device can be accessed in the Archive player

e Empty: the storage device is empty (but initialized)

¢ Unformatted: the device must be initialized (formatted) first

e Write error: the device can be accessed in the Archive player

Initializing a device and starting NEA recording

When a new storage device is connected to the server via an eSATA connector, then the device is
shown in the NEA storage management dialog accessible from the System administration menu of
the main window.

You can start NEA recording on the device by pushing the Initialize and start recording button.

A new device will automatically be initialized (formatted) for NEA before the recording starts. This
initialization is only executed once per device and it may take a while before it is finished. When
initialization is done, recording will start automatically. Next time, recording will start immediately when
you push the button.

Please note: All data on a storage device will be deleted, when it is initialized for NEA.
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Stopping NEA recording and/or ejecting a device

In the NEA storage management dialog accessible from the System administration menu of the
main window you can stop a NEA recording on the device by pushing the Stop/eject button.

When you push the button, all NEA recordings on the device will be stopped and the device will be
unmounted/ejected. A dialog will open and ask you to unplug the device before pushing OK.

If you leave the device connected when you push OK, the archive of the device will be shown again in
the camera tree of Archive player of users who have the appropriate privileges (see above). In such a
case you have to execute the command Stop/eject again before unplugging the device.

7.5.3 Accessing NEA archives at another Observer server

Any user with the appropriate privileges can play back NEA archives easily at any Observer by just
connecting the NEA storage device to the server.

The user privilege for accessing the NEA archives in the archive player is "Recordings: View external
archive recordings (NEA)".

In the Archive player of the client the NEA archive appears automatically in the camera tree under
the camera group External Archive:

I netavis Cameras
----- W Axis 208
----- 0 Axis 207 MW
----- 0 Az 211 A
----- w0 Ayis 2415
=2 External Archive
=1-I5) CKL-encr1 on netavisDELL 2012-07-24 18:10 - 2012-07-24 18:18
-5 netavis Cameras
b i Ariis 206
e Badis 207 MW
f o Boiis 211 A
co g 1G-755
S @ Panasonic WY N240

Please note: There are some limitations on external NEA archives, like Archive motion detection is
not possible.
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8 Working with simple motion detection

Please note: Since release R1.12 Observer offers powerful video analysis functions with iCAT.

This chapter describes the simple motion detection features that were present before R1.12 and that
are now a part of the iCAT toolbox. Simple motion detection is based on a detection of changed pixels
between video frames while iCAT offers intelligent object detection and tracking. For more details on
iCAT refer to 14 Video analytics with iCAT on page 105.

Observer offers two mechanisms for simple motion detection:

e Observer’'s own server-based motion detection: The images are analyzed by the Observer
server. The advantage of this method is that it works with any camera, even old cameras. The
disadvantage might be that if there are many cameras that transfer their images to the server
for analysis, the bandwidth of the network could be burdened and also the server could be
overloaded.

e In-camera motion detection: The images are analyzed in the camera and only when detection
occurs, an event and image data are sent to the Observer server that then stores the event and
the images in its archive. The advantage of this method is that the network and the server are
not burdened. The disadvantage is that it works only with special cameras, that offer this
feature and that the motion detection settings have to be programmed in the camera directly.

8.1 Observer’s own server-based motion detection

The simple motion detection feature of Observer can recognize motion by detecting pixel changes
between video frames. Such a detection can then trigger the following predefined actions:

e Entry of events in an Event list (optionally accompanied by an acoustic signal).

e Changes in recording behavior (e.g. higher recording rate) if that has been programmed (see 7
Working with archive recordings on page 49).

Here you find the steps how to configure the parameters for simple motion detection.

8.1.1 Preparation

Before you begin to configure a motion detection definition, be sure that you have the necessary
authorization to make settings. If you are not sure, please ask your Observer administrator.

Please note: Motion detection for PTZ cameras is problematic since normal movement of the camera
will trigger a motion detection event.

8.1.2 Basic configuration of server-based motion detection

If you are not already running the Observer client application, open your Internet Explorer and log in to
your Observer server and your Observer system.

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.
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In the camera tree at the left, select the camera for which you want to create a motion detection
definition.

In the menu choose Add new definition.

From the Type menu chose Simple motion detection.
Select whether you want to create a Rectangle or a Polygon.
Use the mouse to draw a detection field in the preview area.

Mark the Enabled checkbox, otherwise the detection field is inactive and no detection can occur.
Actually, a detection field must also be assigned to an active motion detection schedule (see
below).

Assign a name for the field in the Identifier text box, e.g. “Movement”.
Optionally, you can enter a Comment.

Usually the Sensitivity should be left at Normal. It defines how sensitive (or tolerant) the
detection algorithm is when detecting the change of pixels. Modify the setting only when you
want the algorithm to be more or less sensitive.

In the Sample frequency (fps) field you can specify how often the image is to be checked for
changes.

In the Time between events (sec) field you can enter the minimum time that must elapse before
a following event is triggered. This helps to filter out repetitive events.

Minimum time (sec) = 3 means that, after one motion detection event has been triggered, at least
3 seconds must pass before another Motion Detection event can be generated.
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13. Inthe Pixel change threshold (%) field you can define how many pixels in % must change so
that a detection event is triggered.
Pixel change (%) = 20 means that 20% of the pixels relative to the previous frame (detection
cycle) must change for a detection to be triggered.

14. Optionally you can define a specific event icon and sound for this definition: Click on the Icon
button to assign a symbol. This icon is displayed in the Event list to notify an operator when an
event related to this definition occurs.

Click on the Sound button to assign a specific sound to the definition. This sound is played when
a user notification event related to the definition occurs.

15. After you have entered all parameters for your definition, save it by clicking on the Save button.

16. If you have not yet scheduled a detection-based recording for this camera, you will be prompted
for whether you want to edit the scheduling now.

Click on the Yes button if you want to configure the scheduling now. Please refer to section 8.1.3
Scheduling motion detection on page 66.

Click No if you want to do that later.

Please note:

If you add a new iCAT definition, it will automatically be assigned to all iICAT schedules of the
camera. If you do not want that, you have to remove the assignment manually.

If a definition is not assigned to an active schedule then it will not be activated (no archive
recordings will be made and no events will be generated) although it has the Active option set.

8.1.3 Scheduling motion detection

The scheduling for simple motion detection is the same as for other iCAT definitions. Please refer to
14.3.9 Scheduling iCAT operation and recording on page 120.

8.1.4 Controlling PTZ cameras with motion detection events

It is possible to assign a sequence of PTZ positioning actions to each motion detection (MD) field
definition. Once the MD field gets active, the associated PTZ action is executed. PTZ actions can be
assigned to an MD field by appending the following sequence to the MD Identifier:

ptz:<CID>:<PresetName>:<WaitTime>:<PresetName>:<WaitTime>...
where:

<CID> is the ID of a PTZ camera (the ID is shown in Camera admin > Properties dialog next to the
camera name). If <CID> is 0, then the MD field's camera is controlled (MD and PTZ camera are the
same).

<PresetName> is the name of a preset position (as entered in the PTZ definitions).

<WaitTime> is the pause time in seconds starting from the time when the camera receives the
positioning event.

There can be any number of "<PresetName>:<WaitTime>" pairs added.

Further MD-triggered PTZ actions are blocked as long as a sequence is running. However, control of
PTZ camera can be taken manually, then the automatic MD-triggered PTZ control is suspended until
the manual PTZ control is released.

For information on how to setup PTZ preset positions refer to 10 Working with PTZ cameras on page
76.

Example of an motion detection Identifier:

Door ptz:4:Door:10:HomePos:3
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will on an MD event with the Identifier “Door” move the PTZ camera with ID 4 to the preset position
“Door”, wait 10 seconds and move the camera to the preset “HomePos” and wait another 3 seconds.
The overall positioning time therefore is app. 13 seconds. From then on the PTZ camera is open to
receive further MD-triggered PTZ positioning commands.

8.2 Motion detection in archive recordings

Observer supports server-based motion detection not only in live streams but also in archived
recordings. Please refer to 7.4 Motion detection in archive recordings on page 60.

8.3 In-camera motion detection

Several IP cameras and video servers support in-camera motion detection and upload (push) of event-
triggered images via FTP or HTTP to a video management system like Observer. Observer
implements a general mechanism to handle this feature.

This section describes how Observer supports in-camera motion detection and also how to configure it
in Observer.

Please note: Since the camera carries out the detection, the actual configuration and programming
must be done directly in the camera via the setup interface (e.g. parameters like detection settings,
image quality, speed, etc.). This can usually be done by connecting with a web browser to the camera
(by entering its IP address). Please refer to the most actual document NETAVIS Observer Supported
Video Sources and the camera’s user manual for further details.

8.3.1 How Observer supports in-camera motion detection

In the camera you define the various settings for the motion detection algorithm and for the
transmission of event images to the Observer server, which is done via FTP or HTTP ("push upload"
by the camera). Most cameras also support the transmission of pre- and post-event images. The
configuration of for these pre- and post-event images must also be done in the camera.

Observer is capable of doing these things in connection with in-camera motion detection:
e Receive in-camera motion detection events from the camera and store these events in the

standard Observer Event database (these events can also be displayed in the Event list).

e Receive pre- and/or post-event images from the camera (pushed by the camera) and record
these images in the standard Observer camera archive.

e Optionally, with receiving an in-camera detection event, start a server-based post-event
recording of images and merging this recording with the in-camera event images pushed by
the camera. This server-based recording can have a much higher frame rate than the pictures
pushed by the camera. This allows a much better documentation of in-camera events.

8.3.2 Setting up in-camera motion detection
To configure Observer for in-camera motion detection follow these steps:

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

Assuming that you have already defined the basic properties of the camera in Observer, select
the camera in the camera tree.

2. Onthe Properties dialog push the Next button at the bottom of the dialog until you reach the
Defaults settings dialog. Here you focus on the In-camera motion detection settings:
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10.

In-camera motion detection

Receive evert images via FTP |:|

Receive event images via HTTP |:|

Post recording length (zecy 0

Recarding fregquency: tax fp=

In the menu choose Modify selected camera or group.

Mark either Receive event images via FTP or ...via HTTP depending on what your camera
supports. This tells Observer to receive in-camera events and images from the camera.

If you already have a defined an active server motion detection schedule for the camera, you will
get a dialog that tells you that having both, server and in-camera motion detection at the same
time is not possible. To continue you have to first disable the server-based motion detection
schedules in the Scheduling dialog and then you can continue here.

Optionally you can set the Post recording length (sec) that defines whether and for how long
the Observer server should record camera images in addition to receiving and storing the event
pictures pushed by the camera. As mentioned above, you could want to do that to record the
post-event images with a high frame rate. In such a case, set the Frame rate according to your
needs.

Now you also have to tell Observer, for how long it should keep the recorded event-images
(both, the ones pushed by the camera and the ones, additionally recorded by the server).
Push Previous button at the bottom of the dialog until you reach the Scheduling dialog.

Below the Time intervals list push the Add button and then choose Camera MD (FTP/HTTP)
from the newly created Change pop-up menu.

In the field Requested recording period (days/hours) enter the values that fits your needs.
Optionally you can also mark the Priority over other cameras (if storage space is short)
checkbox. For further details about these recording parameters please refer to sections 7.1.1
Programming continuous timed recordings on page 49 and 7.1.3 Operation of the Observer
dynamic storage management on page 51.

Push the Save button to store your changes.

Now you have to configure your camera for pushing the in-camera events and images to the
Observer server. Since the steps for doing that are very camera-specific, you must consult the
document NETAVIS Observer Supported Video Sources. To program the camera'’s detection
algorithm please consults its user manual.

Note: After setting up the camera, do not forget to check and set the date and time of the camera to
reflect your current time.
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9 Handling events

Observer can record and display events of various types. They can be camera-related events like
video analytics events, archive access by a user, or camera failures, but also system-related events
like user logon and logoff.

Events are displayed in Event lists of the client and are stored in the central event database of the
server were they can also be queried. They have several properties that depend on the type of the
event.

Event priorities

All events also have an event priority that defines the relative importance of events. The default event
priority is 100. Informational events have a lower priority of 50, system and camera malfunction events
have a higher priority of 300. For events generated by video analytics triggers, you can specify
individual event priorities. Event lists can also be sorted according to priority.

User privileges for accessing and handling events

In the User admin under the System administration menu you can define for each user some basic
event handling privileges. For example whether user you can access events at all or what kinds of
system events are displayed at the users event list (see 5.2 Setting general user privileges on page
35).

The number of events stored in the database can be defined in the server parameters (see 11.2
Setting Observer server parameters on page 84).

9.1 Event list and event details

The most actual events are displayed in the Event list:

7} Event List big

Time .. Pr... |Details

03/02/2011 12:14:37 100 |[ems2] User Video admin user has acknowledged &y
030272011 12:14:38 100 |[ems2] User Videc admin user has acknowledged ey
03022011 12:13:2F 300 |[ems2] Connection lost to camera "4.317

030272011 11:26:24 100 |[ems2] User Video admin user has acknowledged ey
03/02/2011 10:50:50 50 [ems2] User adming@10.0.0.2 logged in

03/02/2011 07:56:41 [<=* 100 |[emsZ] Motion event has happened on the 4.120 cam
03/02/2011 06:54:05 [<2* 100 |[ems2] Motion event has happened on the 4.120 cam
03/02/2011 06:45:54 [<=» 100 |[emsZ] Motion event has happened on the 4.120 cam
03/02/2011 06:39:10 [<=* 100 |[ems2] Motion event has happened on the 4.120 cam
030272011 05:39:16 [<=* 100 |[emsZ] Motion event has happened on the 4.120 cam
02/02/2011 23:35:22 [<2* 100 |[ems2] Motion event has happened on the 4 120 cam
020272011 22:07:34 [*=» 100 |[emsZ] Motion event has happened on the 4.120 cam
02/02/2011 20:44:13 [<=* 100 |[ems2Z] Motion event has happened on the 4 120 cam
02/02/2011 20:31:53 [*=* 100 |[emsZ] Motion event has happened on the 4.120 cam
02/02/2011 20:02:09 [<=* 100 |[ems2] Motion event has happened on the 4.120 cam

02/02/2011 19:58:39 |«=* 100 |[em=2] Motion event has happened on the 4.120 cam
11 | 3

Each client can have multiple event lists, for example, one that is sorted chronologically and another
one that is sorted according to event priorities. In the client preferences (accessible via Client
preferences... in the Observer menu) you can define for each event list what columns are to be
displayed and whether acknowledged events should stay in the list or should disappear automatically
(which is the default behavior).
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The position of the event lists inside client windows and further layout options can be defined as
described in 2.4 Client multi-window and multi-screen operation on page 18.

You can sort the event list according to column values by just clicking on the column title. Little arrows
after the title indicate the sorting order (ascending or descending). Clicking a column title again will
change the sorting order. For example, you can sort the list according to event priority by clicking on
the Priority column heading.

In an event list columns can be rearranged by clicking on a column title and dragging it with the mouse
to the new location.

Unseen events have a light red background color. As soon as an event has been opened in the Event
details dialog its background color changes to light grey. When an event is acknowledged, it usually
disappears from the event list. However, in the client preferences you can define whether
acknowledged events should be displayed in the event list. If so, they appear with a white background
color.

9.1.1 Event details

Double clicking on an event in the event list opens the Event details dialog.

Event details

Object stopped in field "Object sits on chair” () of camera "Axis 206", [netavisDELL]

Name Value
Camera ID: 3
Camera name: Axis 206
Mame of event: Chiject sits on chair
Comment:
Time of event: 05/04/2011 10:01:43
BeepEnabled 0
Priority 100

[ Start live stream ” Short event replay ” Go to Archive player ]

[ Previous ] | MNext | ’ Acknowledge and Next ]

The first line contains the event text. Further details of the event are listed at the left side of the dialog.
The exact contents of the event details depends on the event type, but you will at least find the exact
time when the event occurred and if it is camera-related then also the camera ID and name are
shown.

When you move the mouse over the camera preview area you will also see the video analytics object
markers and annotations related to the event trigger (as seen in the screen shot above).

Here is what you can do in the dialog by pushing various buttons:

e Start live stream: starts live monitoring of the camera that triggered the event .

e Short event replay: starts a playback of the event recording that triggered the event (a replay
is only available if the camera has been configured to record on the event).

e Goto Archive player: opens the Archive player and starts a playback of the event recording.
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e Previous: loads the previous event.

e Next: loads the next event.

e Acknowledge and next: acknowledges the event and loads the next event.
e Acknowledge: acknowledges the event and close the dialog.

e Cancel: closes the dialog.

9.2 Searching in the event database

When you choose Event search... from the Events menu the Event search dialog appears.
Select the Time filter according to your needs.
Push Search to display the results.

You can further constrain the search by setting values for Event type, Name of camera, Name
of user, or Event ID (from- to). For some values an appropriate dialog will open, e.g. the Event
selection dialog:

AP wdNPE

¥ [B Allevents =
¥ [B System eventz
@ Informational mezsages
- (@ Data change
- @ Generic information
- @ User logged in
- & User logged out
@ System malfunction messages
- @ Connection to host is lost
8 Connection to host is restored
¥ (@ Differences against seftings
|: @ Lower image saving frequency
(@ Lower motion detection frequer

¥ (& Disk state change mezsages

L & Disk failure
L 8 Generic system malfunction failure
¥ (3 Camera specific messages
(& State change events

(& Cchange of the input port

(& Image content change

L @ Motion detection

{5 Camera failures
¥ (3 Events of the user interface

L @ camera control
- [3 Event acknowledgement

L & Serial line plugins
-
4| [
Select c:ameral Canoell

It each of the dialogs it is possible to make multiple selections. For example to search for the
event types User logged in and User logged out, hold down the CTRL key and select these
event types with left mouse clicks:

¥ [B Allevents
@ System events
@ Informational messages
(@ Data change
{3 Generic information
{3 User logged in
{3 User logged out

You can also search for events which are acknowledged or not acknowledged by selecting the
appropriate check box.
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5. After setting different search criteria push the Search button again to display the results.

By clicking the Next button you can step forward in the result list and with Previous button you
can step back.

9.2.1 Saving results in an HTML file

You can export the search results to an HTML file:

1.
2.

In the Event search dialog push the HTML export... button, which opens an export dialog.

Enter a file name and choose whether you want to export only the events displayed in current
search list or all events matching the filter criteria.

Push Export. Now the file is created. You can open the file in a normal web browser:

2 NetAVIS Observer Il — Event listing - Microsoft Internet Explorer k g@ﬂ
Datei Bearbeiten Ansicht Favoriten Extras  ? .’}.

- : n 3
5 > ﬂ ;ELI .." P | Suchen ‘i_:{'Favoriten @Medien

Adresse ,ejhtq::ffBD.Bl.128.3Dfappleﬂ—FI'MLsfevent_Ist_213.html 4 Wed‘nselnzu Links *®

Events: 02/09/2004 17:07:10 - 09/09/2004 10:24:30

7638 - 02/09/2004 17:07:10 - [netavis] User logged in
7641 - 02/09/2004 17:07:22 - [netavis] User logged out
7665 - 06/09/2004 10:44:01 - [netavis] User logged in
7668 - 06/09/2004 10:53:33 - [netavis] User logged out
7671 - 06/09/2004 11:21:58 - [netavis] User logged in
7676 - 06/09/2004 11:24:25 - [netavis] User logged out
7679 - 06/09/2004 13:13:329 - [netavis] User logged in
7682 - 06/09/2004 13:14:53 - [netavis] User logged out
7685 - 06/09/2004 13:15:01 - [netavis] User logged in
7688 - 06/09/2004 13:18:17 - [netavis] User logged out
7691 - 07/09/2004 11:00:37 - [netavis] User logged in
7697 - 07/09/2004 11:49:21 - [netavis] User logged out
7700 - 07/09/2004 11:58:12 - [netavis] User logged in
7703 - 07/09/2004 12:12:58 - [netavis] User logged out
7706 - 07/09/2004 14:42:42 - [netavis] User logged in
7721 - 07/09/2004 14:53:28 - [netavis] User logged out
7724 - 07/09/2004 15:22:53 - [netavis] User logged in
7727 - 07/09/2004 15:29:46 - [netavis] User logged in
7730 - 07/09/2004 15:29:54 - [netavis] User logged out
7739 - 07/09/2004 16:02:02 - [netavis] User logged out
7808 - 09/09/2004 09:52:12 - [netavis] User logged in
7838 - 09/09/2004 09:59:13 - [netavis] User logged out
7841 - 09/09/2004 10:18:29 - [netavis] User logged in
7859 - 09/09/2004 10:24:30 - [netavis] User logged out

< ¥
€] Fertig ® Internet

9.2.2 Exporting event-related recordings

You can export event-related video recordings from the Event search dialog. For each event that has
recording associated a separate video file is created. The file name is composed of the event ID, date,
time, and event type. The export can be done in 2 formats: AVI (DivX) and SAFE (see also 7.3
Exporting recordings (images and video sequences) on page 58).

Here is how you can do that:

1.
2.
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In the Event search dialog push the Video export... button, which opens an export dialog.

Select the directory where the exported video files are to be stored and choose whether you want
to export only the events displayed in current search list or all events matching the filter criteria.

You can also supply the pre- and post-event time to be exported.
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Select the video format.

3. Push Export. Now a separate video file is created for each event that has a recording. At the end
a summary dialog shows how many files have been create and what is their total size.

9.3 Generating an event statistics report
Observer allows you to create an event statistics report in MS Excel XLS format.
To create a statistics report file, follow these steps:

1. Choose Event statistics export... from the Events menu.This brings up the Event statistics
export dialog:

Time interval settings

Rezolution: Day

Start time: 2007 |- 02 -

tdarth

|
it

Time period: 1

Event filter
Ewent type:  Summary far all

hlame of camera:  Summary far all

Sl

Mame of uzer: Summary for all
Evert parameter name:

Event parameter value:

% (= any string), _ (= any character)

2. Select for which Start time, Time period and time Resolution you want to create the report.
Also you can filter according to Even type, Camera and User (multiple selection by holding
down the CTRL key while clicking is supported for all filters). If you do not select any values for
Event filter, then a summary statistic report will be created.

3. Push OK to start creating the report file. You will be prompted for a file name where the report
should be stored.

4. Open the created file in MS Excel. With the data, you can also create graphics like the following
one (motion detection statistics for one day):
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A | B | C | o | E | F | & |
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9.4 Receiving notification on events
Observer can be configured flexibly to notify users on various event types and by various channels.
The event types for defining naotifications are:

e System malfunction events (e.g. storage failures)
e System information events (e.g. example user login and logout)
o Camera-related events
o Camera malfunction events (e.g. camera is not accessible)
o Camera in-picture events (e.g. motion detection, video analytics object triggers)

The notification channels are:

e Event list of the client
e Email
e SMS

For each of the above event types the notification channels can be enabled/disabled in the user
privileges and camera access rights (see 5.2 Setting general user privileges on page 35 for details on
how to define privileges and rights).

Please note that the notification channels can be defined on a user or on a group level. Likewise the
camera-related notifications can be defined on a camera or a camera group level.

Please note: In order to receive Emails, the Email address must be correctly defined in the user
properties. Also the server must be correctly configured and must also have access to en Email router
for sending Emails. For receiving SMS an SMS sending device must be configured at the server. See
NETAVIS Observer Server Installation and Administration for details.
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9.4.1 Receiving Email notification with alarm image on camera events

Here you learn how to set up Email notification with alarm image on camera motion detection or video
analytics events:

1.

In the User admin dialog select the user for which you want to define the Email notification and
enter the correct Email address (see 5.1 Creating a new user account on page 34).

Continue to the Camera access rights by pushing the Next button and then select the camera or
group for which you want to define the notification settings and enable the right Events: Sending
email about in-picture events (e.g. motion detection, video analysis).

If the user should also be informed about camera failures you can also enable Events: Sending
email about camera malfunction events.

See 5.2 Setting general user privileges on page 35 and 5.3 Setting camera access rights on page
36.

Define and enable a motion detection or iCAT definition (see 14.3 Setting up a camera for video
analytics with iCAT on page 108).

Check that the iCAT video analytics or motion detection definition has an active recording enabled
(either continuous or event-based). Please refer to 14.3.9 Scheduling iCAT operation and
recording on page 120.

Make sure that for the motion detection or iCAT definition the event generation is enabled (the
checkbox Save event in event list is marked in the Scheduling dialog) and that it is not
suppressed in the iCAT event definition itself.

When you have setup all these things the user should receive an Email with an attached alarm image
on every event.
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10 Working with PTZ cameras

Observer features the control of PTZ cameras (pan/tilt/zoom).

Note: To configure and work with PTZ cameras, you need the corresponding user privileges and
camera access rights (see 5.2 Setting general user privileges on page 35 and 5.3 Setting camera
access rights on page 36). If you find that you do not have the authorizations you need, please contact
your Observer administrator.

10.1 Setting up a PTZ camera

Setting up a PTZ camera is the same procedure as setting up a camera without PTZ functionality (4
Setting up cameras on page 25).

The user must possess the user-specific camera authorizations (see 5.3 Setting camera access rights
on page 36) to permit PTZ access.

10.2 Defining fixed PTZ positions

1. Choose PTZ from the System administration menu. This opens the PTZ dialog.

2. From the camera tree, select the PTZ camera whose PTZ positions you want to program.
3. Inthe menu select Add new definition.
4

In the Name field enter a designation for the position and then use the PTZ control elements to
move to the desired position (detailed explanation of control elements in Section 10.4 Controlling
PTZ cameras on page 77):

5. Click on Save to save your configuration. Then you can repeat steps 3 to 5 to define additional
PTZ positions.

6. From the Online Monitor you can select these predefined positions (see below).

7. Double-clicking on one of the predefined positions lets you position the camera. Proceed
similarly in order to change positions.

10.3 Defining PTZ routes

In addition to individual PTZ positions, you can also define position routes that can be followed on
command. A position route consists of a list of PTZ positions that are automatically, sequentially
followed and a duration per position.

Define a PTZ route as follows:

1. Choose PTZ from the System administration menu. This opens the PTZ dialog.
2. From the camera tree, select the PTZ camera whose PTZ route you want to program.

3. If you have not already defined PTZ positions that now appear in the list, or you can create new
positions now. See the previous section for defining new positions.

4. Click on the Next button at the bottom right. This takes you to the Routes dialog, whose layout
resembles the Positions dialog above.

5. Inthe menu select Add new definition.
In the Name field enter a designation for the route. Optionally you can enter a description.
7. Click on Next to move to the Route details dialog:

o
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6 Route details - AXIS 2130 - Routed

Default

Oben

Unten

Besprechungsraum zoom

Besprechungsraum total

Empfang

WMeeting Room

MNewy | Delete | Position: Meeting Room |

Up | Down | Stay on target time: |0

Prev'u:lusl Stop test Canoell Savel |.&J-CT|

Click the New button to create a new entry in the Position list of the route and select a position
from the list of predefined positions via the Position popup menu.

In the Time at position field, enter the duration in seconds that the camera is to spend at the
position. Note that this time includes the positioning time of the camera.

Repeat Steps 8 and 9 for each entry in the position list.

You can change the sequence within the position list by selecting a position and then clicking the
Up or Down button. You can remove an entry from the Positions list by selecting it and then
pressing the Delete button.

Click the Save button to save your route or Cancel to discard changes.

You can select the saved route in the Online Monitor via the PTZ menu of the view port control menu
of the PTZ camera. Proceed similarly to modify a route.

10.4 Controlling PTZ cameras

10.4.1 Controlling PTZ cameras in the Online monitor

Control PTZ cameras as follows:

1.
2.

Select the Online monitor.

Switch to a view that contains a PTZ camera (how to create views and assign cameras is
covered in section 6 Using the Online monitor on page 39).

In the view port of the PTZ camera push the PTZ start button or choose PTZ->Activate PTZ

from the view port control menu. The icon P of the view port indicates that you have PTZ control
over the camera.
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Active PTZ control

Note: For each user a PTZ priority and allocation timeouts can be defined (see 5.1 Creating a
new user account on page 34). If another user with equal or higher priority has already assumed
PTZ control over the camera, you will be denied control and notified in a window. Then you need
to wait until this user surrenders control or reaches his timeout.

A user with a higher PTZ priority can take away PTZ control from a user with lower PTZ priority.

Direct PTZ control inside a view port

You have several options for directly controlling PTZ cams: The various modes can be selected
via PTZ->PTZ control mode in the view port control menu. The default setting is Continuous
mode and Center on click. As an alternate mode also an operation via a Crosshair is available.

Continuous mode (available for joystick and mouse operation): Click the mouse in the view port
and drag it in the direction where you want the PTZ cam to move. A red line indicates how fast
the movement is. When you release the mouse, the movement will stop.
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Center on Click: A single mouse click somewhere in the view port commands the camera to

center on the mouse click location.

Zooming: Zooming is available via the mouse wheel: zoom-in (forward scroll) and zoom-out
(backward scroll). The amount of the zoom will be indicated by 3 red dots after the mouse is

released:

Please note: When PTZ control is enabled, any mouse actions are taken for PTZ control. In
order to control the client-based view port zooming (see 7.2.3 Zooming in a view port and in

archive recordings on page 55), hold down the CTRL key while using the mouse.

Crosshair: When this mode is enabled, a crosshair is shown in the view port

Medium movement up

Large movement left

Small movement right

Large movement down and right

Predefined positions

Large zoom in
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Controlling PTZ cameras with a joystick:

The locally installed version of Observer is able to handle USB joysticks as input device from
Java VM 1.4 and newer (for information on how to install the application version locally please
refer to 2.3 Working with the installed Observer client on page 15.

The joystick can be used for panning, tilting the camera, while its buttons for zoom-in and zoom-
out operations (which button is used for which operation is assigned during calibration). The
joystick must be calibrated before use (found in the System Information menu, beside the
language change menu). To "assign" the joystick input focus to a camera, click into the frame
while holding the SHIFT and CTRL buttons. This is visible via an in-picture icon drawn when the
assignment is successfully done.

Jump to a predefined PTZ position and follow PTZ routes

1. To spot a camerato a predefined PTZ position, click on the right arrow at the lower right corner
of the view port and select a position from the list (see 10.2 Defining fixed PTZ positions on page
76).

2. To automatically follow a predefined PTZ route choose it from PTZ->Select PTZ route in the
view port control menu of the PTZ camera.

3. Inthe view port control menu of the PTZ camera, click PTZ->Select PTZ route->Stop route to
stop control of the PTZ camera.

Stop PTZ control

You can stop PTZ control by pushing the P putton or deselect PTZ->Activate PTZ control in the view
port control menu.

Note: Please do not forget to stop PTZ control; otherwise other users cannot assume control. When
you end the Observer client, all PTZ control is automatically released.

For further details on user-specific PTZ priorities and timeouts please refer to 5.1 Creating a new user
account on page 34.

10.4.2 Controlling PTZ cameras with motion detection events

It is possible to automatically control PTZ cameras with motion detection events. Please refer to 8.1.4
Controlling PTZ cameras with motion detection events on page 66.

10.4.3 Scheduling PTZ routes

It is possible to schedule time intervals for PTZ camera to follow predefined routes.

Note: Before you can schedule a route you first must define the route (please refer to 10.3 Defining
PTZ routes on page 76).

To schedule a PTZ route, follow these steps:

1. Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

Select a PTZ camera.

Press the Next button to go to the Scheduling dialog.

In the menu select Modify selected camera or group.

Click the Add button to add a programming slot to the Time Intervals field.

Click the Change button (now enabled) for a popup menu; select PTZ route.
This will show the PTZ scheduling settings (see above).

7. Setthe time settings according to your needs.

o g~ wDN

80



NETAVIS Observer 4.4 User Manual

8. Select the route from the Route Name pop-up menu (in the example above we selected Route
1).
9. Click on Save to store the scheduling settings.

Note: You can add several PTZ route schedules for a single camera. This means that you can follow
different routes at different times.
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11 Administrating Observer servers

This chapter describes how to

e get status information about runningObserver servers,
e set server parameters,

e start/stop servers,

e administrate external NEA storages

Further information about administrating servers you find in the document NETAVIS Observer Server
Installation and Administration.

11.1 Server system information and restarting
Observer offers 2 sets of status information of the running servers in a network.

e The server load display in the main client window
e The System information dialog in the Admin area

11.1.1 Server load display

The server load display is located in the status bar of the main client window and shows the following
information:

CPU: xx % Server CPU load in percent. This display is updated every 5
seconds.

IDB: xx % Load of Image database (IDB) engine: This parameter shows
how busy the server is with saving video data on storage. The

xx KB/s actual video data storage rate is displayed below the percent

value in Megabytes/sec or Kilobytes/sec. The IDB display does
not appear if the server does not record.

Note that the IDB load also increases when the server
removes video data when the storage is full or recording time
limits are reached. IDB details are updated once a minute.

OVR: xx % Overloaded state of the IDB engine: The IDB engine is
overloaded if the server receives more video data from the
cameras than it can record (save on storage). In this case the
server will drop frames. OVR shows the percent of dropped
frames. If the label OVR does not appear then the server can
save every incoming frame.

SWP: xx MB Swapping: This display appears if the server starts heavy
swapping, which means that the amount of main memory of
the server is insufficient. If this is situation persists, the server
must be extended with additional RAM.

11.1.2 System information dialog

1. Choose System information from the System administration menu. This opens the System
information dialog.

The table shows the connected servers and their state:
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Name shows the name of the server and the Observer version running.

State shows whether the server is running and if there is a failure (the server in the screenshot
above is running OK).

License shows the license of the Observer server:

e OBS: represents the basic functionality
¢ Installation types:
e STD: Standard Server
e AS: Application Server
e Server network licensing:
¢ UNW: unlimited number of connected servers
e LNW: max. 3 connected servers
e Licensed features:
e EIDB: Encrypted image database
e AD: Active Directory/LDAP support

e ABS: ABS (Adaptive Balanced Streaming) transcoding for low-bandwidth
connections

e CAM: shows the number of total camera licenses. If the number contains an
“R” then it is a floating license from a remote licensing server. If the number
of cameras exceeds the license limit, then in parentheses first the number of
disabled cameras is shown and then, after a slash, the number of allowed
licensed cameras.

e USR: shows the number of total user licenses. If the number contains an “R”
then it is a floating license from a remote licensing server.

e SNAP: SNAP/XML integration interface
e LNT: Layout navigation tool
e (CAT:iCAT video analytics
e SAB: Camera sabotage detection
¢ |IPAD: Client for iPad
e URL: URL Command API
e VW: Video wall control
e SNLT: Snapplet
e SMPH: Client for Smartphone
You can display the current license key string by entering the following URL in a web browser

http://1P-address-of-your-
server/arms/servlet/BrowserServlet?cmd=showl icensekey.

For further information about licensing please refer to the manual NETAVIS Observer Server
Installation and Administration.

Archive shows the sum of fps and Kbytes per second of archiving on that host.

Monitor shows the sum of fps and Kbytes per second of all logged in users.

Please note that you usually only see the status of your server. If you want to monitor the status
of other Observer servers as well, you have to make other servers known to your server (please
refer to 12 Working with interconnected Observer servers on page 88).

To show the details of a server, double click an entry or select a server in the table and then

choose Details from the System menu. Now you see detailed information for the selected server
with hard disk partitions and their state.
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Partition ctrl: shows the number of the hard disk controller; dev: shows the hard disk number on
the controller. On the screen dump we have 5 disks on 3 controllers.

Type indicates the type of the partition: DB is a database holding configuration and event data
and | is an image patrtition that holds the actual video image data.

Status indicates whether there is a failure on the partition. Such a failure needs to be reported to
your Observer Administrator.

Capacity indicates the size of the partition in MB.
Used % shows how much space of the partition is used.

Click on the Back button to leave the server details dialog and go back to the list of servers.

11.1.3 Restarting Observer and rebooting the server

1.

Choose System information from the System administration menu. This opens the System
information dialog.

Select a server in the table. In the System menu you have the following actions available:

Stop Observer system: This stops all video system processes but does not shut down the
server.

Switch off server: This shuts the server down.

Reboot server: This reboots the server.

11.2 Setting Observer server parameters

Observer allows you to set several server parameters. To access them, follow these steps:

1.
2.
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Choose Host admin from the System administration menu. This opens the Host admin dialog.

Select your own server indicated by bold face (default is netavis). Here you see the Hostname,
Network name or IP address and Observer Host ID of your server (are read only). The Observer
Host ID is needed for working with distributed Observer server (see next section).

If this server is cooperating with other servers, then the settings for synchronization group may
be relevant (see also 12 Working with interconnected Observer servers on page 88):

If this server should be part of a synchronization group then enter the name of the
synchronization group in the field Name of synchronization group. If this server should be the
master of the synchronization group, then select the check box Master of the sync group.
Please refer to 12.1.2 Keeping multiple users servers in sync (synchronization groups) on page
88 for a general explanation of synchronization groups.

Please note: Modification of configuration data is only possible at the master of the
synchronization group and not at the slaves (as they will be updated by the master
automatically). As long as there is no master in the sync group (which may happen during set up
of the sync group) no modification is possible at all.

Click on the Next button. Now you see the Server Parameters dialog. Following settings are
available:

Field label Description
Event storage period (days) Defines how many days events are stored. Any events that
are older than these days will be deleted from the event
database.

Max number of events stored on | Defines how many events can be stored in the event



Field label
server

Server timezone abbreviation

Timeout for IP cameras (sec)

Retry count for IP cameras, after
which an event is generated

Maximum login time for the “guest”
user (sec)

Timeout for server-server
communication (sec)
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Description

database. For each event more than the defined max.
number of events the oldest event will be deleted.

Please note that both settings, the storage period and the
max. number of events, together constrain the event
database.

Defines the server timezone. Available values are:

GMT, Greenwich Mean Time

CET, Central European Time GRMT+I
MIT, Pacific/Apia GTh-11

HST, Hawaiian Standard Time GhT-10
AST, Americaffnchorage GMWT-9
PET, Pacific GMT-3

MET, Mountain GhT-7

CST, Central GMT-B

EST, Eastern GMT-5

PRT, America/Puerto_Rico GMT-4
CMNT, ArmericaiSt_Johns GWT-3.5
AGT, America/Buenos_Aires GMT-3
ART, Africa/Cairo GMT+2

EET, Europe/lstanbul GMT+2

EAT, Africatdddis Ababa GWT+3
MET, AsiaTehran GMWT+3.5

MET, Asiaferevan GMWT+4

PLT, Asia/karachi GWT4+5

IST, AsiafCalcutta GMT+5.5

BST, AsziafDacca GMT+H5

WST, AsialSaigon GMT+7

CTT, Asia/Shanghai GMT+3

JST, AsiaiTokyo GMT+3

ACT, AustraliafDarwin GMWTHI.5
AET, Australia/Sydney GMT+10
S5T, Pacific/Guadalcanal GMT+11
MNET, Pacific/Auckland GMT+12

Defines the time after which the message “Camera not
responding” appears in the Online Monitor.

Defines the number of retries after which the server raises a
“camera not reachable” event. The Timeout for IP cameras
(sec) multiplied by this retry count gives the number of
seconds, after which an event is generated when an IP
camera is unreachable.

Defines the time after which the guest user is forced to
logout. If the value is 0, then the guest is never forced to
logout.

Defines the time after which an event “Connection lost to
server ...” is generated and the cameras mounted from that
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Field label

Server network address for
camera access

List of IP addresses from which
URL control is enabled

Transcoding bandwidth limit for

live view video streams (kbit/s)

Transcoding bandwidth limit for
archive playback video streams
(kbit/s)

Transcoding bandwidth limit for
archive export streams (kbit/s)

IP address of network interface
(NIC) for bandwidth limitation

Total outgoing bandwidth limit

Description

server disappear from the camera tree (only the root
element of the mounted camera tree remains visible,
painted in red).

This setting is only important for IP cameras that must
actively access the server (e.g. for FTP upload with in-
camera motion detection) and only when the server is not
accessible by the cameras at its set IP address but at a
different address (e.g. due to address mapping). Per default
this address always reflects the IP address of the server.
You can enter an IP address or a network name.

URL control is one way to enable third-party applications to
start actions via URL-encoded strings (send http GET
request to an Observer server). The server upon receiving
these special URL requests executes the actions as if they
would have been generated internally.

URL control is only enabled for computers whose IP
addresses are entered in this fields (comma separated list).
All other requests are blocked. Please refer to the Release
Notes for further details on URL control.

Bandwidth limit per session for transcoded outgoing live
view streams (ABS). Zero means no transcoding and no
limit for live view video streams. Please read 2.6 Observer
Transcoding™ for low-bandwidth client-server connections
(ABS) on page 21 for choosing the best limit values.

Bandwidth limit per session for transcoded outgoing archive
playback streams (ABS). Zero means no transcoding and
no limit for archive playback streams. Please read 2.6
Observer Transcoding™ for low-bandwidth client-server
connections (ABS) on page 21 for choosing the best limit
values.

Bandwidth limit per session for transcoded outgoing archive
export streams (ABS). Zero means no transcoding and no
limit for archive export. Please read 2.6 Observer
Transcoding™ for low-bandwidth client-server connections
(ABS) on page 21 for choosing the best limit values.

IP address of the network interface (NIC) for which
bandwidth limitation is applied. If zero, then the bandwidth
limit is applied in total for all available network interfaces. If
transcoding is switched on, then it will only be applied to
connections of this NIC.

If you enter the keyword NUS instead of the IP address of
the NIC then only traffic to a NUS (Observer user server) is
transcoded. Local client connections to this server will not
be transcoded. It also works this way if the server has only 1
NIC for all traffic to cameras, local clients and a NUS.

Total bandwidth limit for all outgoing connections of the



Field label
(kbit/s)

RTSP streaming port

Image database AES encryption
(0O=no encryption, 1 or
2=encryption)
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Description
specified network interface (NIC).

Port number generally used for RTSP communication (e.g.

for some MPEG cameras).

Please note that modifying the value here does not change

the RTSP port setting in the cameras. The cameras need to
be configured separately for the RTSP port.

This defines whether the image data are encrypted with
AES.

Value 0 switches off encryption (default).

Entering the value 1 or 2 will switch on AES encryption of
the video recording. Value 1 means the system will store the
encryption key on a local server disk.

Value 2 will store the key on a USB device (formatted with
FAT32), which has to be plugged into the server. If the
device is not accessible, then archive access is not
possible.

Prior to inserting the USB device, a writable directory "nek"
must be created on the device (this can be done under
Windows, for example). Observer will search for this
directory and store the key file in it. After the USB device is
detected and the key has been written to it the first time, an
event with following text is generated: "IDB encryption
started, USB device can be removed now for creating
backup copy". At this time the USB device can be removed
from the server, and a backup copy of the directory "nek"
can be created. Note that the stick must be inserted again
before any archive query is started.

Warning: Loss of the encryption key stored on the USB
device will make archive access impossible!

Also, encryption needs much more CPU power than no
encryption (see also 1.3 Observer data security on page 6).

5. To modify any of these values, select Modify host in the menu, set the values and then press

Save.
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12 Working with interconnected Observer servers

Observer allows you to work with the resources of interconnected (remote, distributed) Observer
servers. The concept is similar to accessing files on a remote file server. You can import single
cameras or whole groups of cameras from other Observer servers and you can also export your
locally defined cameras to other Observer servers. You can work with remote cameras as if they
would be local (e.g. you can also access their archive, modify their parameters or even add new
cameras to remote sites).

You can also define whether events are to be propagated between servers.

A special feature are so called synchronization groups of servers. A synchronization group allows you
to automatically synchronize server configuration data (like user configuration data and camera
configuration data) between servers.

Before you can do any of these things, you first have to make both servers known to each other. You
can do that by adding the other server as remote server on each of the machines. The next section
describes how to do that.

12.1 Basic concepts of interconnected Observer servers

In a single server system an Observer server does multiple things: store camera recordings, run video
analytics on camera streams, store events in the event database, handle user clients.

In a bigger system with many cameras and users, because of workload a single server is not capable
of doing all those things at once. Therefore multiple servers can be installed to handle the workload.

12.1.1 Camera servers (NCS) and user servers (NUS)
In a network of multiple servers the individual servers usually work in different roles:

Camera servers (NCS = Network Camera Server): A camera servers (NCS) mainly manages
cameras, it stores recordings and optionally runs video analytics on the video streams of the
connected cameras. It also stores the events related to the connected cameras. A NCS usually does
not serve any user clients directly but it offers its cameras to user servers for mounting.

User server (NUS = Network User Server): A user server handles user clients. It usually mounts
cameras from multiple camera servers and also receives events from them. Thus a user connecting to
a NUS can have access to the cameras of all camera servers. A user server usually does not manage
any cameras directly and does not do any recording or any video analytics. However, it usually does
store the events of all the mounted NCS in its central event database.

12.1.2 Keeping multiple users servers in sync (synchronization groups)

In a larger system that requires multiple user servers (NUS) it can be cumbersome to manually keep
all user configuration data synchronized between all user servers. Thus Observer offers the concept of
so called synchronization groups.

In a synchronization group a master user server automatically propagates its configuration data
(complete user configuration data and camera configuration data, customer-specific resources like
icons and layout navigation data) to all the other user servers in the same group. Thus the master user
server is the single point of all user administration (in fact changes at slave servers are no longer
possible). Any changes are automatically propagated to the other users servers in the same group.

Whenever a server is added as a slave to a synchronization group, it will automatically be
synchronized with the data from the master sync server.

The synchronization group settings can be modified in 11.2 Setting Observer server parameters on
page 84 (see 11.2 Setting Observer server parameters on page 84).
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Please note:When a server is added as a slave to a synchronization group, any configuration data
that is not also existing on the master server will be deleted and overwritten by the data of the master
server. So please be careful when you work with synchronization groups.

Also: When users connect to slave servers they cannot modify their user settings, this can only be
done when they are connected to the master user server. Thus layout navigation tool (LNT) project
creation and icon uploads should always be done at the master user server.

12.2 Adding and defining a remote Observer server

1. Choose Host admin from the System administration menu. This opens the Host admin dialog.

In the menu select Add host.

Fill in the basic information of the desired remote Observer host (server):

Field label

Hostname

Network name or IP
address

Comment

Observer Host ID

Your input

This is the name you give to the remote Observer server. It does
not necessarily have to match the actual name of the remote
server.

This is the network name or |IP address of the remote Observer
server.

A descriptive text.

This is an internal ID that uniquely identifies the remote server. The
ID of an Observer server can be obtained by reading its own entry
under the Host Admin tab.

2. Now you can define what you want to do with the remote Observer server. Set options according

to your requirements:

Field label

Send local events to
remote server

Import of cameras from
remote server enabled

Export local cameras to
remote server

Monitor remote server
status

Upgrade software on
remote server (zupgrade

Your input

Check this option if you want that your local events are sent to the
remote host.

Check this option if you want to import cameras from the remote
server.

Check this option if you want to export cameras of your server to
the remote server. If this option is not enabled the remote server
cannot access your cameras.

Check this option if you want to monitor the status of the remote
server in System information dialog.

Check this option if you want to allow automatic distributed software
upgrades of the remote server initiated by your current server. In
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Field label Your input

slave) such a case your current local server is the upgrade master and the
remote host the upgrade slave. For details about distributed
upgrades please refer to the manual NETAVIS Observer Server
Installation and Administration.

Accept software upgrades | Check this option if you want to accept automatic distributed

from remote server software upgrades of the current server (=slave) initiated by the

(Fupgrade master) remote server (=master). In such a case your current local server is
the upgrade slave and the remote host the upgrade master. For
details about distributed upgrades please refer to the manual
NETAVIS Observer Server Installation and Administration.

Request license from Check this option if your current Observer server should check out
remote server (=license licenses from the remote server (=license master). For details about
master) floating network licenses please refer to the manual NETAVIS

Observer Server Installation and Administration.

Use secure connection Select this checkbox if you want to use an encrypted connection
(HTTPS) between the two servers (SSL HTTPS).
Please be aware that an encrypted connection needs more CPU
resources on both servers. See also 1.3 Observer data security on
page 6.

Click on Save to save your settings. Now you are ready to import cameras or camera groups
from a remote Observer server.

12.3 Working with cameras of another server

In order to work with cameras from another Observer server, following prerequisites must be fulfilled:

The servers must know each other (see 12.2 Adding and defining a remote Observer server on
page 89)

The server that exports cameras must have the option Export local cameras to remote
server set (see 12.2 Adding and defining a remote Observer server on page 89)

The server that works with cameras of another server must have the option Import of cameras
from remote server enabled set (see 12.2 Adding and defining a remote Observer server on
page 89)

After you mount remote cameras you can work with them as if they would be connected to this server.
You can access live streaming via the Online Monitor or you can access the archive. If you have the
appropriate administrator rights you can also modify camera settings like PTZ, scheduling or motion
detection.

12.3.1 Mounting cameras of another server

1.
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Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

In the menu select Mount remote camera or group.

Select from Known remote machines menu item this remote Observer host from where you
want to import cameras

Now the basic data of this remote Observer host are shown again (hostname, IP address).
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4. By clicking on Camera on remote host selection dialog the whole camera tree from the selected
remote host appears and you can select a single camera or group to be imported, e.g. PTZ
camera on remote host netavis-hu.

L} L} L} L} L} L} L} L} L} L} L} L} L} L} L} L}

Confirm your selection by clicking on Add camera button.

Now your camera tree shows this imported camera or group in bold with the name of the remote
server in brackets, e.g. PTZ [netavis-hu].

If the remote server is not reachable, the mounted cameras are not shown in the tree; only the
top point of the mounted camera tree appears in red color.

5.  With imported cameras you can work the same way as with local cameras. For example, you can
display them in a view port in the Monitor (please refer to 6.2 Selecting cameras on page 40).
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12.4 Working with events of remote servers

Observer servers can forward their events to other servers. Such forwarded events are stored in the
event database of the generating server itself and also in the event database of the server(s) that
receive the events.

Event entries in the event database of remote servers look the same as local events, they just start
with the remote server’'s name and not with the name of the local server. The same kind of search and
listing is available as with local events.

In order to receive events from another Observer server, following prerequisites must be fulfilled:

e The servers must know of each other (12.2 Adding and defining a remote Observer server on
page 89)

e The server that exports events must have the option Send local events to remote server set
(12.2 Adding and defining a remote Observer server on page 89)

12.5 Monitoring remote servers

You can monitor the status of remote servers in the System information dialog (see 11.1 Server
system information and restarting on page 82). Before you can do that you have to tell your server to
monitor the remote server by checking the option Monitor remote server status (see 12.2 Adding
and defining a remote Observer server on page 89).

12.6 Distributed upgrades

When there are several Observer servers in a network upgrading servers to a newer release of
Observer one by one can be a very cumbersome and time-consuming task. In order to ease this task,
Observer offers an automatic distributed upgrade of all interconnected servers in a network.

Please refer to the manual NETAVIS Observer Server Installation and Administration for further
details.
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13 Working with Layout Navigation

Observer offers powerful layout navigation features that allow you to navigate based on layouts, floor
plans, and also other images. In this chapter you learn how to use the layout navigation features.

Please note: Since Layout navigation is licensed separately of Observer you need a valid license in
order to work with these features. See also 11.1 Server system information and restarting on page 82
for details about what license you have.

13.1 Basic concepts and how it works

The Observer layout navigation tool (LNT) allows you to define a hierarchy of graphical layouts that
correspond to various aspects of your physical environment (section 13.4.1 Planning your layout
hierarchy on page 94 provides details on how to plan the hierarchy).

Layouts that belong together and other related settings can be grouped together in so called projects.
Depending on the user rights, several users can access and share the same projects and by thus
layouts and settings.

On each layout you can place camera control icons that correspond to cameras on an Observer
server. The camera icons on layouts are interactive, i.e. trigger certain actions when you move the
mouse over them or click on them. Such actions can be to show camera live image streams or its
recording archive in the corresponding Observer client running on the same client workstation.

On layouts you can also define polygon-shaped zones that group certain cameras together and that
allow for smart ways of highlighting on events and for good synchronization with the Observer client.

Additionally, you can also display and acknowledge Observer events in the tool.

All information used by the LNT (e.g. project and layout definitions, background images, and camera
mappings) are stored on the Observer server. Users can use the same LNT information as long as
they load the same LNT project, regardless on which client they work.

In a typical installation you would run the Observer client on one screen and the layout navigation tool
on another screen (see 2.4 Client multi-window and multi-screen operation on page 18 for details).
However, you can of course run both tools on the same screen as well.

Please note: Currently LNT can only display MJPEG camera streams (MPEG camera streams are not
yet supported).

13.2 Installing the layout navigation tool

The layout navigation is available only in the locally installed client which currently runs on MS
Windows platforms only (see 2.1 Introduction to Observer clients on page 11).

The Layout Navigation is installed automatically when you install the locally installed Observer client.
Please refer to 2.3 Working with the installed Observer client on page 15.

Note: Currently the layout navigation tool is available only in the locally installed client. For running the
layout navigation tool Microsoft .NET 2.0 or a newer version must be installed.

13.3 Starting the layout navigation tool

You can start the layout navigation tool the same way as you can start the installed Observer client.
Please refer to 2.3.2 Starting the installed Observer client on page 15.
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The layout navigation tool (LNT) main window looks like this:
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13.4 Setting up a project and defining layouts (Editing mode)
In order to setup LNT for work you have to execute a few steps:

e Plan your layout hierarchy
e Select and upload images to be used for layout backgrounds
o Define the hierarchy and map your cameras

In the next subsections we will cover the above topics.

13.4.1 Planning your layout hierarchy

Before you create a project and start to upload graphics images for your layouts it makes sense to
plan the layout hierarchy. For example, if your Observer system covers a building then you could have
an overview layout image for the building and then separate subordinate layout images for each floor.

For an even bigger setup: If your Observer system covers a whole area with several office or plant
buildings then you could have an overview layout image for the whole area and subordinate layout
images for each of the buildings and additional images for the parking lots, driveways, fence sectors,
etc. Each of the building layouts then in turn could have subordinate layout images for parts of the
building like each of the floors. Each of the floors could additionally have subordinate layouts for parts
of the floor or even for each of the rooms. Thus you can create hierarchies at arbitrary levels of detail.

94



NETAVIS Observer 4.4 User Manual

13.4.2 Switching to editing mode and creating a project

1.

Switch to editing mode by choosing Project > Switch to editing mode or by pushing the editing
button # at the right side of the tool bar.

In editing mode the LNT window now has added a new control icon list.

Create a new project by choosing Project > New project and then enter a name of the new

project in the newly opened dialog. Push OK. Now you start to upload background images for
your layouts.

13.4.3 Creating layouts and mapping cameras, 1/O contacts, and zones

After you planned your layout hierarchy you have to select appropriate images for the various layouts.
The layout navigation tool supports popular image graphics file formats like GIF, JPEG, PNG, etc.

Depending on your needs and the available screen resolution for the layout navigation tool (LNT) you
have to choose the size (in pixels) for your images. Please keep in mind that the LNT also supports
image scaling to fit the available space.

Creating a new layout

To create a new layout, follow these steps:

1.

2.

In the layout navigation tool (LNT) switch to customizing mode by choosing Project > Switch to
editing mode or by pushing the editing mode button & atthe right side of the tool bar.
In the Layout menu choose New..., which opens the Layout dialog:

Layout name  Ground floor Preview background image

Parent Alam -

Layout backaround file

moc10-2-36-49_2008-01-24_164430 jpg
floor_pland jpg
floor_plan3 jpg

floor_plan jpg

| Uplad | | Delete |

Enter a name for the layout.

Select a background image from the list of available uploaded images or push Upload to upload
a new background image for the layout (you can also delete uploaded images from the server by
selecting an image from the list and pushing Delete).

If the layout is subordinate to another layout then choose the parent layout from the Parent pop-
up menu (you can change the layout hierarchy later on via the Layout > Properties dialog).

Push OK to create the layout.
Now you see that the layout with the selected background image has been created.
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Mapping cameras

1. From the list of controls at the right side drag a camera control icon with the mouse onto the
layout and drop it there. A camera selection dialog opens automatically. Choose the I/O device
and contact and push OK. Now you have mapped the camera to your camera icon.

Repeat the above step for other cameras.

You can delete a camera by selecting it with the mouse by choosing Delete from the right mouse
button pop-up menu.

Mapping /O contacts

LNT allows you to work with I/O devices, i.e. you can display the state of input contacts and you can
switch output contacts of I/O devices (for configuring 1/0 devices, please refer to 16.7 Configuring /0
devices on page 136). You can place such I/O controls onto layouts like camera controls.

Here are some icons representing the various states of input and output contacts:

L!J ) ? ;}?‘%

1. From the list of controls at the right side drag an 1/O control icon with the mouse onto the layout
and drop it there. An I/O contact selection dialog opens automatically. In the list you only see I/O
devices that are configured with Observer. Choose the device and the 1/0 contact and push OK
(depending on whether the I/O control represents an input or an output contact, you get only
input or output contacts the contacts list of the selected device). Now you have mapped the 1/O
device to your camera icon.

Output contacts: input contacts:

Repeat the above step for other 1/O contacts.

You can delete an I/O contact control by selecting it with the mouse by choosing Delete from the right
mouse button pop-up menu.

Defining zones

LNT allows you to group several cameras on a layout into so called zones that can have arbitrary
polygon shapes.

Cameras belong to a zone as long as they are positioned inside the boundaries of the zone. You can
place an arbitrary number of zones onto a layout.

Here is how you can create a zone:

1. Select a layout from the layout hierarchy.

2. Drag the Zone field with the mouse from the controls list at the right side and drop it onto your
layout. Where you drop the zone field control with the mouse will be the first corner of the
polygon shape and you can now define the zone shape by clicking at further corners. To finish
the zone definition, close the polygon shape. Alternatively you can create a rectangular zone by
pressing the CTRL key while moving the mouse.

3. Per default the zones will be named “Zone-1", “Zone-2" and so on. You can rename and delete a
zone via the right mouse button pop-up menu. Zones can be moved by dragging them with the
mouse.
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Please note: A zone can trigger certain actions, e.g. when you click with the mouse on it, a zone can
show all cameras belonging to the zone in the Observer client. This, for example, will either create a
new view in the Observer client or map it to an existing view depending on the names of the views and
zones. Therefore the name of a zone can be of importance.

Here is how the mapping works for the LNT action Show zone live in Observer Client:

If there is an Observer view that has the same name as the LNT zone and that also contains all the
cameras of the LNT zone, then this view is exposed in the Observer client. Otherwise a new view is
created with the name of the zone. Details for zone actions can be found under 13.5.3 Modifying zone
control appearance and behavior on page 99.

Linking layouts with link fields

LNT offers link fields to easily navigate between layouts. Link fields can be placed on layouts and are
resizable grey areas. Clicking on a link field in Navigation mode will open the “linked” layout.

Here is how you can link layouts via link fields:

1. Drag the Link field from the controls list at the right side and drop it onto your layout. Where you
drop the zone field control with the mouse will be the first corner of the polygon shape and you
can now define its shape by clicking at further corners. To finish the link field definition, close the
polygon shape. Alternatively you can create a rectangular link field by pressing the CTRL key
while moving the mouse.

After you finished defining the shape of the link field, a dialog is opened offering the available
layouts for this link field. Choose a layout by double clicking or by pushing the Select button.
This defines which layout is to be opened when the link field double clicked in Navigation mode.

2. Choose Save from the Project menu to save your changes.

Now you can repeat the steps above to create your overall layout hierarchy. You can switch back to
Navigation mode by clicking the navigation mode icon = at the right side of the tool bar.

Defining a default project

To define a default project to be loaded when LNT is started, follow these steps:

1. Inthe Project menu choose Set default project... which opens a dialog listing all available
projects. Choose a project and push Select. To not load a default project, choose <No default
project> from the list.

Now this project will be loaded automatically at startup.

Defining a home layout

A home layout can be defined which is automatically shown when the project is loaded. You can set
the home layout by following these steps:

1. Inthe layout hierarchy select the layout that you want to set as home layout.
2. Inthe Layout menu choose Set as home.

Now this layout will be opened automatically when the project is loaded.

13.5 Customizing the behavior and appearance of controls

LNT currently has 2 types of controls that can be modified: camera controls and zone controls (the link
field control cannot be modified).

LNT lets you modify several aspects of the appearance and behavior of these control icons:

e Icon image and appearance.
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e What happens when you move the mouse over a control icon or when you click on it.
¢ What happens on certain events originated by Observer related to cameras or zones.

Also you can create new control icons with your own icon images.

13.5.1 Modifying camera control appearance and behavior

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the editing
button # at the right side of the tool bar.

2. Inthe control icon list click on a camera icon with the right mouse button and choose Modify...
from the pop-up menu. This opens the Modify control dialog:

Meadify Control Icon |
Name Indoor right =
lcon filename icon1b.png e
Actions
Sinale click [Show live stream in LNT "]
Double click [Show archive calendar in Observer Client v]
Maouse aver [No action "]
Mouse over delay 400
Context menu actions Actions

Show live stream in LNT Stop motion detection

Start continuous recording Stop analog video decode
Start motion detection
Show archive calendar in Observer Client
Show live in Observer Client
@ Decode video to analog

Stop continuous recording

4| i 3
Events
Event Action Action property
Motion detected Colar -Opadty 255 Interval !
Connection to camera restored Calor -ODEICﬂ‘)' 255 Interval !
Connection to camera lost Calor Opacity 255 Interval -
4 [l | 3
| ok | [ Cancel |

In this dialog you can define the control name and image and which actions are to be performed
on certain mouse operations and events.

Actions

The possible Actions are:
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e Show live in Observer Client exposes a large live view of the respective camera in the
Observer client that runs on the same machine. If no client is running on the same
machine, then noting is happening.

e Show archive calendar in Observer Client exposes the archive calendar view of the
respective camera in the Observer client that runs on the same machine. If no client is
running on the same machine, then noting is happening.

e Show live stream in LNT opens a window showing a live stream of respective camera in
LNT. If this action is bound to Mouse over then the window will be automatically closed
when the mouse is moved away from the camera icon. If this action is bound to Single
click or Double click, then the window stays until it is closed manually. To close all such
windows, you can select Close all live streams in the View menu.

e Start/Stop continuous recording starts or stops continuous recording of the camera in
Observer. It actually sets or deletes the Enable interval checkbox in the camera admin’s
Scheduling dialog. Please be aware that there must be at least one continuous recording
interval for the camera for this to work (refer to 7.1.1 Programming continuous timed
recordings on page 49 for details).

e Start/Stop motion detection enables or disables motion detection of the camera in
Observer. It actually marks or unmarks the Enabled checkbox in the camera admin’s
Motion detection dialog. Please be aware that there must be at least one detection field
definition for the camera for this to work (refer to 8.1.2 Basic configuration of server-based
motion detection on page 64 for details).

e Start/Stop analog video decode allows the control of special devices that decode IP-
based network video signals to analog video signals. This is useful for example for
security center video walls that are driven by analog video signals. The configuration of
these special devices must be done in configuration files (please refer to the Release
Notes or to the customization documentation).

Events

You can also modify the behavior of control icons for certain events, like Connection to camera
lost or Motion detected.

Click OK to save changes.

13.5.2 Adding a new camera control

1.

Switch to customizing mode by choosing Project > Switch to editing mode or by pushing the
customize button # at the right side of the tool bar.

In the control icon list click the right mouse button and choose Add control... from the pop-up
menu. This opens the Add new control icon dialog which is essentially the same as the Modify
control icon dialog (see 13.5.1 Modifying camera control appearance and behavior on page 98).

Here you can define the icon name and image and which actions are to be performed on certain
mouse operations.

You can also modify the behavior for certain events, like color and blinking.

Click OK to create the new camera control icon.

13.5.3 Modifying zone control appearance and behavior

1.

Switch to editing mode by choosing Project > Switch to editing mode or by pushing the editing
button # at the right side of the tool bar.

In the control icon list click on a zone icon with the right mouse button and choose Modify... from
the pop-up menu. This opens the Modify Zone dialog:
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100

Modify Zone
Name Zone
Colar Color Opacity 70
Highlight color Calar Opacity 120
Actions
Single click [Show zone live in Observer Client vl
Double click [No action v]
Mouse over [No action 'l
Mouse over delay 2000
Context menu actions Actions
Show zone live in Observer Client Stop motion detection
Start continuous recording
Stop analog video decode
Start motion detection
Decode video to analog
@ Stop continuous recording
Events
Event Action Action property
——
Connection to camera restored
View selected in Observer Client | Highlight - [ Color Opacity "100]
Connection to camera lost
| ok | | Cancel

In this dialog you can define the color of the zone and which actions are to be performed on
certain mouse operations and events.

Actions

The possible Actions are basically the same as for the camera control (see 13.5.1 Modifying
camera control appearance and behavior on page 98) with one addition:

e Show zone live in Observer Client exposes the corresponding view of the zone in the
Observer client that runs on the same machine. If there is an Observer view that has the
same name as the LNT zone and that also contains all the cameras of the zone, then this
view is exposed in the Observer client. Otherwise a nhew view is created with the name of
the zone.

Events
You can also modify the behavior of zones of this type for certain events, like Connection to
camera lost or Motion detected.

The event View selected in Observer Client works this way: If there is an LNT zone with the
same name as the view in Observer then the corresponding action is triggered.
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Click OK to save changes.

13.5.4 Adding a new zone control

1.

Switch to customizing mode by choosing Project > Editing mode or by pushing the customize
button ¥ at the right side of the tool bar.

In the control icon list click the right mouse button and choose Add zone... from the pop-up
menu. This opens the New zone dialog which is essentially the same as the Modify Zone dialog
(see 13.5.3 Modifying zone control appearance and behavior on page 99).

Click OK to create the new zone control.

13.5.5 Modifying 1/0 contact control appearance and behavior

1.

3.

Switch to editing mode by choosing Project > Switch to editing mode or by pushing the editing
button # at the right side of the tool bar.

In the control icon list click on an I/O control icon with the right mouse button and choose
Modify... from the pop-up menu. This opens the Modify control dialog:

Modify /O Contact Control ]

MName 170 autput
Activated state image

L J
Dectivated state image io_output_deactivated png

L J
Control type Output pin

In this dialog you can define the name of the control and the two images for activated and
deactivated states. The control type (Input or Output) cannot be modified.

Click OK to save changes.

13.5.6 Adding a new /O contact control

1.

Switch to customizing mode by choosing Project > Switch to editing mode or by pushing the
customize button # at the right side of the tool bar.

In the control icon list click the right mouse button and choose Add I/O contact... from the pop-
up menu. This opens the Modify 1/0 Contact Control dialog (for an screen shot see 13.5.5
Modifying 1/0O contact control appearance and behavior on page 101).

In this dialog you can define the name of the control and the two images for activated and
deactivated states. Also set the Control type: An Input contact displays the state of the input
contact of an 1/0 device. An Output contact allows you to switch an output contact of an I/O
device.

For example, for an input contact that shows the state of a gate barrier you can use images that
reflect the open and closed state of the barrier.

Click OK to create the new camera control icon.
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13.6 Layout navigation and operation (Navigation mode)

Switch to Navigation mode by clicking the navigation mode icon = at the right side of the tool bar or
by choosing Project > Switch to navigation mode.

Please note: An Observer client must be running under the same user on the same client workstation
so that it can be controlled by the layout navigation tool.

13.6.1 Peeking live video of mapped cameras

The default behavior of some camera icons is that you can peek at live video of mapped cameras by
moving the mouse pointer over a camera icon. Then the live video stream will be shown on top of the
layout:

As soon as you move the mouse pointer away from the icon, the stream disappears. This behavior
can be changed with the Modify control icon dialog (see 13.5.1 Modifying camera control
appearance and behavior on page 98).

13.6.2 Showing a camera in the Observer client

When you single click a camera icon in LNT then the corresponding camera will be shown in full size
in the Observer client. This behavior can be changed with the Modify control icon dialog (see 13.5.1
Modifying camera control appearance and behavior on page 98).

Please note that the Observer client has to be running on the same machine being connected to the
same server in order for the feature to work (the client will not be started automatically by LNT).

13.6.3 Positioning to the camera recording archive in the Observer client

When you double click a camera icon in LNT then recording archive of the corresponding camera will
be shown in the Observer client running on the same machine. This behavior can be changed with the
Modify control icon dialog (see 13.5.1 Modifying camera control appearance and behavior on page
98).

Please note that the Observer client has to be running on the same machine being connected to the
same server in order for the feature to work (the client will not be started automatically by LNT).

13.6.4 Navigating in the layout hierarchy
You can position to a layout by clicking its name in the layout hierarchy.

You can also jump to a connected layout by clicking a link field.
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13.6.5 Working with events in the layout navigation tool

The layout navigation tool (LNT) also allows you to view and acknowledge Observer events.
Please note: Event handling will only work if the user has the rights to work with events.

When a new event occurs in Observer, then it is displayed in the Event list at the right side of the LNT
window (the Event list can be switched on and off in editing mode by choosing View > Event list).

The Project settings define what happens when a new event is coming in (see 13.6.7 Project settings
on page 104): The layout that contains the primary control for related to the event can be exposed
automatically and also the control that is related to the event can be highlighted (blinking rectangle).

Additionally a longer description is displayed in the Event description field at the bottom of the
window (which also can be switched on and off in Editing mode by choosing View > Event
description).

You can acknowledge an event by pushing Acknowledge in the Event description field.
Acknowledged events will be removed from the Event list. Pressing Cancel sets the state of the event
to seen (visited) but does not acknowledge it.

Please note that for each camera, a primary control can be defined that is exposed when a new event
is generated. You can set the primary flag for a camera icon by right-clicking on the icon in editing
mode and choosing Primary from the pop-up menu.

Generally, events in LNT can have the following states (indicated by different colors of the event
entry):

¢ New (unseen) events are shown as grey (if it is selected then it is shown in green).
e Seen (visited) events are shown in blue.
o Acknowledged events are removed from the list.

When there are several new events, then LNT offers you to see (visit) them one by one. The exact
behavior of the visiting and how the event state can be set to seen (visited) can be defined in the
Project settings (see 13.6.7 Project settings on page 104). You can, for example, mark a new event as
seen and jump to the next event by moving the mouse over the blinking control.

13.6.6 Camera status display

LNT allows you to display certain states of cameras in the mapped camera and zone control icons.
Examples for states that can be displayed are recording, motion detection active, broken connections,
etc.

An example of a status display is:

-

This camera currently is recording and has motion detection enabled.
To modify the status display settings, follow these steps:

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the
customize button # at the right side of the tool bar.

2. Choose Project > Camera status display settings... which opens the Status display settings
dialog.
This dialog now allows you to define the status settings for camera and zone controls. You can
modify the status display settings according to your needs. You can also enable/disable certain
status displays by setting the Enabled flag.

3. Push OK to save your changes or Cancel to discard them.
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When you switch to navigation mode, the new settings become effective.

13.6.7 Project settings

The layout navigation tool (LNT) allows you to set several project settings that define the workings of
the tool. In the Project menu choose Project settings... to open the Project settings dialog.

Here you can set the following values:

Setting Description

Show home layout on load Defines whether the Home layout is shown when the tool is
started. In order for that to work you must have a home
layout defined.

Highlight zone under mouse Defines whether zones will be highlighted when you move

cursor the mouse over them. This can be useful for distinguishing
when the mouse cursor is over the zone or over the camera
control icon on top of the zone.

Automatically jump to layout on In case of an event this setting defines whether the layout

event that contains the primary control related to the event should
be exposed.

Visiting order of events Defines in which order new events are to be visited.

Set event state to seen (visited) by | When a new event comes in or an existing event is
selected, the related control blinks or is highlighted. This
setting defines with what mouse operation the state of the
event can be set to seen (visited) (blinking is stopped).

Only suggest events of mapped If this checkbox is marked then only events of mapped
images for visiting cameras will be suggested for automatic visiting. If it is
unchecked then all events will be suggested.

Standard view size for layouts Defines the default image size, either Fit image or Full
size.
Event list insertion mode Defines whether new events in the Event list are inserted

from the Top or from the Bottom.

104



NETAVIS Observer 4.4 User Manual

14 Video analytics with iCAT

iCAT is the video analytics toolkit of Observer. It provides powerful and easy-to-configure object
detection and tracking mechanisms as well as a statistics module with integration to the event
management system EMS.

iCAT can also interface to 3“-party video analysis toolkits and algorithms (contact NETAVIS Software
GmbH).

Please note: Since iCAT and some functions are licensed separately of Observer you need a valid
license in order to work with these features. See also 11.1 Server system information and restarting on
page 82 for details about what license you have.

14.1iCAT highlights

iCAT works with any camera that can deliver an MJPEG stream (this covers also analog
cameras that are connected via a video server or directly connected to a video grabber card in
the Observer server).

iCAT is easy to configure and setup and it works in difficult situations also with extreme
camera perspectives.

It offers flexible scheduling of iCAT definitions depending on date and time. Thus you can
have different setups for weekdays and weekend as well as day and night.

The Smart Tripwire™ function for people and object counting prevents wrong and double
counting and works even with the most difficult entrance situations.

The Smart Tripwire™ also allows detecting wrong direction movements of people and
objects.

Powerful and robust object tracking and event triggering can be constraint to object sizes,
speeds, and other properties.

Event statistics can be exported to Excel XLS for further processing.
All iICAT detection annotations are available for live streams and in archived recordings.
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e Seamless integration with the Observer event management system EMS and other Observer
functions. Additionally iCAT offers camera sabotage detection and lighting change
detection.

e iCAT algorithms have been tuned for the highest performance and least burden on the
server.

14.2 Basic iCAT concepts

iCAT basically consists of the following components that are tightly integrated with Observer:

1. An object detection and tracking engine analyzes the video stream and tracks detected objects.
Please be aware that an object has to show consistent motion first in order to be detected and
tracked.

2. An event logic engine with configurable event triggers decides when a tracked object triggers an
event.

3. Areal-time statistics module stores statistical information about various aspects of objects like
object sizes and speeds.

For setting up a camera with iCAT you essentially configure the following things:

Object tracking region:

The object tracking region defines the part of the camera view in which iCAT is detecting and tracking
objects. For each camera you can define one tracking region that is either the full camera view or a
part of it in the form of a polygon or rectangle. No object will be detected or tracked outside of this
tracking region. Since the CPU overhead caused by iCAT is directly proportional to the size (area) of
all the active tracking regions of all active cameras of a server, optimizing the tracking regions will
save CPU power. Region definitions can also be used to mask out problematic areas in the scene as
well (e.g. swaying trees).

For each tracking region you can also define what object statistics should be measured by iCAT. Such
statistics can then be visualized.

Event triggers: Each camera can have several event triggers that define under what conditions an
event is generated by the detected objects. Event triggers only work inside of the object tracking
region. Examples of event triggers are people or object counters and detectors of stopped or started
objects. The CPU load caused by event triggers compared to the tracking region is negligible.

Scheduling: The standard Observer scheduling mechanisms are also used for scheduling (activating)
various iCAT setups. For example, it is possible to have different iCAT settings for weekdays and
weekends.

14.2.1 Considerations for setting up a system with iCAT

Camera selection and placement

Though iCAT is able to analyze video captured by any type of supported camera, using a device with
higher image quality will result in better detection and tracking.

Generally the iCAT algorithms work with in- and outdoor cameras as well as for different perspectives.
The configuration of the algorithms in Observer is pretty simple, as you will see below.

For people and object counting, the best results are possible if the camera is mounted overhead
downward looking.

Please note: Setting up iICAT definitions for PTZ cameras is problematic since most of the iCAT
functions require a fixed camera position.
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Video streams and formats

iCAT works with any video camera. If the camera can provide an MJPEG stream, iCAT uses this
format because it is the most efficient for video analytics. If the camera provides only MPEG formats
(MPEG-4, H.264, and MXPEG) then iCAT can also work on these streaming formats. However, please
be aware that video analytics in MPEG streams requires a lot more CPU power than in MJPEG
streams since the decoding is much more complex (for multi-stream operation please see below). Also
video analytics in MPEG streams causes additional delays because it works on groups of pictures or
frames (so called GOPs). As a rule of thumb, iCAT adds a delay of approximately 1 GOP duration.
Depending on the actual MPEG cameras model, A GOP duration is between 0.5 and 1 sec (see also
4.2 Adding a new camera and setting basic properties on page 25).

Analog cameras that are connected either via video server or directly connected to an Observer server
with a grabber card installed are also supported, of course.

iCAT generally works on CIF (or QVGA or nearest) resolution. This is a good balance between
accuracy and CPU overhead. If there is a continuous recording enabled for the camera, iCAT uses
this stream for its algorithms and does not cause additional bandwidth. If the size of the stream is
bigger than CIF, iCAT downscales it to CIF (or QVGA or nearest) resolution.

Any pixel measures that are available in iCAT are relative to this resolution.

Future releases will also allow you to select higher resolutions for the iCAT algorithms.
CPU load of iCAT (performance issues)

iCAT runs on the server and works very efficiently. The CPU overhead caused by iCAT is directly
proportional to the following aspects (see also 14.2 Basic iCAT concepts on page 106):

e The size (area) of all the active tracking regions of all cameras of a server. This means that
optimizing the tracking regions will save CPU power. The number and shape of event triggers is
negligible.

e The video processing speed (in fps) of ICAT.

e The streaming format (see above)

An Observer server running with iCAT on standard (not high-end) desktop server hardware can easily
handle approximately 10 iCAT-enabled cameras with standard settings.

Additional CPU power (like quad core), enhanced RAM speed, and bigger L2 caches help to boost the
iCAT performance.

Multi-streaming operation with iCAT

As indicated above iCAT normally needs much more CPU power for processing MPEG streams
(MPEG-4, H.264, and MXPEG) than for processing MJPEG streams. Therefore Observer can pull two
parallel streams from the camera if the camera supports that: one MPEG stream for live viewing and
recording and 1 additional MJPEG stream for iCAT operation.

In the Default settings dialog in Camera Admin the checkbox Multi-stream allowed enables or
disable this dual-stream iCAT processing (see also 4.2 Adding a new camera and setting basic
properties on page 25).

If this checkbox is selected and live viewing or recording is active with an MPEG stream with a frame
rate of more than 5 fps or a resolution bigger than VGA 640x480 pixels then Observer will try pull a
second MJPEG stream in QVGA fine from the camera for iCAT processing (please note that this
stream will be pulled even if the checkbox Allow JPEG streaming is deselected). The frame rate of
this second stream depends on the iCAT function.
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Please note: Dual-streaming iCAT processing will not be activated automatically after selecting the
Multi-stream checkboxes. Please restart the server or stop and start (disable/enable) all iICAT
functions of the camera in order to activate dual-streaming iCAT after changing the Multi-stream
selections.

Object detection

Depending on the sensitivity and other settings iCAT currently detects objects of 8x8 pixels or bigger
in size (in a QVGA image). Only moving objects are detected. New objects are detected by iCAT after
a few video frames. How quickly objects are detected is also influenced by the sensitivity setting.

iCAT video processing speed

If the objects you want to track move very quickly across your camera view you will require a higher
video processing speed of iCAT than if they move slowly across your camera view. As a rule of thumb
the optimal frame rate for object detection and tracking is 8-10 fps.

Please note: Not the absolute speed of the objects influences what processing speed you need but
the relative speed that these objects have in your camera view. This relative speed is influenced by
the camera perspective and distance from objects.

Example: Cars on a highway are moving very fast. However if you look at them with a camera from a
larger distance and from a perspective with a flat angle the cars are actually are moving pretty slowly
in your camera's view. Therefore you can choose a slower video processing speed even for such fast
objects like cars on a highway.

14.3 Setting up a camera for video analytics with iCAT

14.3.1 Defining an object tracking region

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

Select a camera in the camera tree and in the menu select Add new definition.

In the Type pop-up menu choose Object tracking region.

In the Identifier text field enter a name for this region.

Choose whether you want a Polygon or Rectangle shape by checking the respective check
box.

6. Now you can draw the region with the mouse in the preview pane. For a polygon you just click
with the mouse to define the corners of the polygon. You close the polygon by crossing an
existing edge or by double clicking with the mouse. Here is an example of a tracking region:

a bk wDn

S —

| | Rectangle Palygon

108



NETAVIS Observer 4.4 User Manual

Please note: As indicated in 14.2 Basic iCAT concepts on page 106 and 14.2.1 Considerations
for setting up a system with iCAT on page 106 objects will only be detected and tracked inside a
tracking region. Event triggers will only work inside the boundaries of tracking regions. On the
other hand, making the object tracking region as small as possible helps you to save CPU power

of your Observer server.

Also be aware that the tracking region should approximately at least be twice the size of the
biggest objects you want to track.

Now you have to set the configuration parameters of the tracking region:

Field label

Indoor camera

Overhead downward

looking

Sensitivity

Max object lifetime (sec)

Max stopped object
lifetime (sec)

Your input

Enable this setting if the camera is an indoor camera. Indoor setting
usually is best for rooms not bigger than 10x10m and objects not
farther away than 15m. Disable this check box for outdoor
environments. Experiment with this setting, if the detection/tracking
quality is not ideal.

This setting only takes effect if Indoor camera is enabled. Enable
the setting if the camera is overhead mounted and downward
looking. This will improve object separation and the accuracy of
object counting. In our example above, the camera is an indoor
camera and mounted overhead downward looking.

Usually this setting should be left at Normal. Only if you are not
satisfied with the object detection quality or behavior you can try to
modify this setting.

If you want a sharper object detection and separation, you can set
the Sensitivity to High or Very high. Also for example, if you want
to detect very small objects, you can improve the sensitivity. The
Sensitivity also influences how fast new objects are detected.
Higher Sensibility means quicker object detection, lower means
slower detection.

For environments that are very noisy visually and that cause too
many objects to be detected, the Sensitivity can be set to Low or
Very low.

Defines how long a detected object is tracked before it is dismissed
by iCAT (i.e. no longer treated as object but essentially becoming
background). After an object is being dismissed by iCAT, if it starts
moving again, it will be detected as new object. The setting is useful
to lower the probability of falsely tracked objects which remain in
the scene for too long. If you experience that objects are no longer
tracked though they are visible and moving, this value might have to
be increased.

Defines how long a detected object that stopped is tracked before it
is dismissed by iCAT (i.e. no longer treated as object but essentially
becoming background). After an object is being dismissed by iCAT,
if it starts moving again, it will be detected as new object.

The setting is useful for removing false detections (usually caused
by environmental changes) which often remain still for a longer
period. If objects in the scene usually stop longer than this time
limit, then set it higher.
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Field label Your input

Video processing (fps) This defines at what frame rate the iCAT algorithms operate. If the
objects you want to track move very quickly across your camera
view you want to improve the speed. If they move slowly across the
camera view you can decrease the speed. See also 14.2.1
Considerations for setting up a system with iCAT on page 106.

Tolerance radius for Defines when how much a stopped object may move away from its
stopped object (%) stopping position before ICAT detects it to move again.

There is a virtual circle centered at the object's center point. In this
field one can define its radius proportional to the size of the object.
If the object's center remains inside the circle it is detected as
stopped. When this value is set close to 100%, slowly moving or
loitering objects will be detected as stopped. It also influences the
statistics of stopped objects.

8. Push Next to get to the Statistics settings for the tracking region. Here you can define what
statistics iCAT should collect. Later on these object tracking statistics can be visualized (see
14.4.2 Displaying Visual Statistics™ on page 124. Currently, the following measurements are
available: Object counts, speeds, sizes (also for stopped objects).

9. Push Save to create the tracking region. Later on you can modify the tracking region settings.

10. If you did not yet define the scheduling for iICAT activities, then after you save the first iCAT
definition for a camera, you will be prompted for whether you want to edit the scheduling now.

Click on the Yes button if you want to configure the scheduling now (refer to section 14.3.9
Scheduling iCAT operation and recording on page 120 for further information).

Click on the No button if you do not wish to schedule the recording or if you want to do that later.

Please note:

- If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of the
camera. If you do not want that, you have to remove the assignment manually (see 14.3.9
Scheduling iCAT operation and recording on page 120).

- If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.

iICAT event settings

You can also specify event-related properties on an iCAT definition:

1. You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.

2. You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).

3. The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

14.3.2 Defining an event trigger for people and object counting (Smart Tripwire™)

Once you have created a tracking region, you can create an arbitrary number of event triggers inside
this tracking region. Event triggers define under what conditions an Observer event is generated by
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iCAT. Such events can trigger automatic recording and are stored in the normal Observer event
database that can be queried and exported.

Currently iCAT supports the following event triggers:

e A Smart Tripwire™ for directional people or object counting. This tripwire is directional, so if you
want to count objects in two directions you would create two tripwires.

e A polygon or rectangle that creates an event when an object either crosses the field, stops
inside the field or starts moving inside the field.

Please note: Before you can define an object trigger you must first define an object tracking region
(see 14.3.1 Defining an object tracking region on page 108).

Here are the steps for creating a counting tripwire:

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

2. Select a camera make sure that you have a suitable tracking region defined that allows for object
counting.

3. Choose Add new definition from the menu.

4. Inthe Type pop-up menu choose Event trigger, which will expose the configuration settings.

5. Under the camera preview choose the Tripwire check box for directional people or object
counting.
6. Now you can draw the tripwire line with the mouse in the preview pane. You just click with the

mouse to define the corners of the polygon. You finish the line by double clicking with the mouse.
Here is an example of a tripwire:

| |Rectangle | | Polygon [v| Tripwire | Toggle

This tripwire triggers a counting event whenever an object moves from the green area across the
red tripwire. The tripwire is “smart” as it only counts objects that have first been detected in the
green area and move across. It would not count the object if it would first be detected in the non-
green area, then moved across the line into the green and then move across the tripwire from
the green to the non-green area. It also would not double count an object that would have moved
across the line twice.

Hints: To countincoming and outgoing people or objects you would create two different
tripwires with opposite green areas which would both trigger events.
You can also use the tripwire to detect objects moving in the wrong direction.
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10.

11.

12.

13.

112

Please note: As indicated 14.2.1 Considerations for setting up a system with iCAT on page 106
objects will only be detected after a few frames. Therefore an object can move a bit before it is
actually detected as object by iCAT. Therefore it makes sense to have the green area big
enough to allow iCAT time for the object detection. If that is not the case it might be possible that
quickly moving objects are not detected before they cross the tripwire and therefore would not be
counted. The ideal settings depend on viewed (relative) object speed and iCAT video processing
frame rate.

Do not place the tripwire too close to areas where objects exit the scene (e.g. image borders,
doors), because they might disappear before crossing the tripwire. It is a good practice to draw
the tripwire about half the average object size away from such areas.

You can also define when an object is counted by either selecting Object center point, Any
point of object, or Whole object. The most appropriate choice in most cases Object center
point because of its robustness.

When you push the Next button you can define additional constraints for the event creation. You
can limit the counting only to certain object sizes, certain aspect ratios, and a certain speed.
Currently those measures are definable in pixels (please keep in mind that the resolution iCAT
works on is either CIF or QVGA depending on the aspect ratio of the camera). Future releases of
iICAT will allow for real world measures.

Zero values in these fields mean that there is no constraint.

Hint for constraining the object size or speed: The size is the area of the object in pixels and
the speed is also measured in pixels per second. To know what object sizes or speeds you want
to filter it is helpful to watch a few objects passing the triggers and switch on the object markers.
These markers show the size and speed of the object in pixels. These are exactly the same
measures that you can use for the trigger. Here is an example of an object marker (Object ID is
[10], object size is 9110 pixels, speed is 208 pixels/sec):

The section 14.4.1 Displaying iCAT information in the Online monitor and when playing
recordings on page 122 shows you how to view object markers.

In the Identifier text field enter a name for this event trigger. An example name for a people
counter would be "Entrance 1 incoming".

You can also choose a specific lIcon shown and Sound played for the event when it is shown in
the Event list. Or you can choose to have no icon or no sound associated with the event.

You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event (see 9 Handling events on page 69 for further details on
event priorities).

The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

Push Save to save your definition.
Please note:

o |If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of
the camera. If you do not want that, you have to remove the assignment manually (see
14.3.9 Scheduling iCAT operation and recording on page 120).

¢ If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.
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iCAT event settings

You can also specify event-related properties on an iCAT definition:

1.

You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.

You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).

The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

14.3.3 Defining an event trigger for object starting and stopping

In addition to object counting, iCAT also offers to detect stopping and starting objects in a defined

field.

Here are the steps for creating an event trigger for object starting and stopping:

1.

I

Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

Select a camera and make sure that you have a suitable object tracking region defined that
allows for object counting (see 14.3.1 Defining an object tracking region on page 108).

In the menu select Add new definition.
In the Type pop-up menu choose Event trigger, which will expose the configuration settings.
Under the camera preview choose the Rectangle or Polygon check box.

Now you can draw the field with the mouse in the preview pane. For a polygon you just click with
the mouse to define the corners of the polygon. You close the polygon by crossing an existing
edge or by double clicking with the mouse.

Now select on what object behavior you want to trigger an event: When an Object is crossing
field, when an Object starts moving in field, or when an Object stops in field. You can also
define when an event is triggered by either selecting Object center point, Any point of object,
or Whole object.

In the field Min. time for stopping/staying inside (sec) you can enter a minimum time required
for an object that either stops or stays inside a field before an event is triggered.

When you push the Next button you can define additional constraints for the event trigger. You
can limit the counting only to certain object sizes, certain aspect ratios, and a certain speed.
Currently those measures are definable in pixels (please keep in mind that the resolution iICAT
works on is either CIF or QVGA depending on the aspect ratio of the camera). Zero values in
these fields mean that there is no constraint.

Hint for constraining the object size or speed: The size is the area of the object in pixels and
the speed is also measured in pixels per second. To know what object sizes or speeds you want
to filter it is helpful to watch a few objects passing the triggers and switch on the object markers.
These markers show the size and speed of the object in pixels. These are exactly the same
measures that you can use for the trigger. Here is an example of an object marker (Object ID is
[10], object size is 9110 pixels, speed is 208 pixels/sec):
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The section 14.4.1 Displaying iCAT information in the Online monitor and when playing
recordings on page 122 shows you how to view object markers.

10. Inthe Identifier text field enter a name for this event trigger.
11. Push Save to save your definition.

Please note:

- If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of the
camera. If you do not want that, you have to remove the assignment manually (see 14.3.9
Scheduling iCAT operation and recording on page 120).

- If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.

iICAT event settings

You can also specify event-related properties on an iCAT definition:

1. You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.

2. You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).

3. The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

14.3.4 Defining sabotage detection
iCAT offers intelligent features for detecting three types of camera sabotage actions:

e Camera defocused
e Camera covered
e Camera moved

Please note: For sabotage detection an object tracking region is NOT needed.
When initializing the camera for sabotage detection please make sure that the camera has the correct
focus setting and that the scenery and brightness is stable.

Here are the steps for installing an iCAT-based sabotage detection:

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

2. Choose a camera and in the menu select Add new definition.

3. Inthe Type pop-up menu choose Sabotage detection, which will expose the configuration
settings.

4. Select any of the three sabotage detection types.

5. Inthe Identifier text field enter a name for this sabotage detection.

6. Push Save to save your definition.

Please note:

- If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of the
camera. If you do not want that, you have to remove the assignment manually (see 14.3.9
Scheduling iCAT operation and recording on page 120).

- If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.
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Background information on sabotage detection algorithms

Sabotage detection uses three detector algorithms to generate events for camera moved, defocused
and covered.

The camera movement detector tries to locate a couple of strong (= has high contrast) points across
the entire picture. Then it searches for them on each of the following frames, while continuously
creating new points to keep adapting to a new scenery. A "camera moved" event occurs when a given
number of these points are lost for a while.

The focus change detector acts like the auto focus algorithms in digital cameras. It estimates the
average sharpness of the picture and produces an event if this sharpness changes abruptly. A "focus
lost" event is produced if the sharpness of the picture decreases below a threshold, and a "focus
gained" event if the sharpness is increased above a threshold. Both thresholds are based on average
sharpness values of previous frames.

The camera covered detector uses a brightness analyzer that calculates the average brightness of the
picture for each frame and if something strange happens tries to find out what has happened (light
switched off, light switched on or just a person in dark clothes passed by). It does so by analyzing a
sample of average brightness values collected in previous frames.

The result of the these three detectors are combined to give the final alarm event (camera moved,
camera covered, focus lost/gained, brightness change)

Possible reasons of missed or wrong detections

As mentioned above the camera movement detector works with high contrast points on the picture
and the focus change detector checks the sharpness of the picture (measuring the sharpness of
edges). Logos or date and time text fields generated and placed on the picture by the camera could
decrease the accuracy of these detectors or could even prevent detection at all. This is because such
overlay fields are always stable, have a high contrast and sharpness and can therefore balance real
picture changes, so that the overall change is too small to be detected.

The solution is to disable the text overlay at the camera's own web page.

"Focus lost" and "focus gained" events:

A dynamic scene with moving objects of various sizes always changes the average sharpness a little
bit and the detector tries to filter out these small variations. This is not always possible, so one can
sometimes experience false "focus lost" or a "focus gained" events.

Covering the camera should cause a "camera covered" event, but the effects of the covering could be
very similar (from the algorithm's point of view) to a moved camera or to a lost focus. So the algorithm
has to decide what happened and the result is not always the proper event category (one may get
"camera moved" and more usually "focus lost" instead of "camera covered"). However, a sabotage
event should occur at unusual situations, it is just possible that the detailed category will not match the
actual reason.

Hint: As the three sabotage types have many properties in common, to get the best detection rate
switch on all sabotage categories. For example, a camera cover event might be categorized as a
focus lost, because then image sharpness drops dramatically. If this category is also switched on, the
sabotage will surely be detected.

iICAT event settings

You can also specify event-related properties on an iCAT definition:

1. You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.
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You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).

The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

14.3.5 Defining simple motion detection

Prior to release R1.12 Observer offered simple motion detection based on a detection of changed
pixels between video frames. Since then this detector has been made more robust and it is now part of
iCAT toolbox. Simple motion detection does not require an object tracking region.

For more details on setting up and working with this simple motion detection please refer to 8 Working
with simple motion detection on page 64.

14.3.6 Detecting a lighting change

Please follow these steps to enable lighting change detection:

Please note: For lighting change detection an object tracking region is NOT needed.

1.

Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.
Choose a camera and in the menu select Add new definition.

In the Type pop-up menu choose Lighting change detection, which will expose the
configuration settings.

Select the checkboxes for Light switched on and Light switched off to detect abrupt lighting
changes like when somebody switches the light on or off.

You can also enter values in the Brightness high limit (%) and Brightness high limit (%) fields
to detect slower lighting changes like during sunrise and sundown. If you leave these values
empty, then slower lighting change detection will be disabled.

In the ldentifier text field enter a name for this definition.
Push Save to save your definition.

Please note:

- If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of the
camera. If you do not want that, you have to remove the assignment manually (see 14.3.9
Scheduling iCAT operation and recording on page 120).

- If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.

iICAT event settings

You can also specify event-related properties on an iCAT definition:

1.
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You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.

You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).

The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).
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14.3.7 Defining a privacy mask
Privacy masks allow hiding private areas of a camera view from live viewing and recording.

This is an example of a privacy mask hiding the text on the carpet:

ENTRY_a241s & fps

Here are the steps for creating a privacy mask:

Please note:
- For privacy masking an object tracking region is NOT needed.
- Currently, privacy masks are not shown in exported streams and in the Layout Navigation tool.

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

Choose a camera and in the menu select Add new definition.

In the Type pop-up menu choose Privacy mask, which will expose the configuration settings.
Under the camera preview choose the Rectangle or Polygon check box.

Now you can draw the privacy field with the mouse in the preview pane. For a polygon you just
click with the mouse to define the corners of the polygon. You close the polygon by crossing an
existing edge or by double clicking with the mouse.

In the Identifier text field enter a name for this privacy mask.
7. Push Save to save your definition.
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Please note:

- If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of the
camera. If you do not want that, you have to remove the assignment manually (see 14.3.9
Scheduling iCAT operation and recording on page 120).

- If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.

iICAT event settings

You can also specify event-related properties on an iCAT definition:

1. You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.

2. You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).
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3. The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

14.3.8 Defining removed/abandoned object detection

iCAT offers to detect removed and abandoned objects in a defined region.

Please note: For removed/abandoned object detection an object tracking region is NOT needed. Be
careful with the size of the region since a greater size will cause a more CPU overhead on the server.

Here are the steps:

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.
Select a camera and in the menu choose Add new definition.

3. Inthe Type pop-up menu choose Removed/abandoned object, which will expose the
configuration settings.

4. Under the camera preview choose the Rectangle or Polygon check box.
Now you can draw the field with the mouse in the preview pane in which you want to detect
removed or abandoned objects
For a polygon you just click with the mouse to define the corners of the polygon. You close the
polygon by crossing an existing edge or by double clicking with the mouse. Here is an example
of such a field.

n
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Please note: The size of the region for removed/abandoned objects should be at least 50%
larger than the objects you want to detect. Never draw the region too tight around the object of
interest because the underlying algorithm analyses also the object's direct surroundings. A
region too close to the object can make detection impossible.

5. Select whether you want to Detect removed objects, Detect abandoned objects or both.

6. Inthe field Min. stay time for removed/abandoned objects (sec) you can enter a minimum
time a recognized object must stay, before a remove or abandoned detection on the object and a
corresponding event is triggered. Sometimes, in difficult cases, these time limits are exceeded by
the detector with a few seconds but usually detection time is close to the values defined. See
Further considerations and limitations below.

7. Inthe field Minimum size removed/abandoned objects (area in pix) you can constrain the
object size for the event trigger.
Currently those measures are definable in pixels (please keep in mind that the resolution iCAT
works on is either CIF or QVGA depending on the aspect ratio of the camera). Zero values in
these fields mean that there is no constraint.

118



NETAVIS Observer 4.4 User Manual

Hint for constraining the object size: The size is the area of the object in pixels and the speed
is also measured in pixels per second. To know what object sizes or speeds you want to filter it is
helpful to watch a few objects passing the triggers and switch on the object markers. These
markers show the size and speed of the object in pixels. These are exactly the same measures
that you can use for the trigger. Here is an example of an object marker (Object ID is [10], object
size is 9110 pixels, speed is 208 pixels/sec):

The section 14.4.1 Displaying iCAT information in the Online monitor and when playing
recordings on page 122 shows you how to view object markers.

In the Identifier text field enter a name for this event trigger.
Push Save to save your definition.

Please note:

- If you add a new iCAT definition, it will automatically be assigned to all iCAT schedules of the
camera. If you do not want that, you have to remove the assignment manually (see 14.3.9
Scheduling iCAT operation and recording on page 120).

- If a definition is not assigned to a schedule then it will not be activated and no archive
recordings will be made and no events will be generated.

iCAT event settings

You can also specify event-related properties on an iCAT definition:

1.

You can also choose a specific Icon and Sound for the event when it is shown in the event task
bar.

You can also define a special event priority for events generated by the trigger by setting the
value Priority of generated event. Please note that the event priority is a relative priority
whereby 100 is the default priority (see also 9 Handling events on page 69).

The check boxes Save event in event list and Do not save event in event list allow you to
selectively override the general setting for the camera schedule which is defined in 14.3.9
Scheduling iCAT operation and recording on page 120).

Further considerations and limitations

Abrupt brightness changes and large variation of white balance (as automatically set by
several cameras) may cause false detection, especially false detection of removed objects. In
general, if these two conditions become worse, the algorithm become less reliable.

The best conditions are provided by a stably lit indoor situation. However, the algorithm can
also work successfully in outdoor situations. If the lighting conditions are varying heavily, it is
recommended to use just abandoned detection (removed detection is switched off), because it
is more robust to such varying lighting conditions (through longer detection timeout).

The region must be carefully defined, i.e. the interesting objects (for example objects of a theft
detection) must be fully located inside the region. For example: If you want to detect when your
telephone is removed from the table, you can define a relatively small region around the phone
to avoid false detections elsewhere, but the region must be a bit larger than the phone allowing
the robust detection of its contours. The situation is the same in case of abandoned objects.
Abandoned objects which are partially located outside the region may not be detected.

The objects which are apparently static (stopped person who moved before, person sitting in an
office) can also cause false alarms. The detector tries to track moving objects and keep their
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position when they stop, in order to ignore such objects during detection of really static ones.
However through the failures of the tracking such objects may be lost and wrongly classified as
an abandoned one. A stopped person who is lost by the tracker becomes the subject of
removed/abandoned classification after the given alarm timeout. If it starts moving before the
timeout reached, there will be no false alarm raised.

The possibility of the above mentioned problem increases with the number of person in the
scene (as tracker reliability decreases) or with people who only show movement rarely (person
working in an office). In the former case you can increase the abandoned detection timeout in
order to be more robust, but in the latter one masking out the area where the apparently static
person is should be the best.

There are two alarm timeouts to be set. One for abandoned and one for removed objects. If the
scenery is clear, the interesting object is visible then the alarm event will be raised by and large
if the timeout is reached. But when another moving or stopped objects (for example the actor
itself who is going to leave a luggage) hides or overlaps the interesting object such that it is
visible only partially or not at all, the detection time may be longer. So these timeouts are not
guaranteed detection timeouts but rather parameters which can increase robustness (setting
them longer) or to increase sensitivity (setting them shorter). Of course the alarm event will
follow the detection some time around the timeout but the difference depends strongly on the
observed scenery.

14.3.9 Scheduling iCAT operation and recording

This section describes how to schedule iICAT video analysis operation and how to define the related
event-based recording.

Here are the steps:

1.

120

Choose Camera admin from the System administration menu. This opens the Camera admin
dialog.

In the camera tree select the camera that you want to schedule. Go to the Scheduling dialog by
clicking on Next at the bottom.

In the menu select Modify selected camera or group.

Press the Add button below the Time intervals list and choose Video analysis (iCAT) from the
type button labeled Change.

Now define the days and times when iCAT should be enabled for this camera. You can activate
individual days or, with the All button, the whole week at once. Select hours and minutes from
the time popup.

Please make sure that the Enable interval checkbox is marked, because only then the settings
are enabled.

Note: You can create multiple iCAT intervals for different setups at different times. For each
interval proceed as described here.

Check the assigned iCAT definitions to this interval via the Assigned iCAT definitions popup
menu at the right side of the dialog. Per default all available iCAT definitions for this camera are
assigned. If you do not want that you can remove them now by deselecting the definition that you
do not want in this interval.

You can also define whether something should be recorded at an event triggered by one of the
assigned iCAT definitions. For that you have a full set of options to set which are described in
7.1.1 Programming continuous timed recordings on page 49.

In addition to the parameters for continuous timed recordings you can specify a Pre-event frame
rate (fps) which can differ from that after the event defined by Frame rate (fps). With Pre/Post-
event recording (sec) you can specify how long before and after the event you want to record.
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Please note: If there is an active continuous recording in MPEG format, it does not make sense
to have any Pre/post-event recording (sec) set for the event-based recording. This is because
MPEG recording is only done in one quality. See also below for further considerations on pre-
and post-event recording.

8. ICAT events for this camera are only stored in the Event database and only appear in the Event
list if the flag Save event in Event list is switched on. Otherwise only the recording will start but
no event will be generated.

You can override this setting for individual iCAT events selectively in the corresponding iCAT
definition (e.g. 14.3.2 Defining an event trigger for people and object counting (Smart Tripwire™)
on page 110).

9. For all other recording settings please refer to 7.1.1 Programming continuous timed recordings

on page 49.

10. Push Save.

Please note: iCAT-triggered event generation and recording is only active if there is an enabled
iCAT interval and there is at least one enabled iCAT definition assigned. Outside of this time
interval there is no recording or event generation. Furthermore, recording is started only if either
of the fields for Pre/post-event recording (sec) is bigger than zero.

Further considerations for pre- and post-event recording

Observer allows you to define the frame rate and quality of event-based recordings. If you want to
save video streams for events generated by the video analytics toolkit iCAT please keep in mind that
Observer needs to analyze the video stream that it later stores.

Some cameras have limitations when providing multiple video streams at different qualities and frame
rates. Therefore Observer tries to retrieve only 1 video stream with 1 quality and frame rate setting
whenever possible. This also helps to keep the CPU load for the server and the camera at a minimum.

Here is some information about how event-based recording depending on the video format and
pre/post-event frame rate setting is done. This can help you to tune your system to better fit your
needs while reducing burden on the server and the camera. For further information on which video
format is best for iCAT please refer also to 14.2.1 Considerations for setting up a system with iCAT on
page 106.

Please note: If the recording event is not generated by iCAT, then the recording behavior is the same
as described here, just iCAT is not analyzing the video stream. Simple motion detection involves iCAT.
If both, iICAT-based and other event-triggered recording is active at the same time, iCAT recording
parameters have priority for obtaining pre-alarm streams.

Event-based recording for iCAT in MJPEG format

o Different frame rates for pre and post event recording

Observer obtains a QVGA stream for iCAT analyzing and also uses this stream for pre-event
recording. In case of an iCAT-based event or alarm, Observer switches to the frame rate and
quality defined by the main recording settings (post event).

Please note: Depending on the camera there can be a small delay caused by the camera
needed to switch from the pre-event streaming format to the post-event streaming format.

e The same frame rate for pre and post-event recording

Observer obtains 1 stream of the main (post-event) recording quality. It also does iCAT
analyzing based on this stream (it actually scales the image sizes down to QVGA). In case of
an event/alarm, the video stream format is not changed.

Advantage: same images for pre/post event recordings. No delay between pre- and post-event
recording.
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Disadvantage: CPU load is bigger since images need to be scaled down for iCAT analyzing.
Event-based recording for iCAT in MPEG formats (MPEG-4, H.264, and MXPEG)

The majority of MPEG cameras cannot deliver multiple MPEG streams with different formats. Only 1
stream is delivered from the camera. Therefore you need to set the default frame rate to at least the

detection frame rate you need for iCAT (see Default settings in 4.2 Adding a new camera and setting
basic properties on page 25).

e There is no pre-event recording (recording time is 0)

Observer obtains a QVGA MJPEG stream from the camera and runs iCAT analyzing on it. In
the case of an event, the streaming format is switched to MPEG and recording is started.

Advantage: minimal overhead on server CPU.

Disadvantage: Depending on the camera there can be a small delay caused by the camera
needed to switch from the pre-event streaming format MJPEG to the post-event MPEG format.

e There is pre-event recording (recording time is bigger than 0)

Observer obtains the MPEG stream from the cameras and also does iICAT based on it.
Recording is also done with this stream. Please note that iCAT based on MPEG stream needs
more CPU power on the server (see also 14.2.1 Considerations for setting up a system with
iCAT on page 106).

Continuous and event-based recording at the same time
If the continuous recording has the same frame rate quality like the post-event recording, then only

continuous recording is done and the recording calendar is marked with the events.

If continuous recording is done at a lower frame rate or different quality, then the stream will be
restarted with the post-event frame rate und quality in the case of an event.

iCAT processing will be done with continuous recording frames (scaled down in size and/or frame rate
if necessary). Pre-alarm setting has no relevance in this case.

14.4 Working with iCAT

In this section you will learn about;

e Watching iCAT information live in the Online monitor and also when replaying recordings.
e Displaying Visual Statistics™ in the Online monitor.
e Generating reports on iCAT events like people counting and stopped objects.

14.4.1 Displaying iCAT information in the Online monitor and when playing recordings

For each camera that has active iCAT schedules enabled you can display additional iCAT information
like object markers and bounding boxes and event trigger fields in the Online monitor and also when
playing back recordings.

Here is an example of additional iCAT information displayed:
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To choose what ICAT information to display you have these options:

In the Online monitor in the view port of a camera that has iCAT processing enabled the view port
control menu offers an iCAT info display menu (for setting the display for all view ports in a view the
same menu is also available via the View control menu Set parameters of all view ports).

Also in the Archive player you also have an iCAT button with the same menu.

The iCAT info display menu allows you to select from various display options: For each of these
options you can select Show always, Show on mouse over, and Do not show. For some you also
can select Show on event.

The display options are:

Tracking
boundaries

Event trigger
lines/boxes

Object
markers

Event count
fields

Object

defines whether the object tracking region boundaries should be shown.

defines whether the event triggers like tripwires and object starting/stopping fields
should be shown.

defines whether object markers should be displayed. Object markers show the object
ID and information about the state of the object (MOV = moving, STP = stopped,
LOUNGE = move just a little hit), size and speed.

In this example object ID is [10], object size is 9110 pixels, and the object is moving
with a speed of 208 pixels/sec.

defines whether the event count fields are to be displayed in the lower left corner of
the view port. When enabled the count information will be displayed for each event
trigger separately in the form of Q for last quarter of an hour, H for last hour, D for day
and T for total since setup.

Here is an example:

There are two event triggers: a field for counting stopped objects and a people
counting tripwire (counter 1).

defines whether object bounding boxes should be displayed.
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bounding Here is an example of an object bounding box displayed:
boxes

Please note that also the object marker and the event triggers are displayed.

14.4.2 Displaying Visual Statistics™

For each camera that has active iCAT schedules enabled you can display Visual Statistics™ as
overlays to the normal video stream in the Online monitor and also when playing back recordings.

Please be aware that the statistics are available only inside the object tracking region and that the
tracking region must have the collection of statistics enabled (see 14.3.1 Defining an object tracking
region on page 108).

This is an example of visual object count statistics:

To choose what Visual statistics to display you have these options:

In the Online monitor in the view port of a camera that has iCAT processing enabled the view port
control menu offers a Visual statistics menu (for setting the display for all view ports in a view the
same menu is also available via the View control menu Set parameters of all view ports).

Also in the Archive player you also have an iCAT button with the same menu.
The iCAT video statistics menu allows you to select the following statistics to display:

For the display of those Visual Statistics you can choose between Show always, Show on mouse
over, and Do not show.

In the screen dump above you see an example of the overall object count statistics in an entrance
situation. Cold colors mean few object counts and hot colors mean high object counts. When you
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move the mouse over the camera view you can see the actual object count for each segment of the
view. Above the count in the middle of the screen would be 302 objects.

As a comparison, here you see the Visual Statistics of the stopped object counts of the same camera:

ENTRY_a2#s | & fps

Notice the difference in coloring. You see that people only very seldom stop in the middle of the carpet
but stop very often in front of the welcome counter.

Resetting the Visual Statistics

To reset the statistics to zero follow these steps:

1. Choose Video analysis (iCAT) from the System administration menu. This opens the Video
analysis (iCAT) dialog.

Choose the camera and then the object tracking region.

In the menu select Modify selected definition.

Push the Next button to go to the statistics pane.

Disable the checkboxes of those statistics you want to reset.

Push the Save button to save the changes. Now the statistics counts of the disabled statistics
are reset.

7. Now enable the statistics again by repeating the above steps accordingly. Do not forget to push
Save again.

o g M~ wN

14.4.3 Working with iCAT events

Working with iCAT events is the same as working with other events of the Observer event
management system EMS (as described in 9 Handling events on page 69).

Currently, iCAT generates events of the following types (as shown in the event type hierarchy dialog of
the Event search; see 9.1 Event list and event details on page 69):

Camera specific messages
State change events
Video analysis (iCAT) events
Simple motion detection
iCAT object tracking

All events that are generated by iCAT (that are not simple motion detection) like people counting,
object stopping, and sabotage detection are of type iCAT Object tracking. Therefore if you want to
filter iCAT events you have to choose the event type iCAT Object tracking.
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You can differentiate events for the various iCAT event triggers by their names. You can also create
event statistics reports in Excel XLS format (see 9.3 Generating an event statistics report on page 73).
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15 Video walls with Observer

The Observer video wall solution allows you to configure and operate professional video walls using
standard Observer servers and clients. Such a video wall can then be controlled by the Video wall
control application, which allows you to:

e Handle video walls with up to 10x10 monitors.

e Connect multiple monitors to a single client PC.

¢ Flexibly control the views and layouts in any of the video wall monitors.

¢ Maximize individual camera streams on any of the monitors.

o Work with multiple control consoles in parallel.
The video wall control application has been specifically designed for control center personnel to

operate video walls. Any configuration of the servers, video wall clients, cameras, recordings, or other
administration has to be done in the main Observer client and admin consoles.

Here is the basic architecture of a video wall with Observer:

Video wall
Monitors are connected to

Observer video wall clients Videowall control center

The browser application connects
to one or more Observer servers

Video wall client 2
manages monitars 5-8

Video wall client1 | 1
manages monitors 1-4

1
User LAN Jﬂ--..----l

User Server 1 gl User Server 2
for user access (user = - =L for user access (user
servers — NUS) E servers — NUS)
__l’NUS1 = J”NUSZ
Camera LAN

) ) ) ) ) )

The video wall control application itself runs in a web browser on a PC that serves as the video wall
control center. It connects to one of the Observer servers in the network that then in turn controls the
Observer video wall clients that directly connect to the monitors of the video wall.

15.1 Setting up a video wall with Observer

15.1.1 General setup considerations

The video wall control application connects to an Observer server (normally a user server — NUS) in
order to control the display of the video wall clients. It is possible to choose any server in the network
for that purpose. However, all cameras that you want to display on the video wall must be accessible
by this server (i.e. must be configured at this server or must be mounted from other servers).
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It is also possible to use more than 1 server for providing the streams for the video wall (this depends
on how you setup your server network topology). In such a case the VWCA and also the video wall
clients (that directly connect to the monitors) must connect to these servers. For simplicity and easier
setup and management of the video wall, we suggest using one Observer server for driving the video
wall.

Each video wall client workstation/PC can drive several monitors of the video wall (how many depends
on your hardware setup, i.e. graphics card). Each such video wall monitor has to map to one window
in the Observer client.

User management for the video wall

You will need a few users to manage video wall functions appropriately. Generally these users must
have access rights to all cameras that are to be displayed on the video wall:

¢ 1 video wall management user (with which you login in to the VWCA).
e For each video wall client workstation/PC you need 1 user

You can create a user group that has privileges and access rights to all relevant cameras and then
create the above users belonging to this group (automatically inheriting the privileges and rights).

Please note these special issues:

e Itis impossible to display a camera on a video wall monitor which is not available on the server
where the video wall client connects to. Depending on your setup, it is therefore possible that
you cannot display every camera on any video wall monitor.

e The video wall control application itself does not display live video streams of the cameras but
snapshot images for better orientation instead. The real video streams appear in the video wall
monitors.

15.1.2 Setting up the video wall
Please follow these steps for setting up the video wall;

1. Configure your Observer server network with all the cameras and other settings.

2. Setup the video wall monitors and the video wall client PCs (how many monitors you can connect
to 1 client PC depends on your hardware setup). The video wall clients must run the Observer
desktop application.

3. We suggest using 1 specific user per video wall client PC. As indicated above, you can create a
user group that has privileges and access rights to all relevant cameras and then create 1 user for
each VW client PC. In the example diagram above it would be 2 users with names like VWPC1
and VWPC2.

4. Start the Observer application on the first video wall client PC and login with the user of that client
PC (e.g. VWPC1).

5. For each video wall monitor you have to define a separate window in the Observer application
(there is a 1 to 1 mapping between video wall monitors and Observer application windows). For
each of these windows you can define multiple views with different layouts (you can also add and
modify views later on). These views can later on be controlled by the video wall control
application.

6. Inthe Observer application position each of the created windows to the corresponding video wall
monitors (and put it in full screen mode). You can do that by dragging the window with the mouse
and then maximize the window.

7. When you are done setting up all the video wall client PCs and windows (monitors) you can
continue to configure and use the video wall control application (see 15.2 Controlling the video
wall with the control application on page 129).
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15.2 Controlling the video wall with the control application

The video wall control application (VWCA) is a client/server web application, which you can activate
from an Observer server (from release 4.4 on). The client part runs within a web browser and needs
only minimal computer resources and the server part of the application runs on an Observer server.

You can use any workstation/PC in the network (also your standard Observer client workstation) to run
the VWCA client.

Parallel working of multiple VWCASs: It is possible that multiple operators work on the same video wall.
In this case Observer always executes the last command no matter who initiated it. Therefore we
assume a cooperative multitasking style, which means that the operators have coordinate with each
other.

Supported browsers

e Mozilla Firefox 10.0 or higher
e Google Chrome 17.0 or higher
e Other browsers with HTML5 compatibility

15.2.1 Starting the video wall control application

You can start the video wall control application (VWCA) in a web browser with the following URL:

<your server address>/videowall

Please note: VWCA stores its configuration information (like monitor settings, linked servers, etc.) on
the server where it was started from. If you want to control more than 1 Observer servers with your
VWCA, you have to start it always from the same server.

VWCA has the following components:

(IR =io
video wall - admin@192.168.7 221 + | R - — _—
m‘ - Video wall layoui properiies
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o |eft side: Camera tree — separate for each server link.
e Middle: Video wall monitors — here you can control the contents of the video wall monitors
e Right side: Properties of the current selection — here you can see and modify the properties.

15.2.2 Configuring the video wall control application (VWCA)

Before you can control the video wall with the video wall control application you have to configure it.
We assume that you have already set up your video wall physically and you have already configured
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the video wall client workstations/PCs that connect to the various monitors of your video wall (see 15.1
Setting up a video wall with Observer on page 127).

Configuring the basic setup

1. Select video wall matrix by clicking on the default tab or the background area between monitors.
You will see the Matrix settings in the Properties pane.

2. Define the number of rows and columns of your video wall (this must obviously match your
physical setup).

3. Select the appropriate aspect ratio of the monitors

4. The zoom factor defines how many monitor columns of your video wall you want to see in your
VWCA without scrolling.
Additionally, you can also define some colors.

Linking the VWCA to servers

Before you can operate the video wall with VWCA you have to define the linking (mapping) between
the physical monitors of the video all and the monitors inside VWCA. The linking is actually done via
the Observer server that serves the video wall client workstations that actually connect to the monitors
and by choosing the appropriate Observer user login for which the windows for the monitors have
been defined.

Here are the steps for linking VWCA to the video wall servers:

1. Select one of the monitors by clicking on it. You will see Server link in the Properties pane.

2. Enter the server address, Login name and Password of the Observer server that serves the
video wall control workstations/PCs (for a general description on which servers and users to
choose please see 15.1 Setting up a video wall with Observer on page 127). Please note that you
have to select the correct user login for the monitor: You have to take the user login of the video
wall client workstation/PC where the monitor is connected to.

3. Push Validate. If you entered the correct server and login combination you will be offered to
choose from the available windows of the user.

4. Choose the window that is associated with the monitor (please remember that each monitor has
an associated Observer window; for a basic explanation please refer to 15.1 Setting up a video
wall with Observer on page 127). You will notice that a view of the window has been selected by
default.

5. Repeat the above steps for all monitors of the video wall.

15.2.3 Operating the video wall with the video wall control application (VWCA)

You have several possibilities for controlling the contents video wall monitors. When you select a
monitor by clicking on the monitor title bar inside VWCA you can:

Select a view from the View list. Please note that each window in Observer can have several views.

Drag/drop a camera from the camera tree to a view port in a monitor. Please note that you drag a
camera only to the view port of a monitor that also has the appropriate server link. Impossible camera
drops are prohibited and are shown with a red cross.

Push the Back and Next buttons at the monitor title bars to move in history. You can also specifically
select a point in the history by selecting it from the History tab in the Properties pane.

Please note that the status bar shows the camera name when you move the mouse pointer over
monitor view ports.
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16 Special functions

This chapter describes some special functions of Observer.

16.1 Video annotations

Video streams for live viewing and recording can be annotated with text that then displayed in the
video stream. The annotations can come from external data sources and can be stored in the event
database for later retrieval and search.

Annotations can be created via the SNAP XML interface or with a simple shell command with
command line options.

Example applications are POS cash register data, ATM data, logistics data, or access control data.

16.1.1 Working with video annotations
You can access the video annotation tools from the server's web page:

1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

2. After login click on Download configuration files.
Download the file annotate.zip and unpack the zip to a local directory on your client.

4. The zip contains the Windows command line program annotate.exe. Just run the program from a
command line to see all options. You can also refer to annotate-readme.txt. (The Java source
code of the program is also part of the zip file)

5. If you select to generate an event with the video annotation, an event will be stored in the event

database for later retrieval and search. By selecting VideoStreamAnnotation in the event type filter
of the Event search dialog , the annotation text can be searched for by SQL-type wildcards.

w

16.2 Embedding Observer video streams in web pages (Snapplet)

Observer allows you to embed live video streams in standard web pages. Currently only MIJPEG
stream are supported. The embedding HTML code can be generated by Observer.

16.2.1 Generating the embedding HTML code and testing it

You can generate the embedding HTML code from the server's web page:

1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

After login click on Generate embedding HTML code.

Now you can set several options for the embedded applet like size and streaming properties.

A click on Generate applet tag will open another window that contains the generated HTML code.
Push the Demo button to run and test the applet in your browser.

ok b

16.3 Controlling Observer with HTTP commands from external sources (URL
control)

URL control is one way to enable third-party applications to start actions via URL-encoded strings
(send http GET request to an Observer server). The server upon receiving these special URL requests
executes the actions as if they would have been generated internally.
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For testing purposes, you can execute URL control by entering an HTTP command in a standard web
browser.

http://<your-server>/arms/servlet/BrowserServlet?cmd=clientcontrol&. ..

Here is a list of available URL control parameters:

selector.tool= name of the target tool in the client application (possible values:
online_monitor, archive_tool)

selector.machine= optional IP address of the target client PC

selector.user= optional name of the logged-in target user (if both machine and user are
specified then only the client application is selected which fulfills both conditions)

Further action parameters are:

action.action= the action to be executed (possible values: show_live_stream,
show_calendar, play_archive, draw_bounding_box)

action.cameraid= ID of camera that is involved in the action

action.mode= further descriptor for the action (possible values: pop_if_exists,
show_as_large, show_in_view, show_all_cams)

action.fromtime= from time stamp (YYYY-MM-DDTHH:MM:SS or millisecs since Unix epoch)
of archive playback. Should be given only when action is play_archive.

action.totime= to time stamp of playback (YYYY-MM-DDTHH:MM:SS or millisecs since Unix
epoch). Should be given only when action is play_archive.

action.idlist= comma separated list of camera ids which we want the archive playback or want
to place them in the current Online monitor view . Should be given only when action is
show_live_stream or play_archive.

action.panelname= name of Online monitor view that should be exposed. Should be given
only when mode is show_in_view or show_all_cams. Following conditions exist:

o If panelname does not exist it will be created and all cameras listed in the idlist
parameter will be placed into it.

If panelname exists with the cameras listed on the idlist parameter, it will be popped up.

If panelname exists but the idlist parameter contains more cameras as there already
are in the view, then: 1) if we have enough view-ports to show the rest of the cameras it
will be shown there, or 2) if the view can not handle any more view-ports, a new view will
be created where all listed cameras are then placed.

box.x0= upper left x coordinate of box (valid between 0 and 1000). The values are in 1/10th
percentages of the displayed image. Box parameters should be supplied only when the action
is draw_bounding_box.

box.y0= upper left y coordinate of box (valid between 0 and 1000)
box.x1= lower right x coordinate of box (valid between 0 and 1000)
box.y1= lower right y coordinate of box (valid between 0 and 1000)
box.linewidth= line width used when drawing the box

box.color= color of the box (possible values: black, blue, cyan, darkgray, gray, green, lightgray,
magenta, orange, pink, red, white, yellow)

box.text= text which is written into the box
box.timeout= seconds after the box disappears automatically (0 mean click to disappear)

Please note: URL control is only enabled for allowed computers whose IP addresses are known to
the server (see 11.2 Setting Observer server parameters on page 84 for details). All other requests are
blocked.

Please refer to the Release Notes for further details or updates on URL control.
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16.3.1 URL control examples

Create an action that brings up images of camera ID 12 in a large view on a client machine where the
"admin" user is logged in (we assume that the address of the server to which we are sending the URL
control is 192.168.7.2):

http://192.168.7.2/arms/serviet/BrowserServlet?cmd=clientcontrol&selector.user=admi
n

&selector.tool=online_monitor&action.action=show_live_stream
&action.mode=show_as_large&action.cameraid=12

Create action which draws a red box (for two seconds) onto the frame of camera ID 12 in the Online
Monitor of the "admin" user:

http://192.168.7.2/arms/serviet/BrowserServlet?cmd=clientcontrol&selector.user=admi
n

&selector._user=admin&selector _tool=online_monitor
&action.action=draw_bounding_box&box.x0=100&box.y0=100&box .x1=500&box.y1=500

&box . linewidth=2&box.color=red&box. text=MD&box . timeout=3&action.cameraid=12

Each server offers a simple test page for URL control at the following address:

http://<your-server>/URLtest.jsp.

16.4 Matrix view function of the Online monitor (VIP control)

With the matrix view function (also called VIP control) you can control, which cameras defined in a
bigger matrix are displayed in a view in the Online monitor.

For example, assume you have a big area covered with 50 cameras. Each of these 50 cameras cover
a part of the overall area. The Matrix view function now allows you to position all the cameras in a
huge virtual matrix covering the whole area:

Cam11|Cam12BCam13 |Cam14|Cam158Cam16QCam17 [Cam18 | Cam19

Cam1 | Cam2 | Cam3 | Camd4 | Cam5 | Camb § Cam7 | Cam8 | Cam9 ICamﬂJ
ICamEU

Cam21 CamEEICam23 Cam24 CamESICamZE Cam27|Cam28 | Cam29§Cam30

Cam31|Cam32BCam33|Cam34 | Cam358Cam36 | Cam37|Cam38 |Cam39|Cam40

Camd1|Camd2|Cam43|Camdd | Cam45|Camd6 | Camd7 | Cam4d8 | Cam493 | Cam50

Now assume that in the Observer Online monitor you want to show adjacent cameras of this virtual
matrix in a 3x3 view . Whenever you double click any of the 50 cameras in any of the views in
Observer this camera is then positioned as the center of the 3x3 view and the adjacent cameras of the
big matrix are automatically positioned around it. In the example above you see how the 3x3 view
would look like if you would double click Cam24 and Cam18.

The Matrix view function is defined by XML files sitting on the server. The name of the XML files
follows the form server.utils.CameraMatrixMapping.<action>.xml. You start by downloading and
editing the file server.utils.CameraMatrixMapping.sample.xml. When you are done with editing you
upload the file under a specific name to the server.

16.4.1 Download the XML config file

You can access the XML file in a web browser from the server's web page:
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1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

2. Inthe Customizer click on Download configuration files.

3. Inthe list of files find and save server.utils.CameraMatrixMapping.sample.xml to your local
hard disk. You can do that by right clicking on the file and then choosing Save link as... from the
menu.

16.4.2 Edit the XML config file

Edit the file according to your needs. A detailed description about the function can be found in the
comment at the beginning of the file. When you are done with editing save the file under a file name
that reflects the trigger action for which you want to enable the Matrix view.

Possible trigger actions for the Matrix function and the corresponding XML file names are:

Trigger action XML file name
double click in a camera view port server.utils.CameraMatrixMapping.DOUBLE-
CLICK.xml
single click in a camera view port server.utils.CameraMatrixMapping.SINGLE-
CLICK.xml
LNT: single click, double click, mouse over or server.utils.CameraMatrixMapping.LNT.xml

context menu on a camera icon

In addition to the above you can also control on which Observer clients the Matrix view function should
be triggered. You can do that by downloading and editing the file
server.utils.TargetActionMapping.sample.xml.

16.4.3 Upload and activate the XML config files
You can upload and activate the Matrix function by following these steps:

1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).
2. Inthe Customizer under the heading Upload configuration files click on the button Choose file.

3. Inthe opened file dialog choose the file that you want to upload and push Open. Repeat this step
for all files you want to upload.

4. Uploading a properly filled CameraMatrixMapping file to the server will activate the mapping
function. No server restart is necessary, changes become active within 10 seconds after upload.

16.5 Holiday calendar

A holiday calendar allows you to define a list of special days (holidays) and to modify the standard
recording schedules of cameras for these days (enable or disable recordings).

The holiday calendar is defined in an XML file that can be accessed via the standard server web page.

16.5.1 Download the XML config file

You can access the XML file in a web browser from the server's web page:

1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

2. Inthe Customizer click on Download configuration files.
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3. Inthe list of files find and save HolidayCalendar.SAMPLE.xml to your local hard disk. You can
do that by right clicking on the file and then choosing Save link as... from the menu.

16.5.2 Edit the XML config file

Edit the file according to your needs. A detailed description about the function can be found in the
comment at the beginning of the file. When you are done with editing, save the file.

The SAMPLE file has to be renamed to HolidayCalendar.xml.

Please note: The holiday calendar has to be configured on camera servers (NCS). Controlling
recording over user servers (NUS) is not supported.

16.5.3 Upload and activate the XML config file

You can upload and activate the function by following these steps:

1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

2. Inthe Customizer under the heading Upload configuration files click on the button Choose file.
3. Inthe opened file dialog choose the file HolidayCalendar.xml and upload it to the server.
4. Please restart Observer to activate settings of the holiday calendar.

16.6 Automatic export of event statistics data

Observer allows you to automatically export event statistics data in the format of a CSV (comma-
separated text file) that can be easily read by programs like MS Excel. The details of the statistics like
resolution, duration and filters for event types and camera can be flexibly defined.

The exported file will be stored in the file system of the server. This means you must have file system
access to the server in order to obtain the file. You can do that, for example, via FTP and the admin
user and password . Or you can mount a network drive (via Samba or NFS) and place the file there.

The statistics export function is defined by an XML file sitting on the server. You must download, edit,
and then upload the file in order to configure and activate the function.

16.6.1 Download the XML config file

You can access the XML file in a web browser from the server's web page:

1. Atthe server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

2. Inthe Customizer click on Download configuration files.

3. Inthe list of files find and save StatisticExportConfig. ACTIVE.xml to your local hard disk. You
can do that by right clicking on the file and then choosing Save link as... from the menu.
Please note: If there is no such file then download the StatisticExportConfig.sample.xml.

16.6.2 Edit the XML config file

Edit the file according to your needs. A detailed description about the function can be found in the
comment at the beginning of the file. When you are done with editing save the file.

If you want to access the generated statistics files via FTP, we suggest that you create the output file
in /home/admin. If you want to put the file on a mounted network drive then use the mount location.

The SAMPLE file has to be renamed to StatisticExportConfig. ACTIVE.xml.
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16.6.3 Upload and activate the XML config file

You can upload and activate the function by following these steps:

1.

At the server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

In the Customizer under the heading Upload configuration files click on the button Choose file.

In the opened file dialog choose the file StatisticExportConfig.ACTIVE.xml and upload it to the
server.

Please restart Observer to activate settings of the automatic event export.

16.7 Configuring 1/O devices

Observer allows you to work with I/O contacts of cameras and special I/O devices.

The I/O device configuration is done by XML files sitting on the server. You must download, edit, and
then upload the files in order to configure and activate the function.

16.7.1 Download the XML config files

You can access the XML file in a web browser from the server's web page:

1.

At the server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

In the Customizer click on Download configuration files.
In the list of files you find several XML files that are responsible for the device configuration:

XML file name Trigger action
server.externallO.deviceio.DeviceMappings.xml | Actual I/0O device configuration

server.externallO.deviceio.DeviceTypeDescriptor.| Device descriptor files (not intended for
<device_type>.xml modification by you)

Save server.externallO.deviceio.DeviceMappings.xml and the to your local hard disk. You can
do that by right clicking on the file and then choosing Save link as... from the menu.

Please note: If there is no such file then download the
server.externallO.deviceio.DeviceMappings.sample.xml.

16.7.2 Edit the XML config files

Edit the file server.externallO.deviceio.DeviceMappings.xml to your needs. A detailed description
about the function can be found in the comment at the beginning of the file.

For each supported 1/0 device types there is a device descriptor file
server.externallO.deviceio.DeviceTypeDescriptor.

<device_type>.xml. For configuring a device you must refer to one of the supported devices in
server.externallO.deviceio.DeviceMappings.xml.

When you are done with editing, save the file.

Please note: The sample file has to be renamed to
server.externallO.deviceio.DeviceMappings.xml.

16.7.3 Upload and activate the XML config files

You can upload and activate the function by following these steps:
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At the server's web page click on Customizer login to login to the Customizer area (the admin
password is needed for that).

In the Customizer under the heading Upload configuration files click on the button Choose file.

In the opened file dialog choose the file server.externallO.deviceio.DeviceMappings.xml and
upload it to the server.

Please restart Observer to activate settings of the automatic event export.
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Data integration with external applications 131

Calendar in archive 52 Data security 6
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Default settings
for cameras 27

Deleting windows 20

Demo mode license 11
Distributed upgrades of servers 92
DivX exporting from recordings 58
Documentation set 6

Drag and drop

camera from the camera tree to view ports
40

Duplicate existing camera 31

Dynamic views (view ports) 47

E

Email
receiving on events and alarms 74

Encryption
AES encryption of video recordings 87
general description 6
HTTPS for camera connections 26
HTTPS for client connections 12, 15
HTTPS for server-server connections 90

Event triggers (iCAT) 106, 110

Events 69
acknowledging 70
automatic export of statistics data 135
details 70
Event list 69
create a separate Event list window 20
maximizing 20
modifying layouts 20
positioning in the window 20
priorities 69
sorting 69
event-based recording 120
exporting event-related recordings 72
HTML export 72
in layout navigation 103
notification via client GUI, email, SMS 74
priorities 69
remote servers 92
searching in the event database 71
short replay 70
statistics 73
statistics data automatic export 135
user privileges for accessing and handling
69
video analysis (iCAT) 125

Exiting the client 22
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Export of event statistics data 135

Exporting archive recordings 58
event-related 72

External applications
control via HTTP commands 131

external archive, see NEA 61

F

Floating window components 20
Four-eyes principle 34
Frame rate

changing in view port 42
maximizing 42

G

Getting started 23

Google Chrome

optimizing settings for browser client Web
Start (JNLP files) 14

H

H.264 7, See also MPEG

HDTV 16/9
aspect ratio in Online monitor 39

Holiday calendar 134

HTML code for embedding streams in web
pages 131

HTTP commands for starting actions 131

HTTPS encryption
between servers 90
for camera connection 26
for client connection 12, 15
general description 6

I/O contacts

configuring 1/0O devices 136
placing them on LNT layouts 96
settings 30

I/O devices
configuring 136

iCAT 105
considerations for setting up 106
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CPU load 107

event triggers 106, 110
event-based recording 120
events 125

object bounding boxes 123
object counting 110

object markers 123

object tracking region 106, 108
people counting 110

privacy mask 117

recording based on 120
removed/abandoned objects 118
sabotage detection 114
scheduling activities 120
sensitivity setting 109

Smart Tripwire(tm) 110

starting and stopping objects 113
video processing speed 108
video streaming formats 107
Visual Statistics™ 124

working with in Online monitor 122

In-camera motion detection 67
settings 30

IP address
of camera 26

iPad 20

iPhone 20

Joystick control for PTZ cameras 80

JPEG

aspect ratio 9, 26
exporting from archive 58
image sizes and quality 9
MJPEG vs. MPEG 7

L

Languages 13

Layout navigation 93
editing mode 94
I/O contacts 96
installation 93
navigation and operation 102
zones 96

Layout of windows
modifying 20

LDAP 37

License
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displaying current license 83
license string 11

Login
secondary password 34

the locally installed client 15
the web-based client 14

Low-bandwidth connections with Transcoding
21

M

Manual recording control in the Online monitor
44

Matrix view function (VIP control) 133
MJPEG 8

versus MPEG streaming 8
Mobile devices, PDAs 20

Motion detection 64
in archive 60
in-camera 67
recording based on 120
server-based 64

Motion JPEG 8
MPEG 7, 8
settings 27

versus MJPEG streaming 8
working with cams 46

MPEG-4 7, See also MPEG

Multi streaming (parallel video streams) 7
enabling 27
optimizing iCAT operation 107

Multicast streaming for MPEG cameras 27

Multi-screen operation 18
positioning windows 20

Multi-window operation 18
MxPEG 7, See also MPEG

N

NCS camera server 88

NEA external archive
accessing archives at another server 63
Displaying status 62
recording on removable storage devices 61
starting and stopping double recording 62

NETAVIS_DIRECTORY environment variable
for installed client components 17



New system setup 23

NNS synchronization groups of servers 88
Notification on events and alarms 74
NTSC 9

NUS user server 88

0]

Object bounding boxes (iCAT) 123
Object counting (iCAT) 110
Object markers (iCAT) 123
Object tracking region 106

Online monitor 39

creating views 39

defining views for new user 36
dynamic control with iCAT and motion
detection 47

dynamic control with the Matrix function (VIP
control) 133

manual recording control 44
navigating in the 41

quick camera finder 41

view port quality settings 42

view settings 42

working with iCAT 122

zooming in a view port 43, 55

Overlay painting 18

P

PAL 9
pan, tilt, zoom 76

Password
changing 37

PDAs (mobile devices) 20
People counting (iCAT) 110
Playback of archive recordings 52

Port mapping
of analog cameras on video server 33

Preferences of the client 19

Priority
of events 69
sorting event list 69

Privacy mask (iCAT) 117
Privileges of users 35

Protect archive recordings against deletion 57
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PTZ (panftilt/zoom) 76
automatic routes 80
control with motion detection 66
controlling camera 77
joystick control 80
routes 76
user priority 35

Q

QCIF 9

Quality settings
changing in view port 42

Quitting the client 22

R

Recording 49
AES encryption of video recordings 87
Audio playback 56
calendar 52
continuous (timed) 49
DivX export 58
event-based recording 120
exporting 58
exporting event-related recordings 72
holiday calendar 134
iCAT-based recording 120
manual recording control in the Online
monitor 44
motion detection in 60
on removable storage devices, see NEA 61
Playback 52
programming 49
protection against deletion 57
SAFE format export 59
save space with frame rate reduction for
older parts of the archive 51
storage management 51

synchronous playback of mutiple cameras
56

time zoomimg 56
Release notes 6

Remote servers 88
events 92
monitoring 92
upgrading 92

Restarting and rebooting 84
Round tours 45
RTSP streaming port 87
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S Transcoding for low-bandwidth connections
21

Sabotage detection (iCAT) 114 setting up 86

SAFE format archive export 59 Tripwire for object counting (iCAT) 110

Saturation 31

Scheduling U
iCAT activities 120

) Upgrading
Screen resolution remote servers 92
minimum for running the client 11
URL control
Secondary password allowed IP addresses 86
for login 34 control from external applications 131
Security 6 User server (NUS) 88
Sensitivity setting (iCAT) 109 Users
Server Active Directory/LDAP 37
administrating 82 adding 34 _
information about running servers 82 camera access rights 36
interconnected 88 copying view between 46
load display 82 groups 36
network 88 info about logged in 36
camera server (NCS) 88 managing 34
synchronization groups 88 privileges 35
user server (NUS) 88
setting parameters 84 Vv
Setup of a new system 23
Smart guard function 45 VGA 9
Smart Tripwire (iCAT) 110 Video analytics 105, See iCAT
Smartphones (mobile devices) 20 video annotations 131
SMS Video compression 7
receiving on events and alarms 74 MPEG vs. MJPEG 7 . _
o _ ) Transcoding for low bandwidth connections
Snapplet, embedding live video streams in 21

web pages 131 ]
Video walls 127

configuring the control application 129
controlling with Observer 129
operating with the control application 130

Statistics
events 73
iCAT Visual Statistics™ 124

Storage management in archive 51 setup 127
Streaming formats 7 View ports

changing in view port 42 creating 39

iCAT video analytics 107 define crop view 43

dynamic event-based control 47

Synchronization groups of servers 88 quality settings 42

Synchronous playback of mutiple cameras in zooming camera views 43, 55
archive 56 )
Views
copying between users 46
T dynamic event-based control 47
Online monitor 39
Time zone of server 85 optimizing big views after double click 42

round tours 45

Time zoomimg in archive 56 :
settings 42
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Visual Statistics™ (iCAT) 124
VWCA (video wall control application) 129

W

Web pages
embedding live video streams 131
Windows

create a separate Event list window 20
deleting 20
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modifying layouts 20

YA

Zones in layout navigation (LNT) 96

Zooming
in an Online monitor view port 43, 55
in SAFE exports 59
of PTZ cameras 79
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